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Notices and Certifications

Approvals and certification

For the UK, this product is serviced under a BS5750 Quality 
system accepted by the British Standards Institution.
60HZ, 115V
The equipment is listed by the Underwriters Laboratories, 
UL1950, certified by Canadian Standards Association, CSA22.2, 
No. 1950.
50HZ, 220V-240V
The equipment is certified by the British Standards Institution, 
IEC950 (EN60950). The equipment is manufactured under a 
BS5750 Quality system accepted by the British Standards 
Institution. The equipment is also certified in compliance with 
applicable standards by various national bodies.

Radio Frequency Emissions

USA
This equipment generates, uses and can radiate radio frequency 
energy. It may cause radio interference to radio communications if 
not installed according to the installation instructions. The 
equipment complies with the limits for a Class A computing device 
as documented in Subpart J, Part 15 of the FCC rules which are 
designed to provide reasonable protection against such 
interference when operated in a commercial environment. 
Operation of this equipment in a residential area is likely to cause 
interference. In such cases, the user is responsible for the 
expense of correcting the interference.
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Canada
The equipment does not exceed the class A limits for radio noise 
emissions from a digital apparatus as documented in the radio 
interference regulations of the Canadian Department of 
Communications.
Cet appareil numÈrique est conforme aux limites d'Èmission de 
bruits radioÈlectriques pour les appareils de classe A stipulÈes 
dans le RÈglement sur le brouillage radioÈlectriques du ministÈre 
des Communications du Canada.
Europe 50HZ, 220V-240V Equipment
The equipment was tested and is certified in conformance with the 
European commission directive 82/499/ECC and VDE 0871/ 
0875, class B which relates to radio frequency interference. This 
equipment is certified, manufactured and tested in compliance 
with strict safety and radio frequency interference regulations.

Safety

Your Xerox equipment and supplies were designed and tested to 
meet strict safety requirements. These include safety agency 
examination, approval and compliance with established 
environmental standards.
Attention to the following notes ensures the continued safe 
operation of your equipment. 
If you need any additional safety information concerning the 
equipment or materials, contact your local representative. 

Ozone Safety

This product will produce ozone during normal operation. The 
ozone produced is heavier than air and is dependent on copy 
volume. Providing the correct environmental parameters as 
specified in the Xerox installation procedures will ensure that the 
concentration levels meet safe limits.
If you need additional information about ozone, please request the 
Xerox publication Ozone (part number 600E74140) by calling 1-
800-828-6571 in the United States and Canada.
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Electrical Safety

Always follow a code of safe habits as described in the following 
statements:
1. Use only the power cable supplied with this equipment. 
2. Plug the power cable directly into a properly grounded 

electrical outlet. Do not use an extension cord. If you are not 
sure whether or not an outlet is properly grounded, consult a 
qualified electrician. 

3. Do not use a ground adapter plug to connect this equipment to 
an electrical outlet that lacks a ground connection terminal. 

WARNING: Improper connection of the equipment grounding 
conductor can result in severe electrical shock.
4. Do not place this equipment where people might step or trip on 

the power cable. 
5. Do not place objects on the power cable. 
6. Do not override or disable electrical or mechanical interlock 

devices. Covers, guards, and interlock switches are provided 
to prevent operator access to unsafe areas. 

7. Do not obstruct ventilation openings. These openings are 
provided to prevent overheating of the machine. 

WARNING: Never push objects of any kind into slots and 
openings on this equipment. Contacting a voltage point or shorting 
out a part could result in electrical shock or fire
8. If any of the following conditions occur, turn off the machine 

immediately and disconnect the power cable from the 
electrical outlet. Contact an authorized Xerox Service 
Representative to correct the problem: 

• The equipment emits unusual odors or makes unusual noises. 
• The power cable is damaged or frayed. 
• A wall panel circuit breaker, fuse, or other safety device has 

been tripped. 
• Liquid is spilled into the machine. 
• The machine is exposed to water. 
• Any part of the machine is damaged. 
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Operational Safety

Your Xerox equipment and supplies have been designed and 
tested to meet strict safety requirements. These include safety 
agency examination, approval, and compliance with established 
environmental standards.
To ensure the continued safe operation of your Xerox equipment, 
follow these safety guidelines at all times:
Do These
• Always connect equipment to a correctly grounded power 

outlet. If in doubt, have the outlet checked by a qualified 
electrician. 

• Always follow all warnings and instructions that are marked 
on or supplied with the equipment. 

• Always exercise care when moving or relocating equipment. 
Please contact your local Xerox Service Department to 
arrange relocation of the copier to a location outside of your 
building. 

• Always locate the machine on a solid support surface (not on 
plush carpet) that has adequate strength to support the weight 
of the machine. 

• Always locate the machine in an area that has adequate 
ventilation and room for servicing. 

• Always use materials and supplies specifically designed for 
your Xerox equipment. Use of unsuitable materials may result 
in poor performance and possibly a hazardous situation. 

• Always unplug this equipment from the electrical outlet before 
cleaning. 

Do Not Do These
• Never use a ground adapter plug to connect the equipment to 

a power outlet that lacks a ground connection terminal. 
• Never attempt any maintenance function that is not 

specifically described in this documentation. 
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• Never obstruct ventilation openings. They are provided to 
prevent overheating. 

• Never remove covers or guards that are fastened with screws. 
There are no operator serviceable areas within these covers. 

• Never locate the machine near a radiator or any other heat 
source. 

• Never push objects of any kind into the ventilation openings. 
• Never override or "cheat" any of the electrical or mechanical 

interlock devices. 
• Never operate the equipment if you notice unusual noises or 

odors. Disconnect the power cord from the electrical outlet and 
contact your Xerox Service Representative immediately. 
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Illegal Usage in USA

Congress, by statute, has forbidden the copying of the following 
subjects under certain circumstances. Penalties of fines or 
imprisonment may be imposed on those guilty of making such 
copies.
1. Obligations or Securities of the United States Government, 

such as: 
• Certificates of indebtedness 
• United States Bonds 
• National Bank Currency 
• Treasury Notes 
• Coupons from bonds 
• Federal Reserve Notes 
• Federal Reserve Bank Notes 
• Fractional Notes 
• Silver Certificates 
• Certificates of Deposit 
• Gold Certificates 
• Paper Money 
• Bonds and obligations of certain agencies of the government, 

such as FHA, etc. 
• Bonds 
NOTE: U.S. Savings Bonds may be photographed only for 
publicity purposes in connection with the campaign for the sale of 
such bonds.

• Internal Revenue Stamps 
NOTE: If necessary to copy a legal document on which there is a 
canceled revenue stamp, this may be done, provided the 
reproduction of the document is performed for lawful purposes.
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• Postage Stamps, canceled or not canceled 
NOTE: For philatelic purposes, Postage Stamps may be 
photographed, provided the reproduction is in black and white, 
and is less than 3/4 or more than 1-1/2 times the linear 
dimensions of the original.

• Postal Money Orders 
• Bills, Checks, or Drafts for Money, drawn by or upon 

authorized officers of the United States 
• Stamps and other representatives of value, of whatever 

denomination, which have been or may be issued under any 
Act of Congress 

2. Adjusted Compensation Certificates for Veterans of World 
Wars. 

3. Obligations or Securities of any Foreign Government, Bank, or 
Corporation. 

4. Copyrighted material, unless permission of the copyright 
owner has been obtained or the copying falls within the ìfair 
useî or library reproduction rights provisions of the copyright 
law. 

NOTE: Further information on these provisions may be obtained 
from the Copyright Office, Library of Congress, Washington, D.C. 
20559. Ask for Circular R21.

5. Certificates of Citizenship or Naturalization. 
NOTE: Foreign Naturalization Certificates may be photographed.

6. Passports. 
NOTE: Foreign passports may be photographed.

7. Immigration Papers. 
8. Draft Registration Cards. 
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9. Selective Service Induction Papers, which bear any of the 
following information: 

• Registrantís earnings or income 
• Registrantís previous military service 
• Registrantís dependency status 
• Registrantís physical or mental condition 
• Registrantís court record 
NOTE: U.S. Army and Navy discharge certificates may be 
photographed.

10. Badges, Identification Cards, Passes, or insignia carried by 
Military, Naval personnel, or by members of the various 
Federal Departments and Bureaus, such as FBI or Treasury, 
unless the photograph is ordered by head of such department 
or bureau. 

11. Copying the following is also prohibited in certain states: 
• Automobile Licenses 
• Driver Licenses 
• Automobile Certificates of Title 
The above list is not all inclusive, and no liability is assumed for its 
completeness or accuracy. In case of doubt, consult your attorney.
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Illegal Usage in Canada

Parliament, by statute, has forbidden the copying of the following 
subjects under certain circumstances. Penalties of fines or 
imprisonment may be imposed on those guilty of making such 
copies.
1. Current bank notes or current paper money. 
2. Obligations or securities of a government or bank. 
3. Exchequer bill paper or revenue paper. 
4. The public seal of Canada or of a province, or the seal of a 

public body or authority in Canada, or of a court of law. 
5. Proclamations, orders, regulations or appointments, or notices 

thereof (with intent to falsely cause same to purport to have 
been printed by the Queenís Printer for Canada, or the 
equivalent printer for a province). 

6. Marks, brands, seals, wrappers, or designs used by or on 
behalf of the Government of Canada or of a province, the 
government of a state other than Canada or a department, 
board, commission, or agency established by the Government 
of Canada or of a province or of a government of a state other 
than Canada. 

7. Impressed or adhesive stamps used for the purpose of 
revenue by the Government of Canada or of a province or by 
the government of a state other than Canada. 

8. Documents, registers, or records kept by the public officials 
charged with the duty of making or issuing certified copies 
thereof, where the copy falsely purports to be a certified copy 
thereof. 

9. Copyrighted material or trademarks of any manner or kind 
without the consent of the copyright or trademark owner. 

The above list is provided for your convenience and assistance, 
but it is not all inclusive and no liability is assumed for its 
completeness or accuracy. In case of doubt, consult your solicitor.
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Product Recycling and Disposal

Xerox operates a worldwide equipment takeback and reuse/
recycle program. Contact your Xerox sales representative (1-800-
ASK-XEROX) to determine whether this Xerox product is part of 
the program. For more information about Xerox environmental 
programs, visit www.xerox.com/environment.html.
If your product is not part of the Xerox program and you are 
managing its disposal, please note that the product may contain 
lead, mercury and other materials whose disposal may be 
regulated due to environmental considerations. For recycling and 
disposal information, contact your local authorities. In the United 
States, you may also refer to the Electronic Industries Alliance 
web site: www.eiae.org.

http:// www.xerox.com/environment.html
http://www.eiae.org
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About this guide

The Xerox FreeFlow Process Manager Operator and 
Administrator Guide provides information and procedures for 
using the Process Manager applications. 

About this chapter

This chapter explains the information found in this guide and how 
the information is organized. It helps you get the most out of this 
guide by:
• Identifying the audience and the basic skills required to use 

this guide effectively.
• Explaining the standard conventions and cues that highlight 

important information.
• Listing related documentation you might find helpful.
• Listing available online FreeFlow Process Manager Help 

systems.
• Providing information on ordering additional materials and 

supplies.
• Providing information on obtaining additional information.

NOTE: NOTE: If you are using Process Manager for the first time, it is 
recommended that you first read Chapter 1, About Process 
Manager, in this guide.
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Audience

The Xerox FreeFlow Process Manager Operator and 
Administrator Guide is a comprehensive reference manual 
intended for administrators and operators.

How to recognize important information

The following sections provide the conventions and flag icons that 
are used in the Xerox FreeFlow Process Manager Operator and 
Administrator Guide.

Conventions

The Xerox FreeFlow Process Manager Operator and 
Administrator Guide uses the conventions listed in the table, 
below, to help you recognize information:

Table 1-1. Description of conventions 

Convention Description

<CAPS in angle 
brackets>

Within procedures, the names of keys to 
press are displayed in capital letters and 
enclosed in angle brackets (for example, 
press <ESCAPE>).
Keyboard combinations are represented by 
the plus sign (+) between names of keys 
(for example, press <CONTROL+C> to 
copy).

<Angle brackets> Variable information is enclosed in angle 
brackets (for example, select <filename>).

[Square brackets] Names of options you select, including 
toolbar buttons and buttons in dialog boxes, 
are enclosed in square brackets (for 
example, select [Close]).
Menu commands are also displayed in 
square brackets, with the menu name 
appearing first, then a colon, followed by the 
option name (for example, select [File: 
Close]).

Bold Text you should enter exactly as it appears 
is displayed in bold (for example, enter 
test1.rdo).
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Flag icons

The Xerox FreeFlow Process Manager Operator and 
Administrator Guide uses the following flag icons to help you 
recognize important information:

NOTE: The NOTE symbol and text in italics indicate there is 
important or supplemental information when performing a task or 
procedure.

CAUTION: The CAUTION symbol and bold text indicate that 
you may lose data or damage equipment if care is not taken 
when performing the task or procedure following the caution.

WARNING: The WARNING symbol and red text indicate that you 
may cause personal injury or death if care is not taken when 
performing the task or procedure following the warning.

Step-by-step
The step-by-step icon identifies the beginning of a procedure.

Italics Titles of documents and manuals that 
provide additional information on the current 
topic are displayed in italics (for example, 
the Xerox FreeFlow Process Manager 
Operator and Administrator Guide).

Table 1-1. Description of conventions 

Convention Description
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Related information

This section lists additional materials you may need, or find 
helpful, when using your FreeFlow Process Manager system.
To order the Xerox documentation listed below, or for additional 
information on Xerox solutions, contact your Xerox 
Representative.

FreeFlow Process Manager documentation

For more information on FreeFlow Process Manager, refer to the 
following publications:
• Xerox FreeFlow System Administrator Guide
• Xerox Customer Software Release Document (CSRD) for 

FreeFlow Process Manager

Windows related information

Microsoft provides users and administrators with several different 
resources to support the Windows 2003 environment. Some of 
these resources include web sites and online Help. The following 
sections describe these sources and tell you how to find and use 
them.

Windows Online Help

Windows 2003 Server includes extensive online Help for all 
aspects of the operating system. Most likely, the online Help will 
be your primary source for information. Administrative procedures, 
from adding users and managing groups to installing Windows 
printers, can be found in the online Help files. Furthermore, most 
Windows applications also contain their own online Help system 
containing information that is specific to the application.
To access online Help, select [Start: Help] from the Windows task 
bar. If you are looking for help within a specific application, use the 
options available from the Help menu within that application.
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Windows Microsoft Web site

Microsoft has a World Wide Web site that contains the latest 
Windows 2003 Server news and information about upgrades. The 
URL for this site is:
http://www.microsoft.com/

Using the FreeFlow Process Manager Online Help

This section provides a brief overview of the type of Help available 
online from the FreeFlow Process Manager software.
You can access the FreeFlow Process Manager Online Help 
system by selecting [<application> Help] in the Help menu, 
located on the main window menu bar in each Process Manager 
application. You can also access Help by selecting the [Help] 
button, when available, in dialog boxes.

Finding a Help topic

In Help, click one of the following tabs: 
• To browse through topics by category, select the Contents 

tab. 
• To see a list of index entries, select the Index tab; you can 

then either search or scroll through the list or keywords. 
• To search for words or phrases that might be contained in a 

Help topic, select the Search tab. 
In the left of the Help window, click the topic, index entry, or phrase 
to display the corresponding topic in the right frame.
NOTE: Under the Index tab and the Search tab, you must select  
<Display> to show the highlighted topic in the right frame.
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To get Help in a dialog box

Select the question mark [?] in the title bar of the dialog box, and 
then click the item in the dialog box you need help with. 
NOTE: You can print or copy the information in a pop-up window 
by right-clicking inside the pop-up window, and then selecting 
[Print Topic] or [Copy].

NOTE: If the dialog box does not have the [?] button, press <F1> 
or search for the item in the Help system.

NOTE: You can also get Help with an item by right-clicking on it, 
and selecting [What's This?].

Using the Process Manager Help system

For detailed information on using the online Help system, refer to 
the topic “Using Help” in the Process Manager online help.
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Obtaining additional support

For additional information about the following topics, refer to the 
Xerox Customer Software Release Document (CSRD) for 
FreeFlow Process Manager:
• X-PRESS FAX
• FreeFlow FAQ Xerox web site
• Xerox Welcome Center
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About FreeFlow Process Manager

1. About FreeFlow Process 
Manager 

This section provides information about Xerox FreeFlow Process 
Manager applications, hardware and software components, 
preparatory steps for workflow building and job management, user 
and group access, the log in process, adding and removing 
printers, creating Preps Job files, and backup and restore 
functions.

FreeFlow Process Manager applications

FreeFlow Process Manager consists of three applications that 
allow you to create, submit, and manage automated workflows:
• Workflow Builder
• Workflow Submission Client
• Workflow Job Manager
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About FreeFlow Process Manager

The Workflow Builder application

Use Workflow Builder to:
• Create workflows

– Use graphical tools to assemble customized workflows 
from workflow process steps.

– Configure the settings for workflow process steps. 
– Enable workflows to receive jobs.
– Disable workflows to modify them or to prevent job 

submission.
• Import and export workflows. 
• Take processes offline and change concurrency counts.
• Create preflight profiles by launching Adobe Acrobat.
• Set up and manage hot folders.
• Add external PDF processes to support third party software.
• Set up third-party scripts.
• Set up Notify attributes on the SMTP server; set up the Proxy 

server.
• Set up repository credentionals.
The Workflow process steps include: 

Table 1-1. Workflow process steps

Step Description

Input Displays automatically as the first workflow node when you select 
<Enter> during new workflow creation. Does not have a settings 
dialog in Workflow Builder. In Workflow Job Manager, the 
settings dialog and the tool tip display the original input files.

AIE Automatic Image Enhancement (AIE) optimizes sharpness, color 
balance, saturation, exposure, noise reduction and contrast of 
TIFF, JPEG, and BMP images, whether standalone or embedded 
in a PDF. AIE also supports redeye removal for humans and 
shadow detail enhancement. The AIE feature works only for color 
and grayscale images.

Convert Converts documents submitted to the workflow to PDF. Converts 
the following formats: MS Word, MS PowerPoint, MS Excel 
(includes Microsoft Office 2007), MS Publisher, Adobe 
Photoshop, Adobe InDesign, Adobe Illustrator, JPG, JPEG, TIFF, 
TIFF-IT, TIF, BMP, PS, RDO, QXD, QXP, VPC, and EPS. 
Allows you to flatten PDFs for printing.
Users can select from various job options to generate optimal 
PDFs.

Join Combines multiple PDF files into a single PDF file.
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About FreeFlow Process Manager

Optimize The Optimize process allows you to modify a PDF file to be PDF/
X compliant, specify how fonts should be embedded, define PDF 
Box settings, configure spot color settings, and manage color 
profiles. You can also remove trap layers and replace hairlines.

Preflight Uses a preflight profile to validate and check formatting, verify the 
image, fonts, and verify references to OPI image server images. 
The preflight checks depend on the profile selected.

You can also use Preflight to let the workflow automatically 
discover conditions. For example, you can create a single-rule 
profile, use it as a filter to check a file for a specific condition, for 
example, a certain page size, and then direct the file to the next 
appropriate process or workflow. 

Watermarks Allows you to add a text or image watermark to each page of an 
input PDF file. You can specify a combination of opaque or 
transparent images or text, in various alignments, that can 
appear either underneath or on top of the page content. The 
Preview option allows you to dynamically view the content before  
committing to the selected settings.

Bates 
Numbering

Allows you to add bate stamps to each page of an input PDF file. 
Bate stamps consist of a page number with optional leading 
zeros and an optional fixed text prefix. An optional extra line of 
fixed text can appear either above or below the page number.  
The Preview option allows you to dynamically view the content 
before  committing to the selected settings.

Page 
Numbering

Allows you to add page numbers to each page of an input PDF 
file.  The Preview option allows you to dynamically view the 
content before  committing to the selected settings.

Barcode Allows you to add a barcode to your workflow. You can specify 
the barcode type, font, placement, alignment, rotation, frequency, 
size and other options. Provides support for variable data in the 
text and page range areas. The Preview option allows you to 
dynamically view the content before  committing to the selected 
settings.

Rotate Pages Allows you to rotate each page in the PDF file 90 degrees right or 
left, or 180 degrees.

Flip Pages Allows you to flip each page in the PDF file horizontally or 
vertically to create a mirror image.

Resize Allows you to select a specific size, or a size based on a 
percentage of the original image size. For TIFFs, JPGs, or BMPs, 
the image is resized; for PDFs, the page is resized.

Table 1-1. Workflow process steps

Step Description
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About FreeFlow Process Manager

Impose Allows you to do the following: 
• Use imposition to define the placement of page elements. 
• Place crop marks. 
• Select various job types—for example, signature booklets and 
N-up. 
• When the PREPS impostion node is selected, choose from a list 
of preconfigured PREPS imposition job files.
• Select from various PDF Boxes.
• Select Cell Clustering, which provides the option of pulling 
together cells on a sheet in a way that results in cell sizes that 
contain the imposed page image with no waste space between 
cells.
The Preview option allows you to dynamically view the content 
before  committing to the selected settings.

Crop Allows you to automatically crop jobs consisting of one or more 
PDF pages and JPEG, TIFF, or BMP file images. For PDF 
documents, crops the pages; for JPEG, TIFF, or BMP files, crops 
the images.

Pressmarks Allows you to add a fixed pressmark to a workflow. You can 
specify the pressmark placement, rotation, frequency, and 
transparency, and then preview the specifications. The Preview 
option allows you to dynamically view the content before  
committing to the selected settings.

Review Can be used multiple times, at critical points in a workflow, to 
view, check and edit the PDF file using Adobe Acrobat. 

When stopped at the Review step, you can change process 
settings, resubmit the job to a previous step for additional 
processing, view a soft proof, or print a hardcopy proof. 

You can approve the job and allow it to move to the next step in 
the workflow, or you can fail the job.

If there is a Print step after the Review step, you can select 
[Copies] to access the Copies dialog and change the number of 
copies to print.

Notify Provides job status notification via e-mail. Allows you to attach 
job files up to a maximum size of 1 GB.

Print Allows you to print PDF, VPC, or RDO (for reprint) files to a 
specified production printing queue using a specified job ticket.
For information about reprinting RDOs, refer to the topic “About 
submitting RDOs.”

Save Allows you to save all supported file types from the workflow to a 
specified location in a Windows file system or document 
repository.

You can also use Save to direct or “branch” a job to other 
workflows by designating a hot folder as the Save location. 

Table 1-1. Workflow process steps

Step Description
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About FreeFlow Process Manager

JDF Export Creates a JDF ticket and exports a PDF and JDF ticket to a 
specified location in a Windows file system or document 
repository. You have the option to export the JDF with changes 
made by the external process nodes.
The output file of a JDF export task can be re-imported and re-
run by dropping it into a hot folder associated with an appropriate 
workflow. The files associated with the JDF must exist in the 
same location as the original job.

Conditional Conditional branching provides an added level of logic to a 
workflow, allowing it to examine the properties of submitted jobs, 
and then act accordingly without human intervention.
You can add one or more conditional branches to a workflow, 
each with one or more user-designated conditions that specify 
the desired attributes or properties of the submitted jobs.

External 
Process 

External Processes enable the use of third party workflow 
components. The processes are added and configured in 
Workflow Job Manager.

Table 1-1. Workflow process steps

Step Description
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About FreeFlow Process Manager

The Workflow Submission Client application

Use Workflow Submission Client to:
• Select files for submission from WIndows or from a document 

repository.
• Save and load a file list.
• Select an optional job ticket for submission with the files. 
• Submit the files to one of the automated workflows.
• Modify the workflow process settings. 
• View the job ticket and resolve job ticket conflicts.
• Launch Workflow Buider
• Submit files remotely from a workstation or server with 

Remote Workflow Submission Client installed.
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The Workflow Job Manager application

Use Workflow Job Manager to:
• View job details and status.
• Review and edit jobs in Adobe Acrobat.
• Edit process settings.
• Print hardcopy proofs.
• Identify faulted jobs.
• Resubmit jobs. 
• Approve, fail, pause, or delete jobs.
• Generate, view, and export reports.
• Launch Workflow Submission Client, Workflow Builder, Printer 

Registration, and FreeFlow Administration Tool.
• Review and configure incoming third party jobs from 

Management Information Systems (MIS).
• Perform selected tasks remotely from a workstation or server 

with Remote Workflow Job Manager Client installed.
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FreeFlow Process Manager hardware and software configurations

For information pertaining to FreeFlow Process Manager 
hardware and software configurations, refer to the Xerox 
Customer Software Release Document (CSRD) for FreeFlow 
Process Manager.
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Post-installation setup

Table 1-2 provides a post-installation checklist you must complete 
after your FreeFlow Process Manager system has been installed. 
NOTE: This checklist assumes that a Xerox Representative has 
installed of all hardware and software necessary to run the 
FreeFlow Process Manager system.  

Table 1-2. Workflow and Job Management Preparatory Procedures 

Procedure Overview 

Configure document 
repository connections 

Use the FreeFlow Administration Tool to configure the connection between 
FreeFlow Process Manager and the supported document repositories. 

For detailed procedures on configuring repository connections, refer to the 
System Administrator Guide or to the FreeFlow Administration Tool online Help 
system.

Create user accounts; 
add or edit user contact 
information; change 
XDL Admin account 
password

Creating User Accounts Process Manager user accounts are created and 
managed using the Windows Local Users and Groups functionality in the 
Computer Management application. Users that are created and added to the 
appropriate Process Manager group accounts using Windows appear in the 
FreeFlow Administration Tool list of users.

Storing User contact information The FreeFlow Administration Tool is 
used to view user accounts that have been created in Windows, and to add or 
edit user contact information. 

Changing the XDL Admin account password 
The FreeFlow Administration Tool allows you to change the password for the 
XDL Admin account. This password is set during the installation of the software.

For detailed procedures on creating user accounts, refer to the Windows online 
help. For detailed procedures on adding or editing user contact information or 
changing the XDL Admin account password, refer to the System Administrator 
Guide or to the FreeFlow Administration Tool online Help system. 
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Manage production 
printers for workflows

Production printers must be added to FreeFlow Process Manager before you 
attempt to drag a Print process into a workflow during the workflow building 
process.

In FreeFlow 6.0, a new common printer interface enables all FreeFlow 
applications to maintain a single database of configured printers and to have a 
common job setup GUI interface across FreeFlow applications.  The common 
printer interface includes the following utilities: 

Registered Printer List Locator: Allows you to set whether the registered 
printer list in use by a FreeFlow applicaton is located on a local computer or on a 
remote computer. 

Printer Registration: Allows you to register and manage supported 
production printers and queues for use by FreeFlow software applications. To 
configure the Print process step in a workflow, production printers must first be 
added via the FreeFlow Printer Registration application.

Printer Status/Job Status Tool: Allows you to status jobs, queues, and 
printers.
For additional information about Production Printing, refer to the Xerox 
Customer Software Release Document for FreeFlow Process Manager, 
or the Xerox Production Printing Guide for FreeFlow Applications. 

You can also  access the online Help for the Registered Printer List Locator, 
Printer Registration, or the Printer Status/Job Status Tool.

Configure the SMTP 
server

The Simple Mail Transport Protocol (SMTP) Server is used for e-mail 
notification. The SMTP Setup dialog, accessed via the Workflow Builder  
application, allows you to identify the mail server for outgoing mail or 
notifications and to establish the maximum size for e-mail attachments.

For details, refer to the following procedure in the Freeflow Process Manager 
Operator and Administrator Guide or the online help: “Setting up the SMTP 
Server.”

Set up workflows Three default workflows are provided with the software: Simple, Main, and 
Reprint. Modify these workflows or create your own, based on the needs of your 
organization. You may want to name workflows based on clients (XYZ Co.) or 
types of jobs (brochure, newsletter, flyer). 

For details, refer to the following procedure in the Freeflow Process Manager 
Operator and Administrator Guide or the online help: “Configuring process 
settings;” “Building a new workflow.”

Generate the preflight 
profile repository on a 
clean install.

Preflight profiles do not exist on a clean install. You will need to generate the 
profile repository.

For details, refer to the following procedure in the Freeflow Process Manager 
Operator and Administrator Guide or the online help: “Configuring preflight 
settings.”

Table 1-2. Workflow and Job Management Preparatory Procedures 

Procedure Overview 
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Create or modify 
preflight profiles.

The preflight step validates and checks formatting and verifies the image, fonts 
and references to OPI image server images. You may want to modify the 
preflight profiles that are provided with FreeFlow Process Manager. 

For details, refer to the following procedure in the Freeflow Process Manager 
Operator and Administrator Guide or the online help: “Creating preflight 
profiles.

Set the default job 
option in Adobe 
Acrobat

For the Convert process, you can select from various job options, or create 
custom job options, to generate optimal PDFs in Process Manager. The default 
job option that is displayed in Process Manager is selected in Adobe Acrobat 
Distiller. You can ensure that Process Manager displays the desired Adobe 
Acrobat Distiller default job option by selecting a profile from the Default Settings 
drop box in Acrobat Distiller. 

For details, refer to the following procedure in the Freeflow Process Manager 
Operator and Administrator Guide or the online help: “Configuring Convert 
settings.”

Upgrade legacy 
workflows that contain 
the Job Level Edit 
process.

In previous versions of FreeFlow Process Manager, all job level edit functions 
(for example, watermarks, page numbering, page rotation) were available via a 
single Job Level Edit dialog. Legacy workflows that contain Job Level Edit 
processes will perform as they did in earlier versions, but you will not be able to 
edit them. To use the version 6.0 job level edit functions, save the existing Job 
Level Edit workflow, and it will be converted into a series of individual, 
Watermark, Bates Numbering, Page Numbering, Flip and Rotate nodes, as 
appropriate.

For details, refer to the following procedure in the Freeflow Process Manager 
Operator and Administrator Guide or the online help: “Upgrading legacy 
workflows that contain the Job Level Edit process.”

Ensure Color Manage 
workflow consistency 
between the server and 
a remote client.

Importing 5.0 
workflows with a Color 
Manage node.

Workflows that include color management can become inconsistent between the 
Process Manager server and the remote client when profiles are uninstalled on 
the server.

Color profiles are now managed in the Optimize node Color tab.
If you import a 5.0 workflow with a Color Manage node into FreeFlow Process 
Manager 6.0, the 5.0 Color Manage icon is converted to an Optimize icon and 
the settings transfer automatically to the Optimize settings Color tab.

For information, refer to the Ensuring Color Manage workflow consistency 
between the server and a remote client procedure and Importing a 5.0 
workflow with a Color Manage node.

Import ICC profiles 

ICC profile rights

Import any required ICC profiles.

You must own the rights to use the ICC profiles accessed by FreeFlow Process 
Manager.
For details, refer to the following procedure in the Freeflow Process Manager 
Operator and Administrator Guide or the online help: “To import an ICC 
profile.”

Table 1-2. Workflow and Job Management Preparatory Procedures 

Procedure Overview 
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Set up hot folders You may want to designate hot folders ahead of time. 
You can open a common browse folder dialog and select or create a folder in the 
system via the Hot Folders dialog in Workflow Builder. 

You can:
Schedule all hot folders for the same times of day or schedule hot folders 
individually.
Pause/resume all hot folders or individual hot folders.
Enable file clustering on a per hot folder basis.

For details, refer to the following procedure in the Freeflow Process Manager 
Operator and Administrator Guide or the online help: “Setting up a hot 
folder.”

Set up external 
processes

You may want to add external processes to support third party software, or to 
set up third party scripts.

For details, refer to the following procedure in the Freeflow Process Manager 
Operator and Administrator Guide or the online help: “Using third party 
external processes.

Set up Preps To use Preps, you will need to install it, configure the default Preps workflow, 
and create and save Preps job files.

For details, refer to the following procedure in the Freeflow Process Manager 
Operator and Administrator Guide or the online help: “Setting up Preps.”

Table 1-2. Workflow and Job Management Preparatory Procedures 

Procedure Overview 
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Using the FreeFlow Administration Tool

The FreeFlow Administration Tool provides the following options:
• Repository icon: Displays the Repository Connections tab, 

where you can administer the connections between a 
Repository Management System (RMS) server to available 
Document Management System (DMS) repositories.

• Conversion Settings icon: Displays the Conversion Settings 
tab which contains the settings for the dynamic conversion of 
documents uploaded to document repositories. These settings 
will serve as the defaults for the File Conversion Tool 
application.

• Process Manager icon: Available only on machines running 
FreeFlow Process Manager. Opens the following tabs:
– Backup: Allows you to back up FreeFlow Process 

Manager user and group information, workflows, jobs, and 
task information to a user selectable directory location.

– Restore: Allows you to restore previously back up 
FreeFlow Process Manager user and group information, 
workflows, jobs and task information.

• User Accounts icon: Available only on machines running 
FreeFlow Process Manager. Displays tabs used to view and 
edit select FreeFlow Process Manager user account contact 
information. 
Process Manager user accounts are created and managed 
using the Windows Local Users and Groups functionality in the 
Computer Management application. Users that are created 
and added to the appropriate Process Manager group 
accounts using Windows will appear in the FreeFlow 
Administration Tool list of users. The following options are 
available:
– Storing User contact information: The FreeFlow 

Administration Tool is used to view user accounts created 
in Windows, and to add or edit user contact information. 

– Changing the XDL Admin account password:The 
FreeFlow Administration Tool allows you to change the 
password for the XDL Admin account. This password is set 
during the installation of the software. 

For more information refer to the Xerox FreeFlow System 
Administrator Guide and  the FreeFlow Administration Tool online 
Help system.
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Legacy Document Library

Document Library is no longer available with the FreeFlow 6.0 
product offering. Supported document repositories in FreeFlow 
6.0 include Xerox Docushare and SharePoint.
NOTE: Any previous version of FreeFlow Makeready, FreeFlow 
Process Manager, and FreeFlow Web Services customers using 
Document Library, must migrate to a supported repository. For 
more information, contact your Xerox representative. 

Document conversion

Previously, Document Library users used the background batch 
utility, provided via the Conversion tab in the Library 
Administration Tool, to convert documents within Document 
Library cabinets to PDF. 
In FreeFlow 6.0, you may wish to use the FreeFlow File 
Conversion Tool, available via the Start menu, to convert 
documents residing in file systems or repositories to PDF.

Managing backup and restore functions

In FreeFlow 6.0, the customer is ultimately responsible for backing 
up and restoring the FreeFlow system, whereas in previous 
versions of FreeFlow, a backup strategy was recommended. 
The FreeFlow Administration Tool is used to back up and restore 
FreeFlow Process ManagerProcess Manager user information, 
workflow, job, and task information to a user-selectable directory 
location.
For detailed information about backing up and restoring data with 
the FreeFlow Administration Tool, refer to the FreeFlow 
Administration Tool online Help.
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Logging in to the FreeFlow Process Manager applications

You can open all FreeFlow Process Manager applications via the 
Start menu or the Control Center shortcut bar. 
• You can open Workflow Builder via Workflow Submission 

Client and Workflow Job Manager.
• You can open Workflow Submission Client via Workflow Job 

Manager.
Process Manager user accounts are created and managed using 
the Windows Local Users and Groups functionality in the 
Computer Management application. During install, Xerox 
FreeFlow Process Manager Administrators and Xerox 
FreeFlowProcess Manager Operators groups are created. Your 
administrator then populates these groups with users. 
Permissions to launch applications are based on group 
membership. For more information, see Group membership and 
authorization.
When attempting to open a FreeFlow Process Manager 
application:
• If you are currently logged into a Process Manager server, but 

are not a member of either the Xerox FreeFlow Process 
Manager Administrators or Xerox FreeFlow Process Manager 
Operators group, a message displays and you may not have 
permission to run the application. This also applies to logged-
in users on remote client machines.

• If you are currently logged into a Process Manager server, are 
a member of the Xerox FreeFlow Process Manager Operators 
group, and you are attempting to access an application that 
requires Xerox FreeFlow Process Manager Administrators 
group privileges, a login screen displays and you must enter 
the required credentials. This also applies to logged-in users 
on remote client machines

• If you have permission to launch an application by virtue of 
membership in an authorizing group, the application launches 
without asking for credentials. See your administrator for 
questions about your user account.
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Authorization error message

The Windows OS caches a user's group membership 
information. If you add yourself to an authorization group (e.g., 
Xerox FreeFlow Process Manager Administrators) and then try to 
launch an application, you will receive an error message indicating 
you do not have permission to launch FreeFlow Process Manager 
applications.To rectify this issue, log off and then log back on.
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To log in to the FreeFlow Process Manager applications

If you enter the incorrect username or password, you receive an 
incorrect username or password error message. You can then 
enter your correct username and password.
1. Select [Start: Programs: Xerox FreeFlow Software: 

FreeFlow Process Manager: <application>]. The Login 
dialog opens for the selected application.

2. In the User name text box, enter your user name.
3. In the Password text box, enter your password.
4. The Domain text box is populated with the domain of the 

currently logged in user, or the last domain entered in the login 
form. Confirm that the proper domain name appears.

5. Enter the appropriate Process Manager server name in the 
Server text box.

6. Select [OK]. The main window for the selected application 
opens.

Group membership and authorization

The following table shows authorization based on  membership in 
FreeFlow Process Manager Administrators or FreeFlow Process 
Manager Operators groups. 

NOTE: Printer Registration also supports user authentication 
through the operating system and application-level authorization 
through membership in operating system groups.

Table 1-3. Group Membership and Authorization

Administrator Operator

Can launch Workflow Job Manager, 
Workflow Submission Client, Manifest 
Automation from Xerox (MAX)

Can launch Workflow Job Manager, Workflow 
Submission Client, Manifest Automation from 
Xerox (MAX)

Can launch Workflow Builder Cannot launch Workflow Builder

Can launch FreeFlow Adminstrator Tool 
and perform all adminstrative tasks

Can launch FreeFlow Adminstrator Tool and edit 
repository connnection information
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Managing production printers

In FreeFlow 5.0, Workflow Printer Administration was used to 
configure and manage production printers. In FreeFlow 6.0, a new 
common printer interface enables all FreeFlow applications to 
maintain a single database of configured printers and to have a 
common job setup GUI interface across FreeFlow applications.  
The common printer interface includes the following utilities: 
• Registered Printer List Locator: Allows you to set whether 

the registered printer list in use by a FreeFlow application is 
located on a local computer or a remote computer. 

• Printer Registration: Allows you to register and manage 
supported production printers and queues for use by FreeFlow 
software applications. To configure the Print process step in a 
workflow, production printers must first be added via the 
FreeFlow Printer Registration application.

• Printer Status/Job Status Tool: Allows you to status jobs, 
queues, and printers.

Xerox FreeFlow Common Printer Administrators group

In order to make changes to registered printers with the Printer 
Registration tool, a user must be a member of the Xerox FreeFlow 
Common Printer Administrators group.
A logged-in user who is a member of the group has full access to 
the add/edit functionality in the Printer Registration tool. 
If the user is not a member of the group, the error message “The 
logged in user does not have administrative access” displays and 
the tool runs in read-only mode. A login dialog, accessed from the 
file menu, allows  the user to log in and turn on the add/edit 
functionality. The login dialog requires a user name, a password, 
and a domain.
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To register and add a production printer

1. Select [Start: Programs: Xerox FreeFlow Software: Printer 
Registration], or in Workflow Job Manager, select [Launch: 
Printer Registration]. The Installed Products dialog displays.

2. Ensure the radio button for Process Manager is marked.
3. Select [OK]. 
4. In the Printer Registration dialog, select the desired task: 

[Add...], [View/Edit...], or [Delete]. 
5. For additional information about registering and managing 

printers, select [Help] in the Printer Registration dialog to open 
the online Help.

For additional information about Production Printing, refer to the 
Xerox Customer Software Release Document for FreeFlow 
Process Manager, or the Xerox Production Printing Guide for 
FreeFlow Applications, or access the online Help for the 
Registered Printer List Locator, Printer Registration, or the Printer 
Status/Job Status Tool.
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Setting up Preps

To use PREPS, install PREPS in the following way:
NOTE: FreeFlow Process Manager, Version 6.0, supports Kodak 
PREPS  5.2.2.

NOTE: When the PREPS documentation uses the term Xerox 
DigiPath, it is referring to FreeFlow.

• For Setup Type, select the Custom Install. 
• Select the following components during installation:

• PREPS Program
• Languages
• Xerox Digipath
• Automation
• iKey Hardware Key Driver or Sentinel Hardware Key 

Driver
You also have to physically install the appropriate hardware key.
Once PREPS is installed, you need to perform the following:
• Configure PREPS to use the Default workflow PDF to PDF.
• Create and save PREPS Job files.

See also
To configure the Preps default workflow
To create and save Preps Job files
To select a device type for PREPS versions prior to 5.2.2
Missing hardware key error
Using PREPS with Adobe Acrobat 8.0
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To configure the Preps default workflow

1. Start PREPS. 
2. Select [Edit: Preferences...] to display the Preferences 

dialog. 
3. Select the [General] tab. In the Default workflow box, select 

[PDF -> PDF].
4. Select [OK] to close the Preferences dialog.
5. Select [Setup: Save Profile...] to display the Save Profile 

dialog.
6. In the Profile Name text box, ensure that “default” is entered, 

and select [OK] to save the profile. 
7. If the message “Profile default already exists. Overwrite 

anyway.” displays, select [Yes].
8. Exit Preps. 
9. The Save current configuration dialog prompts “Do you want 

to save the current configuration into the profile,” select [Yes]. 
Preps closes.

NOTE: The profile must be manually edited in a text editor to allow 
output to a PDF file. After completing steps 1-9, above, do the 
following:

10. On the Process Manager server, locate the file “default.cfg” 
under <Preps Install dir>\Preps 5.2\Profiles\Default. 

11. Open the file with a text editor. 
a. Double-click “default.cfg”.
b. In the Windows dialog, select [Select the program from a 

list], and select [OK]. 
c. In the Open With dialog, select Notepad, and select [OK].
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12.  Find and change the following entries:
• Change -O:P to -O:D
• Change -ADOBEPJTF:NO to -ADOBEPJTF:YES
• Change -JDFOUTPUT:YES to -JDFOUTPUT:NO
• Change -EXPORTPDF:NO to -EXPORTPDF:YES
• Change SkipDeviceSizeWarning:NO to 

SkipDeviceSizeWarning:YES
13. Save and close the file.
14. For Preps 5.2.2, make the default.cfg readonly once you have 

made all changes: 
a. In Windows Explorer, select the default .cfg file. 
b. Right -click and select [Properties].
c. In the General Tab, in the Attributes area, mark the check 

box for [Read-only]. 
d. Select [OK].

15. If there is a .cfg file under <Preps Install dir>\Preps 
5.2\Profiles, make the same changes as in steps 11 - 13 to this 
file, also.

To create and save Preps Job files

When you use PREPS, the FreeFlow Workflow Builder system 
searches the Imposition Jobs directory for Preps files with a .job 
suffix. Since no default .job files are provided, the user must 
create them.
1. Start PREPS.
2. To create a new PDF job, select [File: New Job: PDF->PDF]
3. In the Signature List window, select [Signatures...] to open 

the Signature Selection dialog. 
4. In the Signature Selection dialog, select a style from the list in 

the Binding style drop box. 
5. Click [+] to expand the Sample Templates tree and display a 

list of templates. 
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6. In the displayed list of templates, click [+] to expand the 
desired template, then select the appropriate signature. 

7. Select [Add] to add the template and signature to the job file. 
The job file template displays in the Template/Signature/Page 
window.

8. Select [OK] to close the Signature Selection dialog.The job file 
template displays in the Signature List window.

You must select a device type for each signature.
9. In the Signature List window, select the desired signature. The 

[Device...] button is enabled. 
10. Click [Device...]. 
11. In the Choose Device window, select [Press Sheet Size] as 

the target device. You must select a device for each signature.
12. Select [OK] to close the Choose Device window.
13. To save the job file, select [File: Save Job] or [File: Save Job 

As...]. Either opens the Save Job As dialog.
14. In the Save in list box, navigate to the FreeFlow Install 

Directory\ImpositionJobs directory, typically, E:\ FreeFlow\ 
ImpositionJobs.

15. Type the appropriate file name, and select [Save].
16. Repeat steps 2-11 to add more job file templates.
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To select a device type for PREPS versions prior to 5.2.2

You must select a device type for each signature in order to use  
old PREPS job files.
1. Start PREPS.
2. Select [Setup: Device Setup]. 
3. Select [Press Sheet Size] in the “Installed Devices” section.
4. Select [OK] to close the Device Setup dialog.
5. Close the PREPS application. You can now use the old job 

files.
For more information about device setup, refer to your PREPS 
documentation.

Missing hardware key error

If the ”Preps Server error, check Preps Automation Front-End 
server” error message is displayed on your PREPS UI or on the 
server that you are using to run PREPS, do the following, even if 
the PREPS hardware key is not missing:
1. Stop the PREPS Automation Front-End server by performing 

one of the following:
• If there is a yellow folder icon (with the tooltip “Waiting for 

Jobs”) in the systray, double-click the icon to open the 
Preps UI.
– In the UI, select [File: Exit] to close PREPS. 

• If there is not a yellow folder icon (with the tooltip “Waiting 
for Jobs”) in the systray, then the application must be 
stopped in the Windows Task Manager.
– Open Windows Task Manager, find the PrepsSlv.exe 

process, and end the process.
– Find the PrepsSrv.exe process and end the process.

2. Close the FreeFlow Process Manager applications and shut 
down the FreeFlow Process Manager server. 

3. Reinsert the hardware key.
4. Reboot the FreeFlow Process Manager server. 
5. Open the FreeFlow Process Manager applications and 

resubmit the job. The Preps Automation Front-End server 
starts automatically.
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 Using PREPS with Adobe Acrobat 8.0

When using Adobe Acrobat 8.0, after PREPS installation, you 
must change the PDF Conversion Acrobat directory.

To use PREPS with Adobe Acrobat 8.0

1. Start PREPS. 
2. Select [Edit: Preferences...] to display the Preferences 

dialog. 
3. Select the [PDF] tab. 
4. Select Adobe Acrobat and select the directory in which you 

installed Adobe Acrobat 8.0, for example C:\Program 
Files\Adobe\Acrobat 8.0\Acrobat.exe. 

5. Select [OK] to close the Preferences dialog.



FreeFlow Process Manager Operator and Administrator Guide1-26

About FreeFlow Process Manager



FreeFlow Process Manager Operator and Administrator  Guide 2-1

Workf low Bui lder

2. Workflow Builder 

Xerox FreeFlow Workflow Builder provides the ability to create 
workflows by dragging and dropping processes into a user-
defined sequence. The optional ability to configure and add third 
party software workflow components to a workflow enhances the 
flexibility and capabilities of the Process Manager system.

About Workflow Builder 

A workflow is a sequence of uniquely configured steps that define 
how a document is processed. Use Workflow Builder to: 
• Create workflows

– Use graphical tools to assemble customized workflows 
from workflow process steps.

– Configure the settings for workflow process steps. 
– Enable workflows to receive jobs.
– Disable workflows to modify them or to prevent job 

submission.
• Import and export workflows. 
• Take processes offline and change concurrency counts.
• Create preflight profiles by launching Adobe Acrobat.
• Set up and manage hot folders.
• Add external PDF processes to support third party software.
• Set up third-party scripts.
• Set up Notify attributes on the SMTP server; set up the Proxy 

server.
• Set up repository credentionals.



FreeFlow Process Manager Operator and Administrator Guide2-2

Workf low Bui lder

 Logging in to Workflow Builder

Process Manager user accounts are created and managed using 
the Windows Local Users and Groups functionality in the 
Computer Management application. During install, Xerox 
FreeFlow Process Manager Administrators and  Xerox FreeFlow 
Process Manager Operators groups are created. Your 
administrator then populates these groups with users. 
Permissions to launch applications are based on group 
membership.
NOTE: If you are not a member of an authorizing group, contact 
your administrator. If you forget your username and password, 
notify your administrator.

To log in to Workflow Builder

A login screen may or may not display, depending on group 
membership and server location.
If you enter the incorrect username or password, you receive an 
incorrect username or password error message. You can then 
enter your correct username and password.
1. Select [Start: Programs: Xerox FreeFlow Software: 

FreeFlow Process Manager: Workflow Builder]. The Login 
dialog opens for the selected application.

2. In the User name text box, enter your user name.
3. In the Password text box, enter your password.
4. The Domain text box is populated with the domain of the 

currently logged in user, or the last domain entered in the login 
form. Confirm that the proper domain name appears.

5. Enter the appropriate Process Manager server name in the 
Server text box.

6. Select [OK]. The main window opens.
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Workflow Builder main window

Two major areas comprise the Workflow Builder main window: the 
workflow list and the workspace.
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Workflow list

The workflow list, in the upper portion of the window, includes the 
following components: 
• Menu bar
• Workflows toolbar 
• List of the current workflows
• Three default application workflows:

– Main Workflow
– Simple Workflow 
– Reprint Workflow

Workflow List 
Area

Workspace 
Area
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Workflow list columns

The workflow list contains the following columns:

In the workflow list, you can sort the list by the items in any column 
by clicking the column heading.

Table 2-1.  Workflow list columns.

Column Description

Workflow Name Lists the names of the workflows.

Id Lists the workflow Ids.

Status Lists whether the workflow is Enabled, Disabled, 
Enabled-Busy, or Disabled-Busy. 

Date Modified Lists the time and date the workflow was last 
changed.

Description Displays workflow comments entered by users.

Processes Shows a small graphical representation of each 
workflow.

Active Jobs Lists the number of active jobs.

Hot Folders Lists the number of hot folders associated with the 
selected workflow.
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Workspace

The workspace, in the lower portion of the workflow window, 
includes the following components:
• Name of the currently selected workflow
• Workspace toolbar
• Workflow Process Options— the workflow building blocks 
• Workspace—for workflow assembly, display, and modification
When a user selects a workflow in the list, it is graphically 
displayed in the workspace. If the workflow is in the “disabled” 
status and does not currently have jobs that are being processed, 
it is available for editing.

Zooming in and out of the workflow view

For large or complex workflows, this feature allows more 
processes to be displayed in the workflow window. Three zoom 
levels are available:
Small Icons: Displays small icons.
Medium Icons: Displays mid-sized icons.
Large Icons: Default; displays large icons.
NOTE: To display the process name in this view, hover over a 
process with the mouse cursor to show the tool tip.
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To zoom in or zoom out

• Select [View: Workflow Icons], and then select the desired 
option, or 

• Right-click in the graphical workflow area, select [Workflow 
Icons], and select the desired option.

Expanding and restoring the viewing space

The expand and restore capability provides more viewing space in  
selected areas.

To expand and restore the view

1. To expand the view, click the right-facing [Expand] arrow to 
the left of the title area—for example, “Workflows” in Workflow 
Builder.

2. To restore the view to the original size, click the down-facing 
[Restore]arrow.

Enabling and disabling process tool tips

You can view process settings via tool tips in the graphical 
workflow display by positioning the mouse pointer over a workflow 
process.
NOTE: In Workflow Job Manager, the tool tip for the Input node 
displays the original input files.

To enable/disable tooltips

bbb In the View menu, 
• To enable tool tips, select [Show Process Tool Tips].
• To disable tool tips, select  [Hide Process Tool Tips].
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Finding a process node

The Find feature simplifies the task of locating process node in a 
workflow.

To find a node

1. In Workflow Builder, Workflow Job Manager or Workflow 
Submission Client, select a workflow or a job.

2. Select [Edit: Find...].
3. In the Find what text box, enter the process name and select 

[Find Next]. 
4. If the process is located, it becomes the selected process.
5. Select [Find Next] to locate the next instance of the process. If 

no additional processes are found, the Reached end of 
Workflow message displays. 

6. To continue the search from the beginning, select [OK]. 
7. If the process is not located, a “Node name not found” 

message displays. Select [OK] to close the Not Found dialog.
8. Begin a new search or close the dialog to end the search.
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Workflow Builder menus

The Workflow Builder menu bar provides commands for creating 
and modifying workflows. 
Commands can also be accessed by right-clicking on a workflow 
or workflow option to display the context menu. Menu items that 
are not available are grayed out.

See also:
The File menu
The Edit menu
The View menu
The Options menu
The Insert menu and workflow process icons
The Help menu

The File menu

The Workflow Builder File menu contains the following options:

Table 2-2. Workflow Builder File menu

File Menu 
Option Description

New Adds a new workflow to the list. Provides a cursor 
for editing the workflow name. The new workflow is 
added to the list and graphically displayed in the 
workspace by a yellow Input folder.

Save Saves changes to the workflow that is currently 
open for modification.

Revert Opens the selected workflow to its last saved state. 
Displays a confirmation dialog.

Import... Opens the Open dialog; allows you to choose .xml 
workflow files.

Export... Opens the Export dialog. Available if one or more 
workflows are selected. 

Exit Closes the Workflow Builder application. If a 
workflow is open and has been changed since it 
was last saved, displays a confirmation dialog. 



FreeFlow Process Manager Operator and Administrator Guide2-10

Workf low Bui lder

The Edit menu

The Workflow Builder Edit menu contains the following options:

Table 2-3.  Workflow Builder Edit menu

Edit Menu Option Description

Workflow 
Properties...

Opens the workflow properties dialog, which allows you to edit 
the workflow name, add a description of the workflow, and 
enable submission to the workflow.

Enable/Disable Enable: Allows a job to be submitted to the selected workflow. 
Enabled workflows are displayed in the Workflow Submission 
Client window. Enable also auto-saves the workflow.

Disable: Prevents jobs from being submitted to the workflow. 
Disabled workflows are not visible or available via the Workflow 
Submission Client.

Duplicate Adds a copy of the selected workflow to the list; provides a 
cursor for editing the workflow name. The user must select 
<Enter> to complete the duplication operation. 

Rename Workflow Highlights the selected workflow name and provides a cursor for 
editing the name. The workflow must first be disabled.

Delete Workflow(s) Deletes the selected workflow with a confirmation dialog.

Cut Deletes and stores the selected process and its properties for 
pasting into the same workflow. 

Copy Stores the selected process and its properties for pasting 
elsewhere in the same workflow.

Paste Pastes the process stored in the clipboard.

Paste as Fail Branch Pastes the process stored in the clipboard as a fail branch of the 
selected process.

Delete Process Deletes the selected process. 

Rename Process Invokes the process rename mode for the selected process.

Process Settings... Opens the settings dialog for the selected workflow process. 

Find... Opens the Find dialog, which allows you to locate a process 
node in a workflow.
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The View menu

The View menu contains the following options:

The Options menu

The Options menu includes the following options:

Table 2-4. Workflow Builder View menu 

View Menu Option Description

Show/Hide Process 
Tool Tips

Show: Allows you to view process settings via 
tool tips in the graphical workflow display by 
positioning the mouse pointer over a workflow 
process.

Hide: Disables the tool tips.

Workflow Icons Small Icons: Displays small icons.
Medium Icons: Displays mid-sized icons.
Large Icons: Default; displays large icons.

Table 2-5. Workflow Builder Options menu

Options Menu 
Option

Description

Processes Opens the Processes dialog, which allows you 
to check the status of a workflow process. 
Allows you to open the Process Settings 
dialog to place the process online or offline, 
and to check or change the concurrent count 
value.
Impose Process Settings allows you to turn 
the copy count divisor functionality on or off. 
This allows you to to adjust the copy count to 
maintain the original quantity intent for 
workflows that contain multiple-up 
impositions. See To enable the Copy Count 
Divisor

Hot Folders Opens the Hot Folders dialog, in which you 
can access the Hot Folder Setup dialog and 
manage existing hot folders. You can delete 
hot folders, pause and resume scanning for 
new files, open the Hot Folder Settings dialog, 
or check hot folder status. 

External Processes Opens the External Processes dialog, which 
allows you to move and delete processes, and 
to access various dialogs for adding and 
configuring external processes.
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SMTP Setup... Opens the SMTP Setup dialog, which allows 
you to set up the SMTP server for e-mail 
notification and to establish a maximum e-mail 
attachment size.

Proxy Setup... Opens the Proxy Setup dialog, which is used 
to configure proxy settings. This enables the 
iWay Prime application to submit PDF jobs to 
Process Manager workflows.

Preflight Setup... Opens Adobe Acrobat, which is used to 
configure preflight profiles.

Repository 
Credentials Setup...

Opens a dialog that allows the current user to 
enter a Username and Password for the 
active repository.

Email Attachment 
Watermark Setup...

Opens the Email Attachment Watermark 
Setup dialog. Allows you to set up and 
customize the security watermark on PDF 
documents sent via email notification.

Table 2-5. Workflow Builder Options menu

Options Menu 
Option

Description
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The Insert menu and workflow process icons

The Workflow Builder Insert menu allows you to insert processes 
into a displayed workflow. 
To insert a process, select a process in a workflow, and select 
[Insert: <item>]. The new process is inserted to the right of the 
selected process.
Workflow processes are also available as icons in the Workflow 
Process Options area. The icons can be dragged and dropped 
into the workspace to assemble a workflow. Processes marked 
with an asterisk (*) in the table, below, are not configurable.

See also:
Customizing a workflow process name 

Table 2-6.  Workflow Builder Insert menu and workflow process icons

Insert Menu 
Options

Workflow 
Process Icon Description

Input

NOTE: Not an 
Insert Menu 
option

Displays automatically as the first workflow node when you 
select <Enter> during new workflow creation. Does not 
have a settings dialog in Workflow Builder. In Workflow Job 
Manager, the settings dialog and the tool tip display the 
original input files.

AIE Automatic Image Enhancement (AIE) optimizes sharpness, 
color balance, saturation, exposure, noise reduction and 
contrast of TIFF, JPEG, and BMP images, whether 
standalone or embedded in a PDF. AIE also supports 
redeye removal for humans and shadow detail 
enhancement. The AIE feature works only for color and 
grayscale images.

Convert Converts documents submitted to the workflow to PDF. 
Converts the following formats: Microsoft Word, Microsoft 
Excel, Microsoft PowerPoint (including Microsoft Office 
2007), Microsoft Publisher, Adobe Photoshop, Adobe 
InDesign, Adobe Illustrator, JPG, JPEG, TIFF, TIFF-IT, TIF, 
BMP, PS, RDO, QXD, QXP, VPC and EPS.

You can select from various job options to generate optimal 
PDFs.

Allows you to flatten PDFs for printing.

Join Combines multiple PDF files into a single PDF file.
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Optimize The Optimize process allows you to modify a PDF file to be 
PDF/X compliant, specify how fonts should be embedded, 
define PDF Box settings, configure spot color settings, and 
manage color profiles. You can also remove trap layers and 
replace hairlines.

Preflight Uses a preflight profile to validate and check formatting, 
verify the image, fonts, and verify references to OPI image 
server images. The preflight checks depend on the profile 
selected.

You can also use Preflight to let the workflow automatically 
discover conditions. For example, you can create a single-
rule profile, use it as a filter to check a file for a specific 
condition, for example, a certain page size, and then direct 
the file to the next appropriate process or workflow. 

Watermarks Allows you to add a text or image watermark to each page 
of an input PDF file. You can specify a combination of 
opaque or transparent images or text, in various 
alignments, that can appear either underneath or on top of 
the page content. The Preview option allows you to 
dynamically view the content before you commit to the 
selected settings.

Bates 
Numbering

Allows you to add bate stamps to each page of an input 
PDF file. Bate stamps consist of a page number with 
optional leading zeros and an optional fixed text prefix. An 
optional extra line of fixed text can appear either above or 
below the page number. The Preview option allows you to 
dynamically view the content before committing to the 
selected settings.

Page 
Numbering

Allows you to add page numbers to each page of an input 
PDF file. The Preview option allows you to dynamically view 
the content before committing to the selected settings.

Barcode Allows you to add a barcode to your workflow. You can 
specify the barcode type, font, placement, alignment, 
rotation, frequency, size and other options. Provides 
support for variable data in the text and page range areas. 
The Preview option allows you to dynamically view the 
content before  committing to the selected settings.

Rotate Pages Allows you to rotate each page in the PDF file 90 degrees 
right or left, or 180 degrees.

Table 2-6.  Workflow Builder Insert menu and workflow process icons

Insert Menu 
Options

Workflow 
Process Icon Description
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Flip Pages Allows you to flip each page in the PDF file horizontally or 
vertically to create a mirror image.

Resize Allows you to select a specific size, or a size based on a 
percentage of the original image size. For TIFFs, JPGs, or 
BMPs, the image is resized; for PDFs, the page is resized.

Impose Allows you to do the following: 
• Use imposition to define the placement of page elements. 
• Place crop marks. 
• Select various job types—for example, signature booklets 
and N-up. 
• When the PREPS impostion node is selected, choose 
from a list of preconfigured PREPS imposition job files.
• Select from various PDF Boxes.
• Select Cell Clustering, which provides the option of pulling 
together cells on a sheet in a way that results in cell sizes 
that contain the imposed page image with no waste space 
between cells. 

The Preview option allows you to dynamically view the 
content before committing to the selected settings.

Crop Allows you to automatically crop jobs consisting of one or 
more PDF pages and JPEG, TIFF, or BMP file images. For 
PDF documents, crops the pages; for JPEG, TIFF, or BMP 
files, crops the images.

Pressmarks Allows you to add a fixed pressmark to a workflow. You can 
specify the pressmark placement, rotation, frequency, and 
transparency, and then preview the specifications. 

The Preview option allows you to dynamically view the 
content before committing to the selected settings.

Table 2-6.  Workflow Builder Insert menu and workflow process icons

Insert Menu 
Options

Workflow 
Process Icon Description
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Review Can be used multiple times, at critical points in a workflow, 
to view, check and edit the PDF file using Adobe Acrobat. 

When stopped at the Review step, you can change process 
settings, resubmit the job to a previous step for additional 
processing, view a soft proof, or print a hardcopy proof. 

You can approve the job and allow it to move to the next 
step in the workflow, or you can fail the job.

If there is a Print step after the Review step, you can select 
[Copies] to access the Copies dialog and change the 
number of copies to print.

Notify Provides job status notification via e-mail. Allows you to 
attach job files up to a maximum size of 1 GB.

Print Allows you to print PDF, VPC, or RDO (for reprint) files to a 
specified production printing queue using a specified job 
ticket.
For information about reprinting RDOs, refer to the topic 
“About submitting RDOs.”

Save Allows you to save all supported file types from the 
workflow to a specified location in a Windows file system or 
document repository.

You can also use Save to direct or “branch” a job to other 
workflows by designating a hot folder as the Save location. 

JDF Export Creates a JDF ticket and exports a PDF and JDF ticket to a 
specified location in a Windows file system or document 
repository. You have the option to export the JDF with 
changes made by the external process nodes.
The output file of a JDF export task can be re-imported and 
re-run by dropping it into a hot folder associated with an 
appropriate workflow. The files associated with the JDF 
must exist in the same location as the original job.

Conditional Conditional branching provides an added level of logic to a 
workflow, allowing it to examine the properties of submitted 
jobs, and then act accordingly without human intervention.
You can add one or more conditional branches to a 
workflow, each with one or more user-designated 
conditions that specify the desired attributes or properties of 
the submitted jobs.

Table 2-6.  Workflow Builder Insert menu and workflow process icons

Insert Menu 
Options

Workflow 
Process Icon Description
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External 
Process 
(only an 
option if one is 
set up)

External Processes enable the use of third party workflow 
components. The processes are added and configured in 
Workflow Job Manager.

Table 2-6.  Workflow Builder Insert menu and workflow process icons

Insert Menu 
Options

Workflow 
Process Icon Description
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Customizing a workflow process name

The ability to change a process name is useful when multiple 
instances of a process exist in a workflow. The new name displays 
beneath the workflow icon and in the process settings window, 
along with the process name. Follow these guidelines:
• Each process in a workflow must have a unique name.
• The name cannot have more than 60 characters.
• You cannot use the following characters: \, /, :, *, ?, “, <, >, or |.

To customize a workflow process name

To customize the process name 1. In Workflow Builder, ensure the workflow is disabled.
2. Double-click the process name below the desired workflow 

node. The name highlights
3. Type a new name.
NOTE: You can also right-click a process, select [Rename], and 
type a new name.

4. Select [Enter].
5. Save and enable the workflow to make the change effective in 

Workflow Job Manager and Workflow Submission Client.
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The Help menu

The Workflow Builder Help menu contains the following options:

Table 2-7. The Workflow Builder Help menu

Help Menu Option Description

Help Topics... Displays the Help application to allow you to 
list the Help topics for Workflow Builder.

About Workflow 
Builder...

Displays program, copyright and version 
information for Workflow Builder. 
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Workflow Builder toolbars

The Workflow Builder toolbars provide commands for creating and 
modifying workflows. 

See also:
Workflows toolbar
Workspace toolbar

Workflows toolbar

The Workflows toolbar contains the following options: 

Table 2-8. Workflows toolbar

Toolbar Option Toolbar Icon Description

New Adds a new workflow to the list. Provides a cursor 
for editing the workflow name. A Start icon is 
displayed in the workspace. 

Save Saves changes to the workflow that is currently 
open for modification.

Enable/Disable Enable: Allows a job to be submitted to the 
selected workflow. Enabled workflows are 
displayed in the Workflow Submission Client 
window. Enable also auto-saves the workflow.

Disable: Prevents jobs from being submitted to the 
workflow. Disabled workflows are not visible or 
available via the Workflow Submission Client.

Duplicate Adds a copy of the selected workflow to the list; 
provides a cursor for editing the workflow name. 
The user must select <Enter> in order to complete 
the duplication operation. 

Delete Deletes the selected workflow with a confirmation 
dialog.
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Workspace toolbar 

The Workspace toolbar allows you perform the following functions 
on a selected workflow process step.

Table 2-9. Workspace Toolbar

Toolbar Option Toolbar Icon Description

Cut Deletes and stores the selected process and 
its properties for pasting into the same 
workflow.

Copy Stores the selected process and its properties 
for pasting elsewhere in the same workflow.

Paste Pastes a process that has been copied.

Delete Process Deletes the selected process.

Settings Displays the settings dialog for a selected 
process.
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Building workflows

You can create Workflows from scratch or by duplicating, and then 
modifying, an existing workflow. To build or modify a workflow, 
you perform the following basic steps:
• Drag and drop process icons into the workspace. Processes 

move from left to right in the workflow.
• Configure the process settings, as needed, to meet the 

requirements of the workflow.
• Save and enable the workflow.
NOTE: All workflows are disabled after an upgrade or migration. A 
pop-up message displays if you try to enable a workflow that 
requires additional configuration. Complete the configuration, and 
then enable the workflow.

Rules for building workflows

Apply the following rules when you sequence workflow process 
steps in the workspace:
Input is the first step in any workflow. Input is automatically 
displayed in the workspace when you begin a new workflow. 
If Convert exists in a workflow, it must precede the following 
processes:
• Join
• PDF Optimize
• Preflight
• Impose
• Bates Numbering
• Page Numbering
• Watermarks
• Rotate Pages
• Flip Pages
• Print 
• Barcodes
• Pressmarks



FreeFlow Process Manager Operator and Administrator  Guide 2-23

Workf low Bui lder

 
If Join exists in a workflow, it must precede the following 
processes:
• Preflight
• Color Manage
• Impose
• Bates Numbering
• Page Numbering
• Watermarks
• Rotate Pages
• Flip Pages
• Print
• Barcodes
• Pressmarks
• Optimize

Building a new workflow

To build a new workflow, drag and drop process icons into the 
workspace, configure the process settings to meet the workflow 
requirements, and then save and enable the workflow.

To build a new workflow

1. Launch Workflow Builder.
2. In the Workflows toolbar, select [New]. A new workflow is 

added to the list. A highlighted name cell is provided for 
editing.

3. Type a workflow name in the cell, and select <Enter>. An 
Input icon displays in the Workspace.

4. Select the desired process from the Workflow Process Options 
area, and drag and drop the process into the workflow 
workspace into the desired position. A Gray placeholder 
indicates where a process can be placed. Links automatically 
display between processes.
You can also use the Insert menu to add a process. The 
process is inserted after the selected process in the workflow.

5. If necessary, configure the process settings.
6. Select [Save] and [Enable].
NOTE: A workflow must be enabled before it can accept new jobs 
for processing.
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Duplicating and modifying an existing workflow

Instead of creating a workflow from scratch, determine if an 
existing workflow has the process steps and process settings that 
approximate your needs. Then copy the existing workflow, add or 
delete process steps, change the properties of a process step, or 
otherwise modify the workflow. 

To duplicate and modify an existing workflow

NOTE: To modify a workflow, it must first be disabled and all jobs 
received for processing in the workflow must be completed.

1. In Workflow Builder, select a workflow from the list.
2. Select [Duplicate] in the Workflows toolbar.
3. Type a new workflow name in the cell, and select <Enter>. 

The new workflow displays in the workspace.
4. Select from the following:

a. To delete a process: Select a process step, and select 
[Delete] in the Workspace toolbar to remove the step from 
the workflow.

b. To add a process: Select a process step from the 
Workflow Process Options area, and drag and drop it into 
the workflow. Repeat to add more processes. If necessary, 
reconfigure the process steps.

5. Select [File: Save] to save the workflow, or select [Enable] to 
enable and auto-save the workflow.

NOTE: After you edit a workflow, it must be enabled to accept new 
jobs.
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Enabling a workflow

A workflow is disabled by default. It must be enabled before it can 
accept new jobs for processing. 
“Enabled Busy” is the status of an enabled workflow that is 
processing a job. The workflow is not available for editing.
NOTE: In Workflow Builder, all options in the node dialogs are 
grayed and cannot be edited when a workflow is enabled. 

To enable a workflow

1. In Workflow Builder, select a disabled workflow from the list.
2. Select [Enable] from the Workflows toolbar.

NOTE: If changes are made to a workflow, it must be saved 
before can be enabled.

Disabling a workflow

A disabled workflow cannot accept new jobs for processing. 
“Disabled Busy” is the status of a disabled workflow that is waiting 
for jobs to finish processing. Once the jobs are completed, the 
status changes to “Disabled” and the workflow is available for 
editing.

To disable a workflow

1. In Workflow Builder, select an enabled workflow from the list.
2. Select [Disable] from the Workflows toolbar. The workflow is 

disabled.
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Deleting a workflow

NOTE: To delete a workflow, the workflow must first be disabled, 
and all jobs received for processing in the workflow must be 
completed.

To delete a workflow

1. In Workflow Builder, select a workflow in the list.
2. In the Workflows toolbar, select [Delete]. A confirmation 

message displays.
3. Select [Yes] to delete the workflow.

Editing workflow properties

The Workflow Properties dialog allows you to change the workflow 
name and description that appear in the list area. In the 
Description field, you may want to include notes regarding when to 
use a particular workflow.

To edit workflow properties

1. In Workflow Builder, select a workflow from the list. 
2. Double-click on the workflow to display the Workflow 

Properties dialog.
3. In the Name field, type a workflow name.
4. In the Description field, type a workflow description.
5. To enable the workflow, select “Enable submission to this 

workflow.”
6. Select [OK] to save the changes and close the dialog.
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Creating fail branches

You may also add fail branches -- contingency workflow steps for 
fail conditions. For example, after a Preflight process, you might 
want to add a fail branch that contains the following: 
• A Notify process that contains Preflight results.
• A Review process, to check or edit the document.
The workflow defaults to having no fail branches open. You can 
open a branch by clicking on the “plus” icon and collapse the 
branch by clicking on the “minus” icon. Only one branch may be 
open at a time. If you open another branch, the branch that is 
currently open automatically closes.

To create a fail branch

1. Select the desired fail branch process and drag it downward, 
after the desired process in a workflow. 

2. Drag the process into the gray space holder that appears after 
the red arrow.

NOTE: You can also place a fail branch after a process step as 
follows: Select, and then [Copy] a process, point to the desired 
position in the workflow, and select [Paste as Fail Branch] from 
the Edit menu. 
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Exporting workflows 

The Process Manager export/import workflow function provides 
workflow portability and a method for backing up and restoring 
workflows.
To import a workflow, you must first generate an .xml workflow file 
by selecting a workflow and exporting it to the desired folder 
location. The .xml file can then be imported into Workflow Builder 
on the same Process Manager server or imported into Workflow 
Builder on a second Process Manage server.
At the conclusion of the export process, the status of workflow 
nodes is listed and the operator is notified if actions are required to 
fully enable the exported workflows.
The Export Workflow dialog displays after you select the file to 
export.
Status text: Status text displays above the upper and lower tables 
and changes to reflect the on-going or completed status of the 
export process.
In the Export Workflow dialog, the upper table shows the export 
status of each workflow. The lower table shows the status of 
nodes of the workflow selected in the upper table.

To export a workflow 

1. In Workflow Builder, select a workflow or multiple workflows.
2. Select [File: Export].
3. In the File name window of the initial Export Workflow dialog, 

type a new name, if desired.
4. To establish an export location, select [Browse].
5. In the Browse For Folder dialog, do one of the following:

• Select a folder. Select [OK].
• Select [Make New Folder]. Name the folder, and select 

[OK].
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6. In the Export Workflow dialog, select [OK]. A new Export 
Workflow dialog displays. The blue process bar cycles until the 
export process is complete.

7. Select a workflow and review the status of each workflow 
node.
• The Workflows Exported table lists the workflow(s) in the 

selected workflow file.  
• The Export Action Summary displays the required actions, 

if any, for nodes of the workflow selected in the upper 
table. See  Import and Export Status Descriptions for a 
description of status icons. 

8. Take the action required, if any, for each workflow node.
9. Select [Done].

NOTE: A .wfc folder displays in the export save location, along 
the .xml file. It contains configuration files, profiles and other 
workflow information to enable workflow restoration during 
import.
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Importing workflows 

The Process Manager export/import workflow function provides 
workflow portability and a method for backing up and restoring 
workflows.
To import a workflow, you must first generate an .xml workflow file 
by selecting a workflow and exporting it to the desired folder 
location. The .xml file can then be imported into Workflow Builder 
on the same Process Manager server or imported into Workflow 
Builder on a second Process Manager server. 
The workflow is fully restored, including any referenced 
directories, hot folders, and profiles that were deleted after the 
workflow was exported. At the conclusion of the import process, 
the status of workflow nodes is listed and the operator is notified if 
actions are required to fully enable the imported workflows.
The Import Workflow dialog displays after you select the file to 
import.
Status text: Status text displays above the upper and lower tables 
and changes to reflect the on-going or completed status of the 
import process.
The upper table shows the import status of each workflow. The 
lower table shows the status of nodes of the workflow selected in 
the upper table.

To import a workflow

NOTE 1: Only .xml files can be selected.
NOTE 2: If the .xml file is incorrectly formatted, an error message 
similar to this displays: “The file [complete path] does not contain 
readable workflow data.”
NOTE 3: If the .xml file contains workflows of the same names, the 
following message displays: “Cannot import the following 
workflows [workflow names]. Existing workflows of the same 
name already exist. Please rename or delete the existing 
workflows first.” Names are not case-sensitive: “Newsletter 
Workflow” is the same as “newsletter workflow.”
1. In Workflow Builder, select [File: Import].
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2. In the Open dialog, browse to the desired workflow file and 
select from the following:
• If the .xml file contains one workflow, in the Open dialog, 

select the workflow and select [Open].
• If the .xml file contains more than one workflow, it opens 

an initial Import Workflow dialog, which allows you to 
selectively import the workflows in the .xml file. Select from 
the following: 
– Select [Select all workflows] to import all the 

workflows in the .xml file.
– In the list box, select specific workflows to import.

NOTE: A .wfc folder displays in the export save location, along 
the .xml file. It contains configuration files, profiles and other 
workflow information to enable workflow restoration during 
import.

3. In the new Import Workflow dialog, review the status and/or 
action required for each workflow node, and take the 
necessary action.
• The Workflows Imported table lists the workflow(s) in the 

selected workflow file.  
• The Import Action Summary displays the nodes of the 

workflow selected in the upper table. 
•  A check mark in a node means the node imported 

successfully. A check mark in all the nodes results in a 
checkmark for the entire workflow in the upper table.

4. Take any necessary action(s).
5. Select [Done]. The imported workflows display in the 

Workflows list.
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Import and Export Status Descriptions

The following table describes the import and export status icons 
and provides a general descripion of actions required.

Ensuring imported workflow compatibility

Workflows can be successfully imported from one Process 
Manager server system to another Process Manager server if both 
servers have the same software version of Process Manager and 
if all the configurations on the second server are compatible. 
The following items should be checked for compatibility:
• PREPS jobs lists
• Fonts used in Bates Numbering, Page Numbering, 

Watermarks

Table 2-10. 

Icon Indicates Action Required 

Successful workflow or node import. A check 
mark in all nodes results in a checkmark for 
the entire workflow in the upper table.

None

Successful workflow or node import but 
attention is required.

Locate node(s) with this symbol; 
perform required action.

Failed workflow or node import or export. 

Overrides all other icons.

Locate node(s) with this symbol; 
note the provided information.
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Configuring process settings

Workflow process settings are configured after a step is inserted 
into a workflow. Changes to the settings apply only to that 
instance of the step.
All process settings, except the following, can be configured:
• Join
• Review
• Input

NOTE: In Workflow Job Manager only, you can open the Input 
dialog and view a list of submitted files.

To modify the process settings

Refer to a specific process for a detailed description of the 
settings. In general, do the following:
1. Select a workflow. The workflow displays in the workspace.
2. Double-click a process step in the workflow or right-click and 

select [Process Settings...] to open the settings dialog.
3. Change the process settings as desired.
4. Select [OK] to save the settings and close the dialog.
NOTE: For all process settings, the option “Always use these 
settings” has a default of “unchecked,” unless otherwise specified. 
If checked, settings in the dialog override any similar settings in an 
incoming JDF job ticket. The settings appear in the Workflow 
Submission Client controls, but are grayed out and unchangeable.
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About Input 

When you create and name a new workflow and select <Enter> 
an Input node automatically displays at the beginning of the 
workflow.
In Workflow Builder, the Input node does not have a settings 
dialog. In Workflow Job Manager, you can open the Input settings 
dialog and view a list of the original input files, the file path, file 
size and date modified. Input files can also be viewed via the tool 
tip. 
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Configuring Automatic Image Enhancement (AIE) settings

Automatic Image Enhancement allows the application of a range 
of image processing operations that optimize the sharpness, color 
balance, saturation, exposure, noise reduction and contrast of 
TIFF, JPEG, and BMP images, whether standalone, or embedded 
in a PDF. AIE also supports redeye removal for humans and 
shadow detail enhancement. The AIE feature works for only color 
and grayscale images.

To configure Image Enhance settings

1. To access the Automatic Image Enhancement Settings, 
double-click the AIE step in a workflow.

2. In the Enhance Files - [node name] dialog, select from the 
following options:
NOTE: You must select the Contrast option to enable Shadow 
Detail.

• [Contrast] to apply the selected contrast level 
enhancements to incoming jobs. Choose from:
– Off: To disable the option.
– Low: For an image with less contrast.
– Normal: Default; for an image with normal contrast.
– High: For an image with higher contrast.

• Saturation to apply the selected color saturation 
enhancements to incoming jobs. Choose from:
– Off: To disable the option.
– Low: For a less colorful image.
– Normal: Default; for an image with normal color 

saturation.
– High: For a more colorful image.

• Sharpness to apply the selected image sharpness 
enhancements to incoming jobs. Choose from:
– Off: To disable the option.
– Low: For a less sharp image.
– Normal: Default; for a normally sharp image.
– High: For a sharper image.



FreeFlow Process Manager Operator and Administrator Guide2-36

Workf low Bui lder

• Exposure to apply the selected exposure enhancements 
to incoming jobs. Choose from:
– Off: To disable the option.
– Darker: For a darker image
– Normal: Default; for a normally enhanced image.
– Lighter: For a light image.

• Color Balance to apply normal color balance 
enhancements to incoming jobs. Choose from:
– Off: To disable the option.
– On: Default; to enable the option.

• Noise Reduction to apply normal IE noise reduction 
enhancements to incoming jobs.
– Off: To disable the option. 
– Low: For less noise reduction.
– Normal: Default; for moderate noise reduction.
– High: For greater noise reduction.

• Red Eye Reduction to remove the red eye defect from 
incoming jobs. For human red eye only. Choose from:
– Off: Default; to disable the option.
– On: To enable the option.

• Shadow Detail to enhance dark areas of the image in 
incoming jobs. Choose from:

NOTE: You must select the Contrast option to enable Shadow 
Detail.

– Off: To disable the option.
– On: Default; to enable the option.

3. Select [Always use these settings] to prevent users from 
modifying the settings. The settings will appear in the 
Submission Client controls, but will be grayed out and 
unchangeable.
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AIE and DocuSP

If you include the AIE process in a FreeFlow Process Manager 
workflow and submit the job to a DocuSP 5.1 or a Xerox FreeFlow 
Print Server 6.0, ensure that you submit it to a queue for which 
AIE is not enabled.
If you have the option of performing the AIE processing in either 
FreeFlow Process Manager or in the current DocuSP 5.1 or Xerox 
FreeFlow Print Server 6.0, for reasons of flexibility and 
performance, it is recommended that you do so in FreeFlow 
Process Manager, rather than in DocuSP 5.1 or Xerox FreeFlow 
Print Server 6.0.

Limitations for AIE

• AIE can be applied only to raster image files such as TIFFs, 
JPEGs, and BMPs. It also supports those files if they are 
embedded in PDFs.

• The image quality improvement for BMPs may be minimal.
• AIE red eye reduction applies only to photographs of humans, 

and not to photographs of animals.
• The Exif data that is found in some JPEG files is not currently 

supported by AIE and will result in the loss of resolution 
information.
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Configuring Convert settings

General tab: Process Manager automates the processing of PDF 
documents. The Convert process step enables Microsoft Word 
Microsoft Excel, Microsoft PowerPoint, Microsoft Publisher, Adobe 
InDesign, Adobe Illustrator, Adobe Photoshop, JPG, JPEG, BMP, 
TIFF, TIFF-IT, TIF, PS, VPC, QXD, QXP, RDO, and EPS 
document types to be converted to a PDF document for 
submission to Process Manager workflows.
You can select from various job options to generate optimal PDFs 
for Microsoft Office (including Microsoft Office 2007) or PS files. 
The job options include the basic Adobe Acrobat Distiller set with 
the addition of various Xerox-specific job options, including 
DocuColor iGen3. You can also create custom job options in 
Adobe Acrobat Distiller for use in Process Manager. 
The default job option that displays in Process Manager is 
selected in Adobe Acrobat Distiller.
The [Flatten submitted PDF files for printing] option allows you 
to re-process PDF files with known printing problems. “Flattening” 
converts a PDF file to PostScript, and then converts it back to a 
PDF file. This feature may result in a loss of features and image 
degradation, including:
• Flattening of transparency.
• Loss of some interactive features such as thumbnails, 

bookmarks, article threads, logical structure and trapping 
information.

• Loss of functionality of other interactive features such as 
forms, hyperlinks, JavaScript.

• Loss of some annotations such as comments, embedded files, 
embedded media such as video/audio, and references to 
external files or media.

Limitations for Flatten This feature potentially requires a large 
amount of disk space for creating both the intermediate PostScript 
and the flattened PDF file.The conversion will fail if the disk space 
is insufficient.
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Manual Conversion tab: Adobe Creative Suite and QuarkXPress 
files must be manually converted to PDFs before they can be 
processed in a workflow. To do this: 
• Set up a working directory via the Convert Settings dialog. 

Files are held in the directory until they are manually 
converted. 

• Set up an email notification address via the Convert Settings 
dialog. This allows you to send an e-mail message to indicate 
that a Adobe Creative Suite or QuarkXPress document is 
waiting to be converted to PDF. A message will be sent for 
each document processed.

• Submit Adobe Creative Suite or QuarkXPress files via 
Workflow Submission Client to a workflow with a Convert 
node. Files are sent to the appropriate working directory; an 
email notification is sent.

• Manually convert the files to PDF via Adobe Creative Suite or 
QuarkXPress, when the workflow is stopped at the Convert 
step in Workflow Job Manager. Place the converted files in the 
appropriate working directory to continue workflow processing.

NOTE: You are solely responsible for obtaining all appropriate 
licenses from Adobe Creative Suite and QuarkXPress and their 
licensors and for maintaining full compliance with those licenses.

See also:
To configure Convert settings
To set up a working directory
Unlimited User Conversion option
Working with PDF Files
Converting Adobe Illustrator and Adobe InDesign documents to 
PDF
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To configure Convert settings

1. (Optional) To ensure that Process Manager displays the 
desired Adobe Acrobat Distiller default job option, select 
[Start: Programs: Acrobat Distiller] and choose a profile 
from the Default Settings drop box.

2. To access the Convert Settings dialog in Workflow Builder, 
double-click the Convert step in a workflow.

3. Select [Flatten submitted PDF files for printing] to re-
process PDF files with known printing problems. This option 
may result in a loss of features and image degradation.

4. In the “Select the job options that submitters can choose from” 
text box, select the desired job options. The job options will 
populate the “Select the default job option” drop box.

5. In the “Select the default job option” drop box, select a default 
job option.

6. Select [Always use these settings] to prevent users from 
modifying the settings. The settings will appear in the 
Submission Client controls, but will be grayed out and 
unchangeable. 

NOTE: When “Always use these settings” is selected, it locks in 
the default job option as the conversion type.

7. Select [OK] to accept changes and close the window.
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To set up a working directory

1. To access the Convert Settings dialog in Workflow Builder, 
double-click the Convert step in a workflow.

2. Select the Manual Conversion tab.
3. Select either [Enable manual QuarkXPress file (*.QXP, 

*.QXD) conversion.] or [Enable manual Adobe Creative 
Suite file (*.INDD, *.AI, *PSD) conversion.] to save files to 
the working directory for manual conversion to PDF. After 
conversion, files are saved to the working directory using the 
given file name.

4. To set up a Working Directory in which to save and convert the  
files to PDF, select [Browse]. Perform one of the following:
NOTE: You may be prompted for a login and password if you 
attempt to access a mapped location.

NOTE: If you are using hot folders to support other FreeFlow 
Process Manager features, such as job submission and third 
party external processes, refer to the topic Limitations when 
setting up directories as input/output hot folders for more than 
one feature.

• In the Browse For Folder dialog, navigate to the desired 
folder, and select [OK].

• Select Make New Folder, name the folder, and select [OK].
5. Enter an address in the Email Notification Address text box. 

The recipient will be automatically notified that a document is 
waiting to be manually converted to a PDF.

6. Select [Always use these settings] to prevent users from 
modifying the settings. The settings will appear in the 
Workflow Submission Client controls but will be grayed out 
and unchangeable.

7. Select [OK].
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Unlimited User Conversion option

An Unlimited User Conversion option is available for Process 
Manager. If you are upgrading from previous versions of Process 
Manager, you will remain as no “Unlimited User Conversion” 
installed unless you purchase this option. 
The Unlimited User Conversion option allows: 
• Unlimited high resolution generation and authoring.
• The conversion of all supported document types to PDF when 

a hot folder is shared or is on a mapped drive. 
The following conditions apply if the Unlimited User Conversion 
option is not installed:
• Reprint of a FreeFlow 5.0 saved and password encrypted 

job: If a reprint is requested of a saved job, the job is 
decrypted and processed for Print. The job is not re-encrypted 
during Save.

• 100 User Conversion This optional component allows a 
maximumm of one hundred users to submit applications for 
PDF conversion for all suppported document types.

See also:
Hot Folder submission with and without the Unlimited User 
Conversion License
Setting up a watermark in an email attachment
• PDF files created through the conversion process and 

saved by Save and JDF Export nodes: These files will be 
password- protected against “Open.” This applies to PDF files 
saved in both the Windows file system and the repository 
system.
– A password is assigned by Process Manager and known 

only by Process Manager.
– Acrobat and other FreeFlow applications will NOT be able 

to open or process those PDF files.
– If any of the PDF files protected by the Save/JDF Export 

node is selected for input to either Workflow Submission 
Client or a hot folder, Process Manager will apply the 
password and process the PDF files accordingly.
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– If the workflow used in this case contains Save or JDF 
Export nodes, the password protection will be reapplied to 
output PDF files.

– If the “Unlimited User Conversion” option is installed and 
those password protected PDF files were selected as 
input, password protection will be permanently removed 
from the PDF files. Review, Notification, Save, and JDF 
Export will all behave normally, as before.

Working with PDF Files

• Adobe does not support PDF files larger than 2.25 Gb on the 
Windows platform.

• PDF files containing more than 30,000 pages and are not 
supported.

• To process only a range of pages within a PDF file, manually 
edit the file in Adobe Acrobat in the Review step.

• If the input PDF file requires a password to open the PDF file, 
most operations will fail.

Converting Adobe Illustrator and Adobe InDesign documents 
to PDF

The third party software packages, Adobe Illustrator and Adobe 
InDesign, must be installed and registered for the PDF conversion 
capability to perform in a FreeFlow system. 
If you encounter problems converting Adobe Illustrator and Adobe 
InDesign documents to PDF, do the following: 
1. Close all instances of Adobe Illustrator or Adobe InDesign that 

are running in the Task Manager. 
2. Invoke Illustrator or InDesign from the Start menu. The “Would 

you like to register now?” dialog appears. 
3. Register, then close the application. Conversion should now 

work properly. 
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About Join

Join combines -- or concatenates -- multiple PDF files into a single 
PDF file. All the PDF files must exist before you attempt to use the 
Join process.
When submitting multiple files to a workflow:
• To create a single joined job, Join must be in the workflow. 
• To create multiple separate jobs that are processed 

individually, Join should not be in the workflow.
Join does not have a settings dialog.

See also:
Limitations for Join
Fault handling for Join

Limitations for Join

Bookmarks, logical structure, internal hyperlinks, and article 
threads within PDF files might not be preserved by the PDF Join 
component. 

Fault handling for Join

Errors are logged in the Windows Event log and displayed in the 
Job Manager status display area. The following errors cause the 
Join operation to fail:
• If the input PDF file is missing.
• If the input PDF file is invalid.
• If the output PDF file is locked and cannot be overwritten, or if 

the user lacks sufficient security privileges to access the 
destination directory.

• If the input PDF file requires a password to open the PDF or 
does not permit any of the following: content copying and 
extraction, document assembly, or content accessibility.
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Configuring Optimize settings

The Optimize process allows you to modify a PDF file to be PDF/X 
compliant, specify how fonts should be embedded, define PDF 
Box settings, configure spot color settings, manage color profiles, 
and configure image quality settings for hairline correction and the 
removal of color trapping layers. 
You can have multiple instances of the Optimize node in a 
workflow. However, there is no conflict checking for multiple 
instances. 
When working with non-PDF documents, the Convert node must 
precede the Optimize node.
The Optimize Options dialog includes five tabs: General, PDF 
Boxes, Color, Spot Colors, and Image Quality. The availability of 
dialog options varies, depending on whether the [Create a 
document that complies with PDF/X standards] option is 
selected, for example:
• When compliance is selected, font embedding is automatically 

set to ON, and output compliance error handling is available.
• When compliance is not selected, font embedding is 

automatically set to OFF; Color Management is enabled, and  
independent use of the PDF Box is enabled.

See also:
To configure the General Optimize settings
To configure the PDF Boxes settings
To configure the Color settings
To configure the Spot Colors settings
To configure Image Quality settings
Description of PDF/X-1a Standards
About PDF Boxes
Managing Color profiles
Ensuring Color Manage workflow consistency between the server 
and a remote client
Importing a FreeFlow 5.0 workflow with a Color Manage node
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To configure the General Optimize settings

The General tab allows you to select a Settings File, define 
compliance criteria, designate font embedding options, and 
optimize for fast web viewing.
1. Double-click the Optimize step in a workflow.
2. In the “Settings File” area, select from the following to load a 

settings file:
• pdfx-1a2001.xml (pre-installed settings file)
• pdfx-1a2003.xml (pre-installed settings file)
NOTE: If created, other user-defined settings files are also 
displayed.

3. To save the options you have selected in the Optimize node 
as a custom settings file, and to display the file as an option in 
the Settings File drop box, select [Save As...] to open the 
Save Settings File dialog. For more information, see To save 
the Settings File as

4. To remove a settings file from the list, select the file in the drop 
box, and then select [Delete].

5. In the “Compliance” area, mark the check box for [Create a 
document that complies with PDF/X standards] and select 
from the following options:
• PDFX-1a 2001 
• PDFX-1a 2003
For more information, see Description of PDF/X-1a Standards.

6. In the “When a PDF/X compliant document cannot be created” 
area, select from the following options:
• [Ignore] to disregard errors and move the job to the next 

workflow process.
• [Warn and continue] to note errors in the error log for the 

current job and move the file to the next workflow node.
• [Cancel job] to note errors in the error log for the current 

job and to halt the job. A fail message displays for the 
Optimize PDF node in Workflow Job Manager. 
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7. In the “Fonts” area, select from the following:
• [Embed Fonts] Selected by default and grayed out when 

compliance is selected.
• [Embed as subset] to minimize the document file size. 
• Select [Embed all fonts] to enable future text editing. If a 

font has been previously subset embedded, it will be fully 
embeddded. This option increases the file size.

NOTE: The font family must be loaded on the PC. Only fonts 
with the appropriate permission bits will be embedded.

8. In the “When an error occurs embedding the fonts” area, 
select from the following: 

– [Ignore] to disregard errors and move the job to the 
next workflow process.

– [Warn and continue] to note errors in the error log for 
the current job and move the file to the next workflow 
node.

– [Cancel job] to note errors in the error log for the 
current job and to halt the job. A fail message displays 
for the Optimize PDF node in Workflow Job Manager. 

9. In the Fast Web Viewing area, mark the check box for 
[Optimize the document for fast web view] to enable fast 
page-at-a-time downloading from web servers.

10. Select [Show job submitter the settings file name only. 
Settings details will be hidden]  to display only the Settiings 
File drop box to job submitters. All other dialog features are 
hidden.

11. Select [Always use these settings] to prevent users from 
modifying the settings. The settings will appear in the 
Workflow Submission Client controls but will be grayed out 
and unchangeable.

12. Select [OK] to accept the changes or select another tab and 
continue configuring.

To save the Settings File as

The Save Settings File dialog allows you to save the current 
settings of the Optimize node. For more infomation about the 
available options, see To configure the General Optimize settings
1. In the Optimize Options dialog General Tab, select  [Save 

As...]. 
2. In the File Name text box, enter a new file name. 
3. Select [Save].
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To configure the PDF Boxes settings

The PDF Boxes tab allows you to define PDF Box settings. For a 
description of the PDF boxes, see PDF Box Descriptions.
The availability of dialog options varies, depending on whether the 
[Create a document that complies with PDF/X standards] 
option is selected in the General tab.
1. Double-click the Optimize step in a workflow and select the 

PDF Boxes tab.
2. Mark the check box for [Set crop box to media box]. 

• If a PDF document has a crop box, it is replaced with one 
the size of the media box. 

• If the PDF document does not have a crop box, one is 
generated and set to the size of the media box.

3. In the “When both trim box and art box are missing” drop box, 
select from the following:
• [Set trim box to media box and offset inwards by:]

– Select or type a value for each option: [Left], [Right], 
[Top], and [Bottom]. 

• [Report an error] to register an error in the error log. 
NOTE: Depending on the error handling specified in the 
General tab in the Compliance area, the job may or may not 
fail.

• [Ignore] to disregard errors and move the job to the next 
workflow process. 

4. In the “When bleed box is missing” drop box, select from the 
following:
• [Set bleed box to media box].
• [Set bleed box to trim box and enlarge by:]

– Select or type a value for each option: [Left], [Right], 
[Top], and [Bottom]. 

• [Ignore] to disregard errors and move the job to the next 
workflow process.
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5. Select [Show job submitter the settings file name only. 
Settings details will be hidden]  to display only the Settiings 
File drop box to job submitters. All other dialog features are 
hidden.

6. Select [Always use these settings] to prevent users from 
modifying the settings. The settings will appear in the 
Workflow Submission Client controls but will be grayed out 
and unchangeable.

7. Select [OK] to accept the changes or select another tab and 
continue configuring.

To configure the Color settings

The Color tab allows you to select the output color space, source 
color space, define the appropriate action when an error occurs, 
and select the desired transparency. 
The availability of options varies, depending on whether the 
[Create a document that complies with PDF/X standards] 
option is selected in the General tab.

See also:
Importing a FreeFlow 5.0 workflow with a Color Manage node
1. Double-click the Optimize step in a workflow and select the 

Color tab.
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2. In the Output Color Space area, define the desired output 
color space by selecting from the following options:
• In the [Change all colors in document] drop box, select 

from the following:
– Convert colors to gray (alway available)
– Convert colors to CMYK (alway available)
The following options are available only if [Create a 
document that complies with PDF/X standards] is not 
selected on the General tab:
– Don’t change colors -- to gray out the Source Color 

Space options; prevent color changes in the document
– Manage Color profiles -- to enable color 

management. This enables the “Don’t change ICC 
profiles for [xx]” option in the CMYK, RGB and Gray 
drop boxes in the Profiles to use section. Enables 
“Treat managed [xx] as.”

– Convert colors to RGB
NOTE: The Color Manage node from earlier versions of 
FreeFlow Process Manager is replaced by the Manage Colors 
profiles option. For more information about managing color 
profiles, see Managing Color profiles.

• In the [ICC profile] drop box, select the desired  profile. If 
you must import a profile to your PC, see To import an ICC 
profile.

NOTE: You must own the rights to use the ICC profiles 
accessed by FreeFlow Process Manager.

3.  If required, mark the check box for [Use Output Intent, if 
present, for Source Color Space]. Select this option to allow 
the document’s output intent to override the designated source 
color space profile.
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4. In the Source Color Space area, the following information 
applies to the CMYK, RGB, and Gray drop box options:
• Treat untagged [CMYK, RGB, or Gray] as: Assigns the 

selected ICC profile to all non-profiled [CMYK, RGB, or 
Gray] objects.

• Treat managed [CMYK, RGB, or Gray] as: Available 
when “Manage Color Profiles” is selected in the “Change 
all colors in document” area. Assigns the selected ICC 
profile to all profiled [CMYK, RGB, or Gray] objects.

• Treat all [CMYK, RGB, or Gray] as: Assigns the selected 
ICC profile to both non-profiled and profiled [CMYK, RGB, 
or Gray] objects.

• Don’t change ICC profiles for [CMYK, RGB, or Gray]: 
Available with “Manage Color Profiles” selection. Grays out 
the [CMYK, RGB, or Gray] profile. Preserves the original 
profile of [CMYK, RGB, or Gray] objects within the 
document.

Select the desired option from the following Source Color 
Space area drop boxes:
• [CMYK]
• [CMYK ICC Profile] 
• [RGB]
• [RGB ICC Profile]
• [Gray]
• [Gray ICC Profile]

5. In the When a color space error occurs area, select from the 
following options:

– [Ignore] to disregard errors and move the job to the 
next workflow process.

– [Warn and continue] to note errors in the error log for 
the current job and move the file to the next workflow 
node. 

– [Cancel job] to note errors in the error log for the 
current job and to halt the job. A fail message displays 
for the Optimize PDF node in Workflow Job Manager.  
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6. In the Transparency/Overprint area, select [Rasterize 
transparent/overprint objects] to enable the feature.

7. Specify the desired Resolution at which to rasterize the 
objects: [150], [300],or [600] dpi.

8. In the When a transparency error occurs area, select from the 
following options:

– [Ignore] to disregard errors and move the job to the 
next workflow process.

– [Warn and continue]  to note errors in the error log for 
the current job and move the file to the next workflow 
node.

– [Cancel job] to note errors in the error log for the 
current job and to halt the job. A fail message displays 
for the Optimize PDF node in Workflow Job Manager.

9. Select [Show job submitter the settings file name only. 
Settings details will be hidden] to display only the Settiings 
File drop box. All other dialog features are hidden.

10. Select [Always use these settings] to prevent users from 
modifying the settings. The settings will appear in the 
Workflow Submission Client controls but will be grayed out 
and unchangeable.

11. Select [OK] to accept the changes or select another tab and 
continue configuring.

Importing a FreeFlow 5.0 workflow with a Color Manage node

If you import a 5.0 workflow with a Color Manage node into 
FreeFlow Process Manager 6.0, the 5.0 Color Manage icon is 
converted to an Optimize icon and the settings transfer 
automatically to the Optimize settings Color tab.
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To configure the Spot Colors settings 

Spot colors usually designate a fifth housing color, an offset 
printing device that contains a special ink. The Spot Color tab 
allows you to keep spot colors, convert to common CMYK 
standard colors, or to convert to an alternative color space. It 
provides a normalization process with the ability to allow you to 
specify how to treat PANTONE® Color values with C, CV, U, CVC, 
and CVU suffixes.
1. Double-click the Optimize step in a workflow and select the 

Spot Colors tab.
2. Mark the check box for [Convert spot colors to process 

colors] to convert Spot Colors to the Output Color Space.  
If no spot colors are defined in the exclusion list, then all spot 
colors in the document will be converted. Objects that contain 
multiple spot colors must have all of their spot colors defined in 
the exclusion list or the objects will be converted to the Output 
Color Space. The exclusion list appears below the text box. 

3. To add a spot color to the exclusion list:
a. In the “Spot colors not to convert” text box, enter the spot 

color name. Names are case and space insensitive.
b. Select [Add].

When an item is selected in the exclusion list, you can change or 
delete the item:
4. To change the name of a spot color:

a. Enter a new name in the “Spot colors not to convert” text 
box. 

b. In the exclusion list, select the spot color you wish to 
change. 

c. Select [Change].
5. To delete a spot color:

a. In the exclusion list, select a spot color.
b. Select [Delete].

6. Mark the radio button for [Set spot color suffix to match 
media type] to convert all suffixes to one of the following 
suffixes:
– [Coated paper] to support PANTONE® coated spot color. 
– [Uncoated paper] to support PANTONE® uncoated spot 

color. 
– [Matte paper] to support PANTONE® matte spot color.  
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7. Select [Show job submitter the settings file name only. 
Settings details will be hidden]  to display only the Settiings 
File drop box to job submitters. All other dialog features are 
hidden.

8. Select [Always use these settings] to prevent users from 
modifying the settings. The settings appear in the Workflow 
Submission Client controls but are grayed out and 
unchangeable.

9. Select [OK] to accept the changes or select another tab and 
continue configuring.
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To configure Image Quality settings

The Hairline Correction feature thickens stroke lines within a 
document that may be too thin for printing purposes. 
The Remove color trapping layers option allows you to eliminate 
color trap layers from the PDF. Color trap layers are originally 
intended to provide fill between two objects that abut in a 
document but end up printing with white space along the abutting 
borders. Color trap layers solve the issue by printing an 
overlapping border between the abutting objects.  
1. Double-click the Optimize step in a workflow and select the 

Image Quality tab.
2. Mark the checkbox for [Replace all hairlines narrower than] 

to enable the feature, and select or enter a threshold value.

• Inches: Default is 0. Maximum value is .0625 (1/16th inch). 

• Pixels: Default is 0. Maximum value is 75 (1/16th inch on a 
1200 dpi. printer).

• mm: Default is 0.0. Maximum value is 1.5875.
• Points: Default is 0. Maximum value is 4.5.

3. Select or enter a value to replace anything lower than 
threshold value.
• Inches: Default is 0.01389. Maximum value is .0625 (1/

16th of an inch).

• Pixels: Default is 16.67. Maximum value is 75 (1/16th of an 
inch on a 1200 dpi. printer) .

• mm: Default is 0.3528. Maximum value is 1.5875.
• Points: Default is 1. Maximum value is 4.5.

4. Select the desired unit for the hairline correction: [inches], 
[pixels], [mm] or [points].

5. In the “Color Trapping” area, mark the check box for [Remove 
color trapping layers] to eliminate trap layers from the PDF.

NOTE: Removal of trap layers is supported for traps created by 
Prinergy, Prinect and Esko Graphics.

6. Select [Show job submitter the settings file name only. 
Settings details will be hidden]   to display only the Settiings 
File drop box to job submitters. All other dialog features are 
hidden.

7. Select [Always use these settings] to prevent users from 
modifying the settings. The settings will appear in the 
Workflow Submission Client controls but will be grayed out 
and unchangeable.
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Description of PDF/X-1a Standards

About PDF Boxes

The following table describes the PDF media box, bleed box, trim 
box and art box. 

Table 2-11. Description of PDF/X-1a Standards

File Type Description

PDF/X-1a 2003 ISO standard for graphic content exchange. Files can be opened in 
Acrobat 5.0 and Acrobat Reader 5.0 and later. The standard requires 
that:

• All fonts are embedded.
• The appropriate bounding boxes are specified: Media Box, 

Trim Box, or Art Box.
• Color appears as CMYK, spot colors, or both (RGB and LAB 

spaces are not allowed). 
• Compliant files must contain describe the output printing 

condition (e.g. SWOP) for which they are prepared.
• The Trap Key is set.  

PDF/X-1a 2001 Same as above, except files can be opened in Acrobat 4.0 and Acrobat 
Reader 4.0 and later.

Table 2-12. PDF Box Descriptions

PDF Box Description

Media box Page size; contains all the objects of a page, including text and images 
that appear on the page or that bleed or extend off the edge of the 
finished document.

Media box dimensions are always greater than or equal to the trim box 
dimensions.

Media box dimensions are always greater than or equal to the bleed 
box dimensions.

Crop Box The crop box represents the region in which the page contents are 
trimmed when displayed or printed. It defines how the page contents 
are placed on the output medium.

The crop box dimensions are always greater than or equal to the trim, 
art, and bleed box. 

The crop box dimensions are always smaller than or equal to the media 
box. 
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Bleed box Represents an extended area around the trim box at which contains 
content that will be trimmed during finishing. 

A document that requires a bleed also requires a bleed box. 

The bleed box must be smaller than the media box, and can be the 
same or larger than the trim box.

Trim box Represents the final finished size of the document after printing and 
finishing. A document intended for commercial printing requires a trim 
box. 

The trim box must be smaller than the media box, and can be the same 
as the bleed box. 

Trim marks are nominally placed around the trim box.

Art box Represents an area of the page (for example, a piece of clip art) to be 
positioned when the PDF content is placed in an application, such as a 
page layout program. 

The art box must be smaller than the bleed box. 

Trim and art boxes may have the same dimensions.

Table 2-12. PDF Box Descriptions

PDF Box Description
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Managing Color profiles

Color Manage allows you to: 
• Add CMYK profiles to untagged CMYK content.
• Replace CMYK profiles for tagged content. 
• Add RGB profiles to untagged RGB content.
• Replace RGB profiles for tagged RGB content.
• Add gray profiles to untagged gray content.
• Replace gray profiles for tagged gray content.
• Allows you to not change a profile for a specific color space.
A CMYK, RGB or gray profile is added to untagged content when 
colors need to be transformed or accurately displayed or printed. 
Untagged color spaces (also known as “device” spaces) have an 
ambiguous interpretation; adding a profile resolves the ambiguity 
by providing a specific interpretation of the data.
CMYK, RGB or gray profiles are replaced for tagged content when 
the original profile—the original specification of how the color 
values should be interpreted—is wrong or has changed. This can 
occur when:
• The original profile is known to be incorrect—for example, 

because of a known error in prior processing.
• The color is being edited, and the output is desired in a 

different color space.
Only profiles installed on the Windows Operating System are 
visible. 

To import an ICC profile

1. Navigate to the .icc profile you wish to import. 
2. Right-click profile and select [Install Profile].
3. The profile is installed in the color directory of your Windows 

system folder. The location of the directory depends on your 
operating system. For example, in Windows 2000, it is often 
found in C:\WinNT\system32\spool\drivers\color.
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Ensuring Color Manage workflow consistency between the 
server and a remote client

Workflows with color management enabled in the Optimize node 
can become inconsistent between a Process Manager server and 
remote client when profiles are uninstalled on the server. Use the 
following procedure to ensure workflow consistency.

To ensure Color Manage workflow consistency

1. Disable the Workflow. 
2. Open the Optimize node.
3. Enable the workflow to reset the profile database. 
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Configuring Preflight settings

At minimum, preflight can validate the file and check formatting, 
verify the image format (resolution, color space, and color profile), 
fonts, and verify references to OPI image server images. The 
preflight validation depends on the profile you select. The 
administrator defines preflight profiles using Adobe Acrobat 
Professional’s profile repository and Xerox custom profiles. The 
operator can select a profile to use as the default profile for a 
specific workflow.
The Xerox FreeFlow Recommended Preflight profile, provided 
with the FreeFlow Process Manager product, includes the 
following checks:
• Font is not embedded
• Image resolution is less than 250 ppi
• Bitmap (1bit monochrome) image resolution is less than 600 

ppi
• Document is damaged and needs repairs
• PDF contains errors or is damaged
Preflight can also be used to automatically filter and route 
incoming PDF files. This is done by setting up multiple preflight 
nodes as filters at key points in a workflow to check for specific 
conditions. Based on the results, the file is directed to the 
appropriate process or workflow branch.

See also: 
To generate the preflight profile repository on a clean install
To configure Preflight settings
Using preflight as a filter
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To generate the preflight profile repository on a clean install

Preflight profiles do not exist on a clean install. After a clean 
install, do the following to generate the profile repository:
1. Select [Start: Programs: Adobe Acrobat Professional].
2. In the Advanced menu, select [Preflight Setup]. This 

generates the profile repository from which you can select 
profiles in the Preflight Settings dialog.

3. Close Adobe Acrobat Professional.

To configure Preflight settings

1. To access the Preflight Settings dialog, double-click the 
Preflight step in a workflow.

2. In the “Select Preflight profiles that submitters can choose 
from” text box, select the desired profiles. The profiles will 
populate the “Select the default profile” drop box.

3. In the “Select the default Preflight profile” drop box, select a 
default profile.

4. Select [Always use these settings] to prevent users from 
modifying the settings. The settings will appear in the 
Submission Client controls, but will be grayed out and 
unchangeable. 

5. Select [OK] to accept changes and close the window.
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 Using preflight as a filter

To help alleviate prepress bottlenecks, you can set up preflight 
nodes at various points in a workflow to automatically check for 
specific conditions, for example:
• Color or black and white 
• Specific page size 
• Portrait or landscape orientation
Depending on whether the files pass or fail the check, they are 
automatically directed to the appropriate workflow node or branch. 

Tips for using Preflight as a filter 

• Begin the workflow with a general preflight profile that checks 
for legitimate fonts and/or other basic requirements.

• Continue filtering with one-rule profiles that check for specific 
conditions.

• Use as many one-rule preflight profiles as necessary to filter 
and direct the jobs to the appropriate node or workflow branch.

Table 2-13. Examples: Using preflight as a filter

To check for... Pass/Fail results

Embedded fonts, legitimate fonts, 
and other basic preflight 
requirements. 

Purpose: To perform initial 
sorting of submitted customer 
files.

If passes, then go to next node. 

If fails, then check the preflight 
report, fix, and resubmit.

Pages 12 x 18 or larger

Purpose: To sort files with large 
page dimensions from those with 
small dimensions.

If passes, then send to printer A, 
which handles large format jobs.

If fails, then send to the fail 
branch for printer B, which 
handles small format jobs.

Color or black and white files

Purpose: To sort files into black 
and white and color.

If color, the file passes; send it to 
Color Manage, and then to the 
color printer A.

If b&w, the file fails; send it to the 
fail branch for b&w printer B.
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Upgrading legacy workflows that contain Job Level Edit nodes

In previous versions of FreeFlow Process Manager (2.0 through 
4.0), all job level edit functions (for example, watermarks, page 
numbering, page rotation) were available via a single Job Level 
Edit dialog. In version 6.0, you must add an individual process 
step to the workflow for each function. Legacy workflows that 
contain Job Level Edit processes will perform as they did in earlier 
versions, but you will not be able to edit them. To use the version 
6.0 job level edit functions, save the existing Job Level Edit 
workflow, and it will be converted into a series of individual, 
Watermark, Bates Numbering, Page Numbering, Rotate and Flip 
nodes, as appropriate.

Limitations for job level edits

The font specified for Bates numbering, page numbering and/or 
textual watermarks must be loaded on the system running the 
automated PDF editing module.

Fault handling for job level edits

Errors are logged in the Windows Event log and display in the Job 
Manager status display area. The following errors cause the Job 
Level Edit operation to fail:
• If the input PDF file is missing.
• If the input PDF file is invalid.
• If the output PDF file is locked and cannot be overwritten, or if 

the user lacks sufficient security privileges to access the 
destination directory.

• If the input PDF file requires a password to open the PDF or 
does not permit any of the following: content copying and 
extraction, document assembly, or content accessibility.
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Adding watermarks

Up to 1000 user-configured text and image watermarks can be set 
up and applied to each page of an input PDF file. The List box 
shows watermarks that have been configured. The attributes for a 
selected watermark are displayed in the Description area. Image 
and text icons to the left of each watermark indicate the watermark 
type.
Dialog options include:
New: Opens the New Text Watermark dialog or New Image 
Watermark dialog, in which you can create a new watermark. 
Modify: Opens the Modify Text Watermark or Modify Image 
Watermark dialog for the selected watermark.
Duplicate: Copies the selected watermark.
Delete: Deletes the selected watermark.
NOTE: All watermarks in the Watermarks list are applied to the 
job and are applied in the order in which they are listed. 

See also:
Setting up or modifying a text watermark
Setting up or modifying an image watermark
Duplicating or deleting a watermark
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Setting up or modifying a text watermark

Text watermarks can consist of multiple lines with hard line 
breaks. They can be created in a variety of font types, sizes and 
colors; can be transparent or opaque, rotated, or variably 
positioned from the document edge; and can appear either 
underneath or on top of the page content.

To set up or modify a text watermark

1. Double-click the Watermarks step in a workflow.
2. Select one of the following:

• Select [New], and then select [Text Watermark] to set up 
a new text watermark.

• Select a watermark from the list, and then select [Modify] 
to change an existing text watermark.

3. To change the font typeface, select a font from the Font name 
drop box.

4. To change the font style, select a style from the Font style drop 
box.

5. To change the font size, select a point size from the Size drop 
box.

6. Select a color for the watermark from the Color drop box. 
a. To select a color that is not available in the drop box, 

select [Customize...]. 
b. Select the desired Hue, Saturation, and Value. 

7. In the text box, enter the desired text. Line breaks are 
accepted. 
NOTE: The text box supports variable data syntax when the 
workflow is submitted from FreeFlow Process Manager MAX, 
Manifest Automation from Xerox. The content of the text 
should be specified as follows: (e.g.”Order Number: $CSV1$ - 
Job ID: $CSV2$”). Variable text is specified by the Order 
Jacket file column number (e.g. $CSV1$). All non-variable 
text, including spaces, will be treated as static text. If the 
workflow is submitted in ways other than via Process Manager 
MAX, variable data text will be ignored.
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8. Select or type the horizontal position from the PDF document 
box: From left, Center, or From right.

9. Select or type the vertical position from the PDF document 
box: From top, Center, or From bottom.

10. Select the position relative to Crop Box, Media Box, Bleed 
Box, Trim Box or Art Box.

11. Select the desired degree of rotation, from 0-359 degrees. The 
icon changes to reflect the selected rotation.

12. Select a transparency from 0-100. The greater the 
transparency level, the less opaque the watermark.

13. In the “Apply to pages” area, specify the pages upon which the 
watermark will appear.
• If Page range is selected, enter a text string using 

commas and hyphens. For example, select  “1-3, 7, 12-14, 
17” to print bar codes on pages 1 through 3, on page 7, on 
pages 12 through 14, and on page 17.

NOTE: Various order jacket file variables are supported by 
FreeFlow Process Manager MAX, Manifest Automation from 
Xerox.. You can enter variable data syntax in the page range 
text box. For example, given an Order jacket file (OJF) with 
columns 1, 2, 3, 4 containing page range data “1-3”, “7”, “12-
14”, “17” respectively, you can enter text “$CSV1$, $CSV2$, 
$CSV3$, $CSV4$” into the page range text box. If OJF column 
contains an invalid page range, the workflow will fail with an 
invalid page range error in Workflow Job Manager. Process 
Manager supports multiple text watermarks, each potentially 
utilizing different Order Jacket variables.

14. Select [OK].
15. To preview the watermark placement in the document, select 

[Preview>>]. For more information about the Preview option, 
see Previewing job level edits.

16. Select [OK] to accept the changes and close the window. 
The watermark displays in the Watermarks list. Select a 
watermark to display its description to the right.
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17. If desired, select [Move Up] or [Move Down] to move the 
selected watermark up or down in the list, and to define the 
order in which each watermark is layered on the page.

18. Select from the following:
• [Place all watermarks behind page content] to place the 

watermark underneath the page contents.
• [Place all watermarks in front of page content] to place 

the watermark on top of the page contents.
NOTE: The setting applies to all image and text watermarks. 

See also:
Adding watermarks
Setting up or modifying an image watermark
Duplicating or deleting a watermark
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Setting up or modifying an image watermark

Image watermarks can be transparent or opaque, scaled, rotated, 
variably positioned from the document edge and can appear either 
underneath or on top of the page content. Colorization is not 
supported.

To set up or modify an image watermark

1. Double-click the Watermarks step in a workflow.
2. Select one of the following:

• Select [New], and then select [Image Watermark] to set 
up a new image watermark.

• Select a watermark from the list, and then select [Modify] 
to change an existing image watermark.

3. Enter a file path or select [Browse] to locate a TIFF, JPEG, 
BMP, or PDF image file.

NOTE 1: The selected image must reside on a local drive.
NOTE 2: Only page 1 of the PDF is selected.

a. In the Browse for watermark image file dialog, select a file. 
b. Select [Open]. The dialog closes and the path and file 

name display in the Watermark filename text box.
4. Select a percentage from 1 to 200 to scale the image.
5. Select or type the horizontal position from the PDF document 

box: From left, Center, or From right.
6. Select or type the vertical position from the PDF document 

box: From top, Center, or From bottom
7. Select the position relative to Crop Box, Media Box, Bleed 

Box, Trim Box or Art Box.
8. Select the desired degree of rotation, from 0-359 degrees. The 

icon changes to reflect the selected rotation.
9. Select a transparency from 0-100. The greater the 

transparency level, the less opaque the watermark. 
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10. In the “Apply to pages” area, specify the pages upon which the 
watermark will appear. 
• If Page range is selected, enter a text string using 

commas and hyphens. For example, select  “1-3, 7, 12-14, 
17” to print bar codes on pages 1 through 3, on page 7, on 
pages 12 through 14, and on page 17.

NOTE: Various order jacket file variables are supported by 
FreeFlow Process Manager MAX, Manifest Automation from 
Xerox. You can enter variable data syntax in the page range 
text box. For example, given an Order jacket file (OJF) with 
columns 1, 2, 3, 4 containing page range data “1-3”, “7”, “12-
14”, “17” respectively, you can enter text “$CSV1$, $CSV2$, 
$CSV3$, $CSV4$” into the page range text box. If OJF column 
contains an invalid page range, the workflow will fail with an 
invalid page range error in Workflow Job Manager.

11. To preview the watermark placement in the document, select 
[Preview>>]. For more information about the Preview option, 
see Previewing job level edits.

12. Select [OK] to accept the changes and close the window.
The watermark displays in the Watermarks list. Select a 
watermark to display its description to the right.

13. If desired, select [Move Up] or [Move Down] to move the 
selected watermark up or down in the list, and to define the 
order in which each watermark is layered on the page.

14. Select from the following:
• [Place all watermarks behind page content] to place the 

watermark underneath the page contents.
• [Place all watermarks in front of page content] to place 

the watermark on top of the page contents.
NOTE: The setting applies to all image and text watermarks. 

See also:
Adding watermarks
Setting up or modifying a text watermark
Duplicating or deleting a watermark
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Duplicating or deleting a watermark

You can duplicate or remove a selected watermark. 

To duplicate or delete a watermark

1. Double-click the Watermarks step in a workflow.
2. To duplicate a watertmark:

• Select a watermark from the list.
• Select [New].
• Select [Duplicate] from the drop box.

3. To delete a watermark:
• Select a watermark from the list.
• Select [Delete] to remove the watermark.

4. Select [OK] to accept the changes and close the window.

See also:
Adding watermarks
Setting up or modifying a text watermark
Setting up or modifying an image watermark
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Adding Bates numbers

Bates numbering can be added to each page of an input PDF file. 
Bates numbering consists of a page number with optional leading 
zeros and an optional fixed text prefix. An optional line of fixed text 
can appear either above or below the bates number.

To add Bates numbers

1. Double-click the [Bates Numbering] step in a workflow.
2. In the Start with area, enter the starting number for the bates 

numbers. 
3. Select whether to enable leading zeros and setting the total 

number of digits.
4. Select the total number of digits, including leading zeros, from 

1-60. 
5. If you wish to have text appear before the bates numbers, 

select [Include Prefix] and enter the desired text in the text 
box.

6. If desired, select [Include second line of text] and enter the 
desired text in the associated text box.

7. Choose whether to position the text above or below the bates 
number. 

8. To change the font typeface, select a typeface from the Font 
drop box.

9. To change the font style, select a style from the Font style drop 
box.

10. To change the font size, select a point size from the Size drop 
box.

11. From the Color drop box, select a color for the prefix and the 
second line of text. 
a. To select a color that is not available in the drop box, 

select [Customize...]. 
b.  Select the desired Hue, Saturation, and Value. 

12. Select or type the horizontal position from the PDF document 
box: [From left], [Center], or [From right].

13. Select or type the vertical position from the PDF document 
box: [From top], [Center], or [From bottom].

14. Select the position relative to [Crop Box], [Media Box], 
[Bleed Box], [Trim Box] or [Art Box].

15. To preview the Bates number placement in the document, 
select [Preview>>]. For more information about the Preview 
option, see Previewing job level edits.

16. Select [Always use these settings] to prevent users from 
modifying the settings. The settings will appear in the 
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Submission Client controls, but will be grayed out and 
unchangeable.

17. Select [OK] to accept the changes and close the window.

Adding page numbers

Page numbers can be added to each page of a PDF file. Page 
numbers are available in a selection of styles, including 1, 2, 3; I, 
II, III; or i, ii, iii. Options include adding a prefix and/or suffix, and 
selecting font, color, and position. 

To add page numbers

1. Double-click the [Page Numbering] step in a workflow.
2. In the Start with area, enter the starting number for the page 

numbers. 
3. Select the desired numbering style from the drop box.
4. If you want text to appear before the page numbers, select 

[Include prefix], and enter the text in the associated text box.
5. If you want text to appear after the page numbers, select   

[Include suffix], and enter the text in the associated text box.
6. To change the font typeface, select a typeface from the Font 

name drop box.
7. To change the font style, select a style from the Font style drop 

box.
8. To change the font size, select a point size from the Size drop 

box.
9. Select a color for the prefix and the suffix from the Color drop 

box. 
a. To select a color that is not available in the drop box, 

select [Customize...]. 
b. Select the desired Hue, Saturation, and Value. 

10. Select or type the horizontal position from the PDF document 
box: [From left], [Center], or [From right].

11. Select or type the vertical position from the PDF document 
box: [From top], [Center], or [From bottom].
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12. Select the position relative to [Crop Box], [Media Box], 
[Bleed Box], [Trim Box] or [Art Box].

13. To preview the page number placement in the document, 
select [Preview>>]. For more information about the Preview 
option, see Previewing job level edits.

14. Select [Always use these settings] to prevent users from 
modifying the settings. The settings will appear in the 
Submission Client controls, but will be grayed out and 
unchangeable.

15. Select [OK] to accept the changes and close the window.
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Adding a Barcode

The Barcode node allows you to add a variety of barcodes to your 
workflows. You can specify the barcode type, font, placement, 
alignment, rotation, frequency, and size.
You can specify additional features for some bar code types. For 
example: 
• Two-digit or 5-digit supplements.The supplement is a second 

barcode, separate from the primary barcode and positioned to 
its right.

• A checksum, for barcode verification, which may be either 
optional or mandatory. 

• Start and stop characters that bracket the bar code content.
• A fixed first digit, which you can specify it from a range.

See also:
To configure Barcode settings
To configure the barcode readable text
To configure barcode data
To add or modify text or a data field
To manage barcode data

To configure Barcode settings

NOTE: View the dynamic effect of your selections in the Preview 
window at the bottom of this dialog, or click the [Preview >>] 
button to preview the barcode placement in the document. For 
more information about the Preview option, see Previewing job 
level edits.

1. To open the Add Barcode dialog, double-click the [Barcode] 
process in a workflow. 

2. In the Barcode tab, specify the barcode symbology from the 
drop box.

3. In the Options area, select from the following:
NOTE: Options vary depending on the selected symbology.

• [Include check digits] to enable barcode verification.
• [Include start character] to include a start character in the 

barcode.
• [Include stop character] to include a stop character in the 

barcode.
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4. In the Size area, specify the following: 
• Font Size: Select or type the desired “font size.” This is an 

approximation of the width of the narrowest bar in the bar 
code in “mils” (one thousandths of an inch). The Bar 
Codes node does not require you to have bar code fonts 
installed on the FreeFlow system.

• Height: Select or type the desired barcode height.
NOTE: The size of the human-readable text is not included in 
the requested bar code height. If you specify height = 1 inch, 
the total size of the graphic is one inch plus the height of the 
readable text extending above or below the bar code.

NOTE: Height can be specified in inches or millimeters, 
except for PostNet (Japan) and QR Code because the height 
for those types is determined uniquely to bar width or cell size.

• Horizontal padding: Select or type the desired padding to 
control the amount of white space on either side of the 
barcode.

• Vertical padding: Available for QR Code type only. Select 
or type the desired padding to control the amount of white 
space at the top or the bottom of the barcode.

5. Select the desired degree of rotation, in increments of 90 
degrees. The icon changes to reflect the selected rotation.

6. Select or type the horizontal position from the PDF document 
box: [From left], [Center], or [From right].

7. Select or type the vertical position from the PDF document 
box: [From top], [Center], or [From bottom].

8. Select the position relative to [Crop Box], [Media Box], 
[Bleed Box], [Trim Box] or [Art Box].
NOTE: You can specify offset in inches or in millimeters either 
as positive (inward from the selected box), or negative 
(outward from the selected box) numbers. Default placement 
is Top-Left of the Crop Box, with horizontal and vertical offsets 
(0.0, 0.0).
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9. In the “Apply to pages” area, specify the pages upon which the 
barcode will appear.
• If Page range is selected, enter a text string using 

commas and hyphens. For example, select  “1-3, 7, 12-14, 
17” to print bar codes on pages 1 through 3, on page 7, on 
pages 12 through 14, and on page 17.

NOTE: Various order jacket file variables are supported by 
FreeFlow Process Manager MAX, Manifest Automation from 
Xerox.. You can enter variable data syntax in the page range 
text box. For example, given an Order jacket file (OJF) with 
columns 1, 2, 3, 4 containing page range data “1-3”, “7”, “12-
14”, “17” respectively, you can enter text “$CSV1$, $CSV2$, 
$CSV3$, $CSV4$” into the page range text box. If OJF column 
contains an invalid page range, the workflow will fail with an 
invalid page range error in Workflow Job Manager.

10. Select [Always use these settings] to prevent users from 
modifying the settings. The settings will appear in the 
Submission Client controls, but will be grayed out and 
unchangeable.

11. Select [OK] to accept the changes or select another tab to 
continue configuring.
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To configure the barcode readable text

The Readable Text tab allows you to specify that the data 
encoded in the bar code prints in a human-readable format. The 
default is disabled. 
NOTE: The size of the human-readable text is not included in the 
requested bar code height. If you specify height = 1 inch, the total 
size of the graphic is one inch plus the height of the readable text 
extending above or below the bar code.

Readable text is not enabled for the following bar code types:  
• Bookland
• ISBN
• Postbar (Japan)
• QR Code (FX market)
The specifications, below, are not available for all barcode types. 
NOTE: View the dynamic effect of your selections in the Preview 
window at the bottom of this dialog, or click [Preview>>] to 
preview the barcode placement in the document. For more 
information about the Preview pane option, see Previewing job 
level edits.

1. To open the Add Barcode dialog, double-click the [Barcode] 
process in a workflow. 

2. In the Readable Text tab, mark the check box for [Include 
human readable text] to enable the feature.

3. If available, mark the check box for [Include check digits] to 
specify whether checksum character(s) should be shown in 
the human-readable text.

4. If available, mark the check box for [Split UPC characters] or 
[Shrink UPC Characrters] to specify that the first character 
and/or last character of the human-readable text is split apart 
from the rest of the human-readable text and/or printed in a 
smaller font. 

5. If available, mark the check box for [To include start and 
stop characters] t 

6. Specify whether the text is Opaque (cannot see through text) 
or Transparent (can see-through text).
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7. Specify the Vertical Placement as either: Place text below 
bars or Place text above bars.

8. Specify a Horizontal  Alignment, either [Left],  [Center], or 
[Right]. 

9. Select or type the text Vertical offset.
10. Select or type a Horizontal offset.
11. From the font drop boxes, specify the font, font style and font 

size.
12. Select [Always use these settings] to prevent users from 

modifying the settings. The settings will appear in the 
Submission Client controls, but will be grayed out and 
unchangeable.

13. Select [OK] to accept the changes or select another tab to 
continue configuring.
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To configure barcode data

You can specify the data to be encoded as a bar code.
NOTE: Guidelines for valid characters and total numbers of 
characters are displayed in the center of the dialog.

NOTE: You can enter data using characters outside of the valid 
character set for a bar code type if those characters are bracketed 
by the start/stop sequences used by variables in FreeFlow 
Process Manager MAX, Manifest Automation by Xerox.

See also:
To add or modify text or a data field
To manage barcode data

To add or modify text or a data field

1. To open the Add Barcode dialog, double-click the [Barcode] 
process in a workflow. 

2. Select the Data tab. 
• In the “Enter data” area, select [Add]. The Add Data dialog 

displays.
• If you are modifying text or data, select the desired item in 

the display window, and select [Modify]. The Modify Data 
dialog displays.

3. In the Add Data or Modify Data dialog, to add or modify text, 
select [Text], enter the desired text in the text box, and select 
[Add]. Your selection displays in the lower area of the dialog. 
Notice that the data is concatenated to form one string of data.

4. To add or modify data, select [Data Field] and select from the 
following variables:

– Job ID
– Job Name
– Sheet In Signature
– Sheet Number
– Sheets Per Signature
– Signature Number
– Total Sheets
– Total Signatures

NOTE: If the data field contains characters that the barcode 
does not support, the job may fail for invalid data.

5. To add leading zeroes, mark the check box to enable the 
feature, then select the desired number of digits from the drop 
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box.
6. Select [Add]. Your selections display in the lower area of the 

dialog.
7. If adding, select [Done]; if modifying, select [OK].

See also:
To manage barcode data

To manage barcode data

1. To open the Add Barcode dialog, double-click the [Barcode] 
process in a workflow. 

2. In the Data tab dialog, review your selections in the window. 
As necessary, select from the following:
• To add text or data, select [Add].  Data is concatenated to 

form one string of data. Refer to To add or modify text or a 
data field.

• To modify text or data, select the text or data and then 
select [Modify]. Refer to To add or modify text or a data 
field.

• To remove text or data, select the desired text or data, and 
then select [Delete].

• To move the selected text or data up or down in the list, 
select [Move Up] or [Move Down].

3. In the “Variable data options” area, select or type the desired 
Sheets per signature, from 1 to 999. This value is used if the 
Signature Number and Total Signatures variables are 
selected.

4. In the “When sheets are part of the barcode data” area, select 
from the following to specify a count direction to be used with 
the SheetNumber, SignatureNumber, and SheetInSignature 
variables. A single count direction is applied to all three 
variables.
• [Increments, starting with the first sheet number 

(ascending)] (1 to N)
• [Decrements, starting with the last sheet number 

(descending)] (N to1)
NOTE: If bar code frequency is set to Even Pages or Odd 
Pages, the Bar Codes node treats the document as duplex, 
and the Sheet Number variable increments for every bar code 
(i.e., not for every PDF page), while the TotalSheets variable is  
half the number of PDF pages. The document is also treated 
as duplex if any of the Signature variables are used.



FreeFlow Process Manager Operator and Administrator  Guide 2-81

Workf low Bui lder

5. Select [Always use these settings] to prevent users from 
modifying the settings. The settings will appear in the 
Submission Client controls, but will be grayed out and 
unchangeable.

6. Select [OK] to accept the changes or select another tab to 
continue configuring.
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Previewing job level edits

The Preview option allows you to dynamically view content added 
to a PDF document before you commit to the selected settings. 
You can preview the following workflow processes:
• Bates Stamping
• Page Numbering
• Watermarks
• Barcodes
• Pressmarks
• Imposition
NOTE: The Preview feature does not support Crop, Resize, Flip, 
and Rotate.  

You can preview content on one or more blank pages or on a 
sample PDF document.

To preview job level edits

1. Open one of the following processes in a workflow:
• Bates Stamping
• Page Numbering
• Watermarks
• Barcodes
• Imposition
• Pressmarks

2. Select [Preview >>] to display the preview controls. The 
controls allow you to preview selections, but do not affect the 
output.
NOTE: In the Imposition settings, mark the checkbox for 
[Preview].

You can specify a sample PDF document upon which to preview 
the content. Otherwise, the content is displayed on one or more 
blank pages. 
3. Select [Use sample PDF] to use the browse function to 

specify a sample PDF document. A Workflow [Process] dialog 
displays.

NOTE: NOTE: You can also drag and drop a PDF document into the 
Preview window.
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4. Select [Yes] to browse for a sample PDF.
5. In the Browse for sample PDF dialog, browse select a file.
6. Select [Open] to choose the file and close the dialog. 

• The path and file name display in the text box. 
• The file displays in the Preview window.
• Preview page count displays the number of pages in the 

sample PDF document.
4. If there are multiple pages to preview, use the Page Forward 

and Page Back arrows to navigate. In the Imposition Preview 
pane, right-click and select from [First Sheet], [Previous 
Sheet], [Next Sheet] or [Last Sheet].

5. Select [Preview page image size] to select a preview page 
size. The content displays on a blank page of the selected 
stock size. The Imposition node supports Auto. The default for 
all other nodes is 8.5 x 11 inches or A4 metric. Select Custom 
to enable Width and Height boxes. 

6. Select [Show Rulers], or in the Imposition Settings dialog, 
select [Show Preview rulers], to turn on or turn off the 
Preview screen rulers.

7. For the Imposition Preview window only:
• Select [Show corner page numbers] to display the page 

number in all corners of each displayed page.
• For Maxium N-Up jobs, in the Imposition Settings dialog, 

the “Automatic output prognosis” area shows the status of 
the specified job options.
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Rotating pages

Each page in the PDF file can be rotated by 90 degrees clockwise 
or counterclockwise, or by 180 degrees.

To rotate pages

1. Double-click the Rotate Pages step in a workflow.
2. Select from None, Right 90, Left 90, or 180 degrees to turn a 

page from its current position.
3. Select [Always use these settings] to prevent users from 

modifying the settings. The settings will appear in the 
Submission Client controls, but will be grayed out and 
unchangeable.

4. Select [OK] to accept the changes and close the window, or 
continue setting job level edit options.

Flipping pages

Each page in the PDF file can be flipped horizontally or vertically 
to create a mirror image.

To flip pages

1. Double-click the Flip Pages step in a workflow. Select from the 
following:
• In the Horizontal area, select [Flip] to flip pages along the 

horizontal axis and create a mirror image.
• In the Vertical area, select [Flip] to flip pages along the 

vertical axis and create a mirror image.
2. Select [Always use these settings] to prevent users from 

modifying the settings. The settings will appear in the 
Submission Client controls, but will be grayed out and 
unchangeable.

3. Select [OK] to accept the changes and close the window.
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Resizing

The Resize feature allows you to automatically resize images at 
the document and page level. You can select a specific size, or a 
size based on a percentage of the original image size. Jobs 
containing PDF, JPEG, TIFF, and BMP files, including mixed files, 
are supported. 
• Settings are applied to all files in the job and all pages in the 

file. 
• For TIFFs, JPGs, or BMPs, the image is resized; for PDFs, the 

page is resized.
• For pages with multiple images, each page—not each 

individual image on a page—will be scaled or resized to the 
specified size.

NOTE: You cannot resize individual images on a PDF page.

To resize

1. To access the Resize settings dialog, double-click the [Resize] 
step in a workflow.

2. Select from the following:
• [Scale to size] to select image resizing to a specific size.
• [Scale by percent] to select image resizing based on a 

percentage of the original image or PDF page size.
• [Width] to select a specific width or a percentage of the 

original width. Default: 8.5” or 100%.
• [Height] to select a specific height or a percentage of the 

original width. Default: 11.00” or 100%.
• [Constrain proportions] to set an equal width and height 

scale percentage by changing only the width value. The 
link below the spin boxes is connected when this option is 
selected and unconnected when not selected. Available 
when [Scale by percent] is selected.

3. Select [Always use these settings] to prevent users from 
modifying the settings. The settings will appear in the 
Submission Client controls, but will be grayed out and 
unchangeable.

4. Select [OK] to accept the changes and close the window.
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Configuring Imposition settings

The Imposition process allows you to define the placement of 
page elements to increase production press efficiency and to 
create specific applications—for example, booklets.
If PREPS is installed on the computer, the initial Imposition 
Settings dialog allows you to choose one of the following:
• Specify imposition settings: When you select [OK], displays 

the FreeFlow Process Manager Imposition Settings dialog, in 
which you can establish the desired settings.

• Use Preps job file: When you select [OK], displays the Preps 
Imposition Settings dialog, in which you can select Preps 
templates.

See also:
Previewing job level edits
To configure Imposition settings - General tab
To configure Imposition settings - Crop Marks tab
Guidelines for Cell Clustering
PDF Page Box Considerations
PDF Page Box Limitations
About Job types
Maximum N-Up considerations
Automatic stock type considerations
Maximum N-Up limitations
Configuring Preps settings
Limitations for Imposition and PREPS
Fault handling for Imposition
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To configure Imposition settings - General tab

The General tab allows you to select a job type and establish 
settings—for example, orientation, stock, margins, and various 
signature options.
1. Double-click the Imposition step in a workflow.

• If Preps is detected on the computer, the initial Imposition 
Settings dialog displays. Select [Specify imposition 
settings], and then select [OK] to close the window and 
display the Imposition Settings dialog. 

• If Preps is not detected on the computer, the standard 
Imposition Settings dialog displays.

2. In the Imposition Settings dialog, select the General tab.
3. Select a job type from the drop box. 

• For more information about job types, see About Job 
types, Maximum N-Up considerations, and Maximum N-
Up limitations.

4. The Preview pane allows you to dynamically view the  
selected settings. Mark or deselect the [Preview] check box to 
open or close the Preview pane. For more information about 
the Preview option, see Previewing job level edits.

5. For Custom N-up jobs, in the Rows and Columns area, select 
or type the number of rows or columns, up to a maximum of 
16.

6. In the Pages on sheet side area, select from the following:
• [Repeated] to fill a multi-up sheet side with copies of a 

single page.
• [Sequential] to place a single page in each cell of the 

multi-page up.
• [Cut and Stack] to arrange the order that the images are 

printed on the sheets so the printed sheets can be cut and 
easily stacked into one copy of the final document.

• [Alternating] to place the pages sequentially, but 
alternating the front side and the back side of a page.

7. In the Orientation area, select from of the following:
• [Portrait] to orient vertically.
• [Landscape] to orient horizontally.
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8. In the Sides imaged area, select from the following:
• [1 sided] to print on one side of a page.
• [2 sided] to print on both sides of a page.
• [Head to Toe] to print the reverse side of a page so the 

finished document has a calendar format.
9. In the Paper Stock area, select a stock type from the drop box.
10. Select [Automatic] from the drop box to enable the automatic 

selection of stock or creation of custom stock based on the 
cells of a specific job.
• Mark the check box for [Select auto stock from the 

nearest standard type if possible] and select from the 
following stock types:
– Constrain to English stock types: to search the list 

of named English stocks for one large enough to 
encompass the layout area.

– Constrain to metric stock types: to search the list of  
Metric stocks for one large enough to encompass the 
layout area. 

– No regional constraint: to search the list of Metric 
and English stocks for one large enough to encompass 
the layout area. For more information, see Automatic 
stock type considerations.

NOTE 1: If the Select auto stock from the nearest standard type 
check box is not marked, a custom stock is created that 
encompasses the layout area. It may or may not equate to a 
standard named stock.
NOTE 2: The auto stock feature produces an imposition result, not 
a print result. Print output stock is selected in the Print node 
dialog.
11. Select [Custom] paper stock to enable the [Width] and 

[Height] options, and then type the desired value.
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12. In the Margins area, select or type the margin for each option: 
[Top], [Left], [Bottom], and [Right]; or select [Uniform] to 
change all settings to the Top setting. 

13. In the Page Position and Autofit area, select from the 
following:
• In the Positon Relative to area, designate a PDF box, 

either [PDF Crop Box], [PDF Trim Box], [PDF Bleed 
Box], and [PDF Art Box], upon which the size of the cells 
that are being imposed is based.

14. You can specify a horizontal and vertical cell-relative position 
for the PDF image (logical page) within an imposed sheet cell, 
and thereby reduce the amount of cut and trim post-printing. 
Select from the following:
• [Horizontal] to specify the horizontal anchor position 

reference edge of the image alignment. Available if not 
centered. Select from the following:
– [From left], [From right], [Center]: Always available.
– [From binding edge]: Available if 2-sided document.
– [From non-binding edge]: Available if 2-sided 

document.
• [Vertical] to specify vertical anchor position reference 

edge of the image alignment. Available if not centered. 
Select from the following: 
– [From top], [From bottom], [Center]: Always available
– [From binding edge]: Available if Head-to-toe 

document.
– [From non-binding edge]: Available if Head-to-toe 

document.
NOTE: Earlier versions of Process Manager (2.0, 3.0, 4.0) 
used the uni-dimensional Anchor Image function. Legacy 
workflows will be translated into a 2-dimensional format. 
Horizontal and vertical values will be 0.00. Edge settings will 
be translated into the appropriate dimensional control element, 
taking into consideration document plex.

NOTE: Page imagery is typically allowed to bleed beyond the 
selected PDF box. However, the selected PDF box can act to 
crop imagery that lies beyond it if the user specifies a margin 
of any size or dimension.
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15. To enable cell clustering, mark the check box for [Cluster 
imposed cells]. For more information about clustering, see 
Guidelines for Cell Clustering. 

16. Select from the following to specify the space or “gutter” 
between the clustered cells: 
• [Gutter width] To specify a single horizontal gutter value.
• [Gutter height] To specify a single vertical gutter value.
Gutters are applied between the cells and do not affect border 
gutters. 
NOTE: With the Autofit check box marked and gutter values 
specified, the Autofit cell size is reduced by half the gutter in 
both the vertical and horizontal dimension. Any page content 
that exists outside of the selected PDF box bleeds into (half) 
the gutter area between imposed cells.

17. Select [Autofit] to scale the image to fit inside the cell. 
18. Select from the following signature options:

• [Signature Shift] to specify an incrementing offset for 
incoming PDF pages on the output paper stock for Book, 
Pamphlet, and Calendar job styles.

• [Single signature] when cleared, to specify the number of 
sheets per signature segment; when selected, to place all 
sheets in one signature.

• [Sheets per signature] to enter the number of sheets that 
will comprise a single segment of a multiple-segment 
signature document, from 1-999. Available when Single 
signature checkbox is unchecked. 

• [Fill last segment] to fill the document with blank sheets to 
ensure the last segment in the job is filled to the value 
specified in Sheets per signature. Available when Single 
signature checkbox is not selected.

NOTE: The number of sheets in the final signature may not 
equal the requested value when Sheets per signature does 
not divide evenly into the number of sheets.

19. Select [Always use these settings] to prevent users from 
modifying the settings or to override any similar settings in an 
incoming JDF job ticket or an RDO file. The settings will 
appear in the Submission Client controls, but will be grayed 
out and unchangeable.
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To configure Imposition settings - Crop Marks tab

The Crop Marks tab includes options that allow you to print guide 
or “cut” marks that define the edges of multiple pages of a job 
printed on larger paper stock. You can:
• Define the size and color of the crop marks.
• Define the sheet faces to which to apply the crop marks for 

simplex and duplex jobs.
1. Double-click the Imposition step in a workflow.
2. If Preps is detected on the computer, the initial Imposition 

Settings dialog displays. Select [Specify imposition 
settings], and select [OK] to close the window and display the 
Imposition Settings dialog. 
If Preps is not detected on the computer, the standard 
Imposition Settings dialog displays.

3. In the Imposition Settings dialog, select the Crop Marks tab.
4. In the Crop mark box window, select from the following:

• [Media Sheet]  to define the crop margin relative to the 
sheet regardless of imposition job type. Range is:
– 0 to remaining width of paper stock for Left and Right 

controls.
– 0 to remaining height of paper stock for Top and 

Bottom controls.
• [Media Cell] to define the crop margin relative to each cell 

on the sheet. Range is:
– 0 to remaining width of cell for Left and Right controls.
– 0 to remaining height of cell for Top and Bottom 

controls.
• [Cell Cluster] to define the crop margin relative to each 

cell cluster on the sheet. 
For more information about clustering, see Guidelines for 
Cell Clustering.

• [PDF Crop Box] to define the boundary for the contents of 
the page when it is displayed or printed.

• [PDF Trim Box] to define the finished dimensions of the 
page after trimming.
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• [PDF Bleed Box] to define the amount of extra area to 
image outside of the final page size defined by the PDF 
Trim Box.

• [PDF Art Box] to define the area of the page where PDF 
content is placed.
For more information about PDF boxes, see PDF Page 
Box Considerations and PDF Page Box Limitations.

NOTE: Bleed, Trim, and Art boxes must be smaller than or 
equal to the defined PDF Crop Box.

5. In the crop marks offsets area, specify offsets from the edges 
of the selected crop mark box:
• [Top], [Bottom], [Left], and [Right] to set the desired  

offsets.
• [Uniform] to define all offsets; defined by the Top offset. 
• [Inward offset] to place offsets inside the perimeter of the 

selected box.
• [Outward offset] to specify offsets outside the perimeter 

of the selected box. 
NOTE: The Outward offset option is disabled for media sheet 
crop marks.

Offsets must be all inward or all outward. Negative offset 
values are not allowed.

NOTE: For the PDF box options, the above options define the 
box relative to the size of the PDF page being imposed. The 
box is affected by and moved according to all transformations 
of the page such as Autofit, Margin, and Page Image Position/
Alignment settings. The range is 0 to 60 inches and the metric 
equivalent.  
 
Use care with this option as it is possible to specify a box 
rectangle that exceeds the actual page size or that is clipped 
off by the sheet cell(s) during imposition.
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6. Select from the following Sheet Face options:
• [Mark both sides] to place crop marks on the front and 

back of sheets. This is the default selection when a duplex 
job is defined.

• [Mark front side only] to place crop marks on the front 
side of sheets. This is the default selection when a simplex 
job is defined.

• [Mark back side only] to place crop marks on the back of 
sheets.

7. Select from the following Interval options:
• [Mark every sheet] to apply crop marks to all sheets in the 

output.
• [Mark first sheet] to apply crop marks to the first sheet in 

the output
• [Mark last sheet] to apply crop marks to the last sheet in 

the output.
• [Mark every] to apply crop marks to every “n” sheet as 

defined by the user via the sheets spin box. Range: 1 to 
500.
– [Starting with the first sheet] to start crop marks on 

the first sheet when selected, or on sheet(s) N when 
not selected.

8. Select from the following Size and Color options:
• [Crop mark length]: Defines the length of the crop mark 

from corner offset outward to the edge of the cell, sheet, or 
page.

• [Crop mark color]: Defines the color of the crop mark.
• [Crop mark bleed]: Defines the distance between the crop 

marks and the corner of the rectangle the crop marks 
identify. For example, if the bleed length is set to “0,” the 
horizontal and vertical crop mark lines that form a corner 
would meet. Larger values space the lines away from each 
other.

9. Select [OK] to accept the changes and close the window.
NOTE: If printing, ensure that the sides imaged and the paper 
stock options in the print component are consistent with the 
options specified here. 
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Guidelines for Cell Clustering

A cell is the area on a sheet occupied by a multipage imposition 
scheme. Cell Clustering provides the option of pulling together 
cells on a sheet in a way that results in cell sizes that contain the 
imposed page images with no waste space between cells. The 
Cell Cluster is positioned and aligned as a single entity.
• Cell Clustering is not available for Standard and Signature job 

types. The cells in a signature job configuration are pulled 
together using the “Binding-edge” alignment option.

• With Autofit off it is possible to yield cell sizes that when 
clustered, produce a layout area that exceeds the dimensions 
of the paper stock. As a result, only a portion of the NxN cell 
matrix may appear on the cell with the rest of the cells partially 
or completely clipped by the defined paper stock size.

• The position and alignment controls control the cell cluster. 
The ability to justify content within a cell is lost. All content is 
justified top-left within a cell.

• With Cell Clustering OFF, the imposition entities being 
controlled are the individual page images with respect to 
position, alignment, and autofit. With Cell clustering ON, the 
entity being controlled is the entire cluster of cells.
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PDF Page Box Considerations

• The PDF Boxes allow you to perform an “automated crop” by 
using a box defined within the PDF, rather than tailoring a 
workflow specific to an input document type. You can use the 
PDF boxes to meet specific job requirements—for example, 
the PDF Art Box can represent document fold lines. 

• The PDF Media box option is not supported in imposition, but 
you can create an equivalent during imposition via the Paper 
Stock setting. The PDF Media Box describes the whole area of 
the PDF document including gutters and trim areas. All other 
box definitions are sub-areas of the media box. It is not 
changeable by the user and is established when the PDF 
document is created. 

• The Trim, Bleed and Art boxes must be smaller than the Crop 
Box. Box edges defined in the input document that are beyond 
the corresponding crop box edge are limited to the crop box 
edge during imposition.

• You can select which of the four supported PDF boxes to be 
used for positioning and autofit. Note that the PDF page is not 
clipped by the selected box unless margins are applied.  
Enabling autofit will cause the selected box to scale to fit the 
sheet cell it is being imposed into.  PDF page data may bleed 
outside of the selected box into any sheet cell waste-
space created during autofit scaling as long as it does not 
intrude into a neighboring imposition cell.

• Bleeds beyond the selected PDF box are disabled if any 
margins are applied.

• From the perspective of downstream workflow components, 
page size in the output document is the selected paper stock 
upon which the input document is imposed.

PDF Page Box Limitations

• There is no support for Media Boxes.
• Bleed, Trim, and Art boxes must be smaller than or equal to 

the defined Crop box.
• Box offsets in the input document do not carry over into the 

imposed output document – all offsets are set at 0 in the 
output document.

• You can make PDF box definitions unique on a page-by-page 
basis.  Asymmetric imposition results occur if these definitions 
are not consistent throughout the document.
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About Job types

The following job types are available via the Imposition Settings 
dialog:
• Standard: The pages are printed in a sequential order with 

one page on one side of a sheet of defined paper stock. There 
is one Standard job type, for which you can specify the image 
orientation and sides imaged.

• Signature: Two separate pages are printed side-by-side on 
one side of a sheet of paper. All Signature documents are 2-
sided. The pages of the document are sequenced when 
printed to produce output that can be folded to create a 
booklet type of document. There are three signature job types, 
each characterized by the fold (binding edge) of the document:
– Signature Booklet: Portrait, fold (binding edge) is parallel 

to short edge of the stock
– Signature Calendar: Head to Toe orientation, fold 

(binding edge) is parallel to short edge of the stock
– Signature Pamphlet: Portrait orientation, fold (binding 

edge) is parallel to the long edge of the stock
• N-up: The pages are printed in sequential order with each 

page of the document appearing a specified number of times 
(n) on the same side of a sheet of paper. (This is also known 
as multiple imposition or tiling.) Each copy of the page is called 
a cell. There are ten n-up job types:
– 2 Up: Each page is imaged twice on one side of a sheet of 

paper.
– 2 Up Flip Left: Each page is imaged twice on one side of a 

sheet of paper with the left of the two imaged pages flipped 
180 degrees to appear upside down.

– 2 Up Flip Right: Each page is imaged twice on one side of 
a sheet of paper with the right of the two imaged pages 
flipped 180 degrees to appear upside down.
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• 3 Up: Each page is imaged three times on one side of a sheet 
of paper.

• 3 Up Flip Left: Each page is imaged three times on one side 
of a sheet of paper with the left of the three imaged pages 
flipped 180 degrees to appear upside down.

• 3 Up Flip Right: Each page is imaged three times on one side 
of a sheet of paper with the right of the three imaged pages 
flipped 180 degrees to appear upside down.

• 4 Up: Each page is imaged four times on one side of a sheet 
of paper. There is no flip option for 4-Up.

• 8 Up: Each page is imaged eight times on one side of a sheet 
of paper. There is no flip option for 8-Up.

• 16 Up: Each page is imaged sixteen times on one side of a 
sheet of paper. There is no flip option for 16-Up.

• Custom N-Up: Allows the user to specify rows and columns in 
combination with Orientation, Sides Imaged, Margins, Paper 
Stock, and Autofit options. The following options are grayed 
out if Custom N-Up is not selected:
– Rows (maximum of 16)
– Columns (maximum of 16)
– Pages on Sheet Side; Repeated; SequentiaI; Cut and 

Stack; Alternating
• Maximum N-Up: Given an input page size, calculates how 

many of those pages can be fit onto the sheet. See also 
Maximum N-Up considerations and Maximum N-Up 
limitations.
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Maximum N-Up considerations

•  Maximum N-up might benefit workflows where resource 
utilization is of a higher-priority than layout scheme.

• The N-up cell count is based on the size of the configured 
imposition reference box (PDF box) on the first page of the 
document only.  If the selected reference box is not of 
consistent size throughout the input document, unusual 
clipping or seemingly asymmetric output will result.

• The application of gutters when this feature is used with 
imposition cell clustering will be accounted for in the layout 
computations and therefore, total N-up cells maybe be 
reduced as a result.

• The use of gutters in conjunction with imposition cell clustering 
may result in a reduction of total N-up cells.

• If the input page size reference is larger than the selected 
stock size, a Standard non-Autofit job style output results.

• If the number of pages in the input document cannot fill all the 
cells for the N-up, a partial N-up output results.

• Autofit functionality is not available with this configuration.
• The maximum number of rows and/or columns is limited to 16 

in each direction.

Automatic stock type considerations 

The Automatic Paper Stock type option selects or creates a 
custom stock configuration that completely contains the cells of a 
specified job type. This option is useful for “intermediate” 
imposition steps in multi-imposition workflows.
Imposition result vs print result The automatic stock feature 
produces an imposition result – not a print result. The stock size 
defined by the code logic cannot be communicated to the print 
component logic because there is no means in Process Manager 
to achieve this at job run-time. The printed output stock is selected 
in the print node or as configured by the XPIF ticket during hot-
folder operation. 
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Stock dimensions based on reference box The stock 
dimensions are based on the resulting cell layout of the job type 
and the size of the configured imposition reference box (PDF box) 
on the first page of the input document only. If the  reference box 
is consistent size throughout the input document, unusual clipping 
or unexpected border-gutter space may result.
Regional prioritization If you prioritize the automatic selection to 
one of the standard named stock configurations, you may further 
constrain the standard stock type used by regionality. 
For each of the options, If no stock among the set is large enough 
to encompass the layout area, a Custom type is created.

– If a standard stock type is identified, orientation is 
dynamically configured to choose a stock orientation that 
minimizes post-imposition waste areas.

– If the subsequent layout exceeds the size of an identifiable 
standard stock type, a Custom stock type that 
encompasses the layout area is created. 

– If you choose not to prioritize among standard stock types, 
a stock type that wholly encompasses the layout area is 
created. This might equate dimensionally to a standard 
named stock type.

Maximum size The maximum size for an automatic stock is 60” in 
either direction.
Both Maximum N-up and Automatic stock selected If you 
select both Maximum N-up and Automatic stock configurations, 
the result is a Standard, non-Autofit job style output as the 
maximum number of cells that can be fit onto a undefined area is 
always equal to one.

Maximum N-Up limitations

• Cannot be used to automatically configure the printed stock.
• No support for Media Boxes.
• Bleed, Trim and Art boxes must be smaller than or equal to the 

defined Crop box.
• Defined boxes in the input document are not carried over into 

the imposed output document.
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 Configuring Preps settings

If Preps is installed on the computer, the initial Imposition Settings 
dialog allows you to choose one of the following:
• Specify imposition settings: Displays the Imposition 

Settings dialog, in which you can establish the desired 
imposition settings.

• Use Preps job file: Displays the Preps Imposition Settings 
dialog, in which you can select Preps job files.

In Preps, job files are layout masters used in conjunction with a 
set of pages to produce imposed jobs. The Administrator 
establishes the selectable job files from the Preps software. The 
Preps dialog settings allow you to select from a list of Preps 
imposition job files.

To configure Preps settings

1. Double-click the Imposition step in a workflow.
2. If Preps is detected on the computer, the initial Imposition 

Settings dialog displays. Select [Use Preps job file]. Select 
[OK] to close the window and display the Preps Imposition 
Settings dialog. 
NOTE: If Preps is not detected on the computer, the regular 
Imposition Settings dialog displays. For information about 
Preps installation, refer to the procedure “Setting up Preps” in 
the About FreeFlow Process Manager section.

3. In the “Select the Preps Job files that submitters can choose 
from” text box, select the desired Job files. The Job files will 
populate the “Select the default Preps Job file” drop box. 

4. In the “Select the default Preps Job file” drop box, select a 
default Job file. 

5. If applicable, select [Always use these settings] to prevent 
users from modifying the settings or to override any similar 
settings in an incoming JDF job ticket. The settings will appear 
in the Workflow Submission Client controls, but will be grayed 
out and unchangeable. 

See also:
Configuring Imposition settings
About Job types
Limitations for Imposition and PREPS
Fault handling for Imposition
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Limitations for Imposition and PREPS

• If more than one Impose node exists in a workflow – for 
example, workflows with Conditional branches and\or fail 
branches with Impose nodes in more than one branch – the 
propagation code selects the impose node on the top branch 
(or the main branch in case of fail branches) as the "first" 
impose node and propagates it with information from the 
ticket. If the job takes the second branch during the execution, 
the impose node on the second branch, although technically 
the “first" impose node to be encountered by the job, will not 
contain the ticket information.

• JDF imposition parameters cannot be translated into Preps 
imposition templates, and Preps does not support JDF.

• Non-printable content such as bookmarks, sounds, movies, 
logical structure, hyperlinks, and article threads will not be 
preserved by the Preps imposition component.

• No support for imposition marks such as exposure keys will be 
provided within the Xerox imposition templates. Such items 
are typically placed in the “gutter” area of the press sheet. This 
type of advanced feature is available in Kodak Preps.

• VI Containers should not be used with PREPS. Process 
Manager handles these as containers, not PDF files.

• When you submit a job to a Process Manager workflow that 
includes Imposition with PREPS, ensure that the PREPS 
application is not running if the license is only for one instance 
of PREPS.

Fault handling for Imposition

Errors are logged in the Windows Event log and display in the 
Workflow Job Manager status display area. The following errors 
cause the Imposition operation to fail:
• If the input PDF file is missing.
• If the input PDF file is invalid.
• If the output PDF file is locked and cannot be overwritten or if 

the user lacks sufficient security privileges to access the 
destination directory.

• If the input PDF file requires a password to open the PDF or 
does not permit any of the following: content copying and 
extraction, document assembly, or content accessibility.
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Cropping

The Crop feature allows you to automatically crop PDF, JPEG, 
TIFF, and BMP files. A job can include all supported file types. 
Equal cropping is applied to all files in the job.

To crop

1. To access the Crop dialog, double-click the [Crop] step in a 
workflow.

2. In the Edge offset section, enter a number or click the up and 
down arrows to define crop position from the Left, Right, Top, 
or Bottom edge of the page.

3. If desired, select [Uniform] to enable the following options: 
• [All edges]: Makes all values equal to the Left entry.
• [Opposite edges]: Makes Left and Right values equal to 

the Left entry; makes Top and Bottom values equal to the 
Top entry.

4. Select [Always use these settings] to prevent users from 
modifying the settings. The settings will appear in the 
Submission Client controls, but will be grayed out and 
unchangeable.

5. Select [OK] to accept the changes and close the window.
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Configuring Pressmarks settings

The Pressmarks node allows you to add a fixed pressmark to a 
workflow. You can specify the pressmark placement, rotation, 
frequency, transparency, and then preview the specifications.

To set up or modify a pressmark

1. Double-click a Pressmarks process in a workflow to open the 
Add Pressmarks dialog.

2. To preview the pressmark placement in the document, select 
[Preview>>]. For more information about the Preview option, 
see Previewing job level edits.

3. Select one of the following:
• Select [New], and then select [Image Pressmark] to open 

the New Image Pressmark dialog and set up a pressmark.
• Select a pressmark from the list, and then select [Modify] 

to open the Modify Image Pressmark dialog and change 
the pressmark.

• To Duplicate or delete a pressmark, see Duplicating or 
deleting a pressmark.

4. Select [Browse] to locate an image file of the type listed in the 
drop box.

NOTE: The selected image must reside on a local drive.

a. In the Browse for Pressmark Image File dialog, select a 
file. 

b. Select [Open]. The dialog closes and the path and file 
name display in the Pressmark filename text box.

5. In the Modify Image Pressmark or New Image Pressmark 
dialog, select a percentage from 1 to 200 to scale the image.

6. Select or type the horizontal position from the PDF document 
box: [From left], [Center], or [From right].

7. Select or type the vertical position from the PDF document 
box: [From top], [Center], or [From bottom].

8. Select a position relative to [Crop Box], [Media Box], [Bleed 
Box], [Trim Box] or [Art Box].
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9. Select the desired degree of rotation, from 0-359 degrees. The 
icon changes to reflect the selected rotation.

10. Select a transparency from 0-100. The greater the 
transparency level, the less opaque the pressmark. 

11. In the “Apply to pages” area, select a pressmark frequency 
from the drop box. 
• If a range is selected, enter a text string using commas and 

hyphens. For example, select  “1-3, 7, 12-14, 17” to print 
bar codes on pages 1 through 3, on page 7, on pages 12 
through 14, and on page 17.

NOTE: Various order jacket file variables are supported by 
FreeFlow Process Manager MAX, Manifest Automation from 
Xerox. You can enter variable data syntax in the page range 
text box. For example, given an Order jacket file (OJF) with 
columns 1, 2, 3, 4 containing page range data “1-3”, “7”, “12-
14”, “17” respectively, you can enter text “$CSV1$, $CSV2$, 
$CSV3$, $CSV4$” into the page range text box. If OJF column 
contains an invalid page range, the workflow will fail with an 
invalid page range error in Workflow Job Manager.

12. Select [OK] to accept the changes, close the window and 
return to the Add Pressmark dialog. The new pressmark 
displays in the Pressmarks list; its description displays to the 
right.

NOTE: All pressmarks in the list are applied to the job and are 
applied in the order in which they are listed. 

13. If desired, select a pressmark and select [Move Up] or [Move 
Down] to move it up or down in the list, and to define the order 
in which the image is layered on the page.

14. Select from the following:
• [Place all pressmarks behind page content] to place the 

pressmark underneath the page contents.
• [Place all pressmarks in front of page content] to place 

the pressmark on top of the page contents.
NOTE: The setting applies to all pressmarks. 

15. Select [OK] to accept the changes and close the window.

See also:
Duplicating or deleting a pressmark
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Duplicating or deleting a pressmark

You can duplicate or remove a selected pressmark from the list. 

To duplicate or delete a pressmark

1. Double-click the Pressmark step in a workflow.
2. In the Pressmark list, select a pressmark. 
3. Select from the following:

• Select [Delete] to remove the pressmark.
• Select [New], and then select [Duplicate] to copy the 

pressmark.
4. Select [OK] to accept the changes and close the window.

See also:
Configuring Pressmarks settings
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About Review

The Review process allows you to view the PDF file in its current 
state and approve or fail the document. When a workflow is 
stopped at a Review step, in Workflow Job Manager you can also 
perform the following functions, depending on the makeup of the 
workflow:
• View and edit the file using Adobe Acrobat Professional.
• View a soft proof using Adobe Acrobat Professional.
• Print a hardcopy proof.
• Modify the copy count.
• Change process settings and resubmit the job.
A settings dialog is not available for Review. 
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Configuring Notify settings

The Notify process provides job status notification via e-mail. 
Examples of uses include: 
• Job start notification: Notifies the operator that the job is 

beginning.
• Preflight fail notification: Notifies the operator when preflight 

fails, which allows immediate intervention.
• Job finish notification: Notifies the operator that the job is 

completed.

Email attachments 

If you choose to attach job files, the recipient will be able to 
remotely proof, validate, or repair the PDF file. Compound 
document types, such as RDOs, cannot be attached. The 
maximum attachment size is established using the SMTP Setup 
dialog in Workflow Job Manager. The maximum allowable 
attachment size depends on your email configuration. The email 
notification will fail if the file exceeds the limitation.
You have the option to add a watermark to the email attachment. 
For more information, see Setting up a watermark in an email 
attachment. 
NOTE 1: If they are allowed to change the settings, operators can 
add, delete, or change the email address in Workflow Submission 
Client when the job is submitted and the workflow is selected.
NOTE 2: Email notification requires configuration of the SMTP 
server via the Workflow Builder application.
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To configure Notification settings

1. To access the Notification Settings dialog, double-click the 
Notification step in a workflow.

NOTE: In the FreeFlow Administration Tool, the administrator 
can modify the user’s contact information and email address. 
When the user logs in to Process Manager, the To and From 
fields in the Notification Settings dialog are automatically set to 
that email address.

2. Select from the following:
• [Use the job submitter’s email address]: Picks up the 

job submitter’s email address as configured in the 
FreeFlow Administration Tool and uses it as the sender 
address for the notification.

• [Use the following address]: Allows you to enter an email 
address. By default, the text field displays the email 
address of the logged-in user. When submitting a job via a 
hot folder, the user set up in the hot folder dialog is the 
submitting user, and his/her email is used in the 
notification when that option is selected. 

3. In the To text box, type the recipient(s) e-mail address(s). Be 
sure to separate multiple addresses with semicolons.

NOTE: If addresses are not in the correct format, an error 
message displays.

4. If desired, select [Send copy of notification to sender] to 
send a copy to the sender.

5. Select [Enter recipient address during job processing] to 
gray out and clear the “To:” field and hold the job when the 
Notify step is reached. You must then enter recipient 
addresses before continuing with the job.
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6. Select [Enable Custom Subject Line] to enter a text string of 
your choice in the text box, or to select which of the following 
options to include in the subject line:
– Append Job ID
– Append Job Name
– Append Job Status

7. Select which of the following options to include in the body of 
the mail note:
– Job ID
– Job Name
– Job Status
– Job Submit Date
– Preflight Results
– Job Files

– Low Res version
8. To include a watermark on the job file, see Setting up a 

watermark in an email attachment
NOTE 1: Job files will include the PDF files at this stage of the 
processing. 
NOTE 2: Attached Job files can be viewed, but not printed or 
edited.
NOTE 3: All options, except Preflight Results and Job Files, are 
selected by default. When Job Files is selected, Send low 
resolution image is selected by default.
9. Type a message with a maximum of 256 characters.
10. Select [Allow job to continue even if no notification is sent] 

to ensure that the job does not fail if the email notification is 
not sent due to lack of recipient address or other failure.
NOTE: When selected, along with [Enter recipient address 
during job processing], the job will stop at Notify, but it will 
continue as successfully completed when you select Resume, 
if you do not enter a recipient.

11. Select [Always use these settings] to prevent users from 
modifying the settings. The settings will appear in the 
Workflow Submission Client controls, but will be grayed out 
and unchangeable.

12. Select [OK] to accept the changes and close the window.
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Setting up a watermark in an email attachment

Users with the Unlimited User Conversion License have the option 
to add a fully customizable security watermark to email 
attachments.
If properly licensed, the user can disable the addition of a security 
watermark by unmarking the [Specify the text to be applied as 
watermark on PDF email attachments] check box.
For users without the Unlimited User Conversion License, the 
attachment watermark defaults to "PROOF." Users can append 
customized text to "PROOF." The Unlimited User Conversion 
restrictions apply when submitted via hot folders and not via 
Workflow Submission Client.
The watermark does not appear on the job document.

See also:
Unlimited User Conversion option
Hot Folder submission with and without the Unlimited User 
Conversion License

To set up a watermark in an email attachment

1. In Workflow Builder, Workflow Submission Client, or Workflow 
Job Manager, select [Options: Email Attachment 
Watermark Setup...] to open the Email attachment 
Watermark Setup dialog.

2. If unmarked, mark the [Specify the text to be applied as 
watermark on PDF email attachments] check box.

3. Select the desired font from the drop down menu.
4. In the Text box, type the desired text, up to 20 characters. The 

text displays in the Sample graphic. 
5. Select [OK] to accept changes and close the window.
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Configuring Print settings

The Print settings dialog allows you to print PDF, VPC, or RDO 
(for reprint) files to a specified production print queue using a 
specified job ticket. A job ticket stores all your document 
information for printing to a production printer. 
Using the Print settings dialog, you can:
• Open a job ticket from a Windows file or document repository. 
NOTE: Job tickets can be applied only to workflows that contain 
the Print task.

• Access the Job Setup dialog for production printing and make 
the desired changes. 

• Insert separator pages via the Job Setup dialog.

If the printer is not available on a standalone client

If you attempt to open the Print Settings dialog on a Workflow Job 
Manager or Workflow Submission Client standalone client and an 
error message states that the current printer is not available, you 
will need to obtain the list of registered printers.
On the standalone client, Select [Start: Programs: Registered 
Print List Locator]. In the Registered Print LIst Locator dialog, 
select [Remote] and enter the computer address of the Printer 
Administration server.

See also:
To configure Print settings
Inserting separator pages
Fault handling for Print
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To configure Print settings

1. To access the Print Settings dialog, double-click the Print step 
in a workflow.

2. In the “Select printers that submitters can choose from” text 
box, select the desired printers. The printers will populate the 
“Select the default printer” drop box.
NOTE: Printers are added to the list in the “Select printers that 
submitters can choose from” text box via the Printer 
Registration application.

3. In the “Default printer” drop box, select the appropriate default 
printer.

4. Select [Job Setup] to open the Job Setup dialog from 
production printing. Make the desired selections. Options vary 
depending on the selected printer. Refer to the job setup help 
for additional information.

5. In the Print Settings dialog, select [Always use these 
settings] to prevent users from modifying the settings or to 
override any similar settings in an incoming JDF job ticket or 
an RDO file. The settings will appear in the Workflow 
Submission Client controls, but will be grayed out and 
unchangeable.

6. Select [OK] to accept the changes and close the window.
NOTE: Be sure the Print process settings reflect the needs of 
your job. The workflow defaults to the print settings. For 
example, if you select 2-sided in the Imposition settings and 
the default Print process setting is 1-sided, the job will print 1-
sided.
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Inserting separator pages

Separator pages are available on printers that support special 
page programming. This feature is available only in Process 
Manager, for PDF files.
NOTE 1: For the “Insert after each set” option, there is a limit of 
1000 separator pages per job. 
NOTE 2: Separator pages cannot be programmed with page 
ranges, finishing, special pages, blank page inserts, or chapter 
starts, in the same job.

1. In the Print settings dialog, select [Job Setup] to open the Job 
Setup dialog for production printing. 

2. To insert a blank separator page after a file or a set, select the 
Output Format tab. The tab name and options might vary, 
depending on the printer. 

3. Choose from the following in the Separator pages section of 
the tab dialog:
• [Insertion after each set]: Inserts a separator page after 

each set. Depending on your collation settings, if only one 
set is requested, the separator page is inserted after the 
last page of the job.

• [Insert after each file]: Inserts a separator page after each 
PDF file. If the job has only one PDF, the separator page is 
inserted after the last file.

Table 2-14. Example output from each separator page option

Multiple PDF Files submitted,
collated,
1 copy

 
Option: Insert after each file 

One PDF file submitted,
collated,
2 copies

 
Option: Insert after each set

One PDF file submitted,
uncollated,

2 copies
 
Option: Insert after each set

PDF file 1, page 1
PDF file 1, page 2
PDF file 1, page 3
PDF file 1, page 4
SEPARATOR PAGE

PDF file 2, page 1
PDF file 2, page 2
PDF file 2, page 3
SEPARATOR PAGE

PDF file 1, page 1, copy 1
PDF file 1, page 2, copy 1
PDF file 1, page 3, copy 1
PDF file 1, page 4, copy 1
SEPARATOR PAGE

PDF file 1, page 1, copy 2
PDF file 1, page 2, copy 2
PDF file 1, page 3, copy 2
PDF file 1, page 4, copy 2
SEPARATOR PAGE

PDF file 1, page 1, copy 1
PDF file 1, page 1, copy 2
SEPARATOR PAGE

PDF file 1, page 2, copy 1
PDF file 1, page 2, copy 2
SEPARATOR PAGE
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4. Select a paper stock for the separator page by stock number 
from the drop box.

NOTE: Options might vary, based on the printer.

5. In the Job setup tab, select the appropriate orientation to 
ensure that the separator page orientation matches the job 
orientation. 

NOTE: The Orientation option is enabled when the separator 
page feature is selected. 

6. Select [OK].

Limitations for separator pages

• Separator pages are available for PDF file printing only. Other 
file types generate an error message. 

• No imaging is available on the separator page.

Fault handling for Print

Errors are logged in the Windows Event log and displayed in the 
Job Manager status display area. The following errors cause the 
print operation to fail:
• If the specified PDF file(s), queue(s), or job ticket(s) are 

missing or invalid.
• If the specified PDF file(s) or job ticket(s) are invalid.
• If any of the input PDF file(s) require a password to open the 

PDF.
• If a user submits a non-PDF file to a workflow that has been 

programmed with separator pages, an “unsupported job ticket 
feature” error message displays.

• DocuSP printers printing via Process Manager will error if the 
user has not rentered an FTP login, or has entered invaild 
credentials.
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Configuring Save settings

The Save process allows you to copy all supported file types to a 
specified location within a document repository or Windows File 
system. Dialog options include:
Save job ticket information: Allows you to save the job ticket 
(XPIF) with the PDF file for reprinting purposes.

See also:
To configure Save settings
Saving a job ticket with the PDF file for reprinting
Limitations for Save
Fault handling for Save

To configure Save settings

1. To access the Save Settings dialog, double-click the Save 
step in a workflow. Select from the following:
a. [Use job name as file name] to use the job name as a 

basis for the file name for job submission.
b. [Use the following as file name] to enter the desired 

name. In the File name text box, type a name that will be 
used as the basis for the file name for job submission.

NOTE: If incorrect file characters (for example, \ / : * ? < >) are 
entered, an error message displays.
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2. Select one of the following:
NOTE 1: You might be prompted for a login and password if you 
attempt to access a mapped location.
NOTE 2: Prior to perfoming operations that require repository 
access, you must set up and save your repository credentials in 
FreeFlow Process Manager. If you select [Browse Repository] 
and no credentials have been established, you will be prompted to 
enter credentials. For more information, see Setting up repository 
credentials.

• [Browse Windows...] to open the Windows file dialog for 
selecting a file location. 

• [Browse Repository...] to open a repository dialog for 
selecting a repository location.

The Location text box is populated with the path specified 
during the browse process.

3. Select [Save job ticket information] to save a job ticket (.xpf) 
with the PDF file for reprinting later. The .xpf job ticket is 
saved, along with the PDF file, in the location designated in 
Save. 

4. Select [Always use these settings] to prevent users from 
modifying the settings. The settings will appear in the 
Workflow Submission Client controls, but will be grayed out 
and unchangeable.

5. Select [OK] to accept the changes and close the window.
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Saving a job ticket with the PDF file for reprinting

NOTE:  To save the job ticket, a Print process must be included in 
the workflow prior to the Save process.

The [Save the job ticket] option in the Save Settings dialog 
allows you to save the job ticket (.xpf) information with the PDF file 
for reprinting purposes. An .xpf job ticket is automatically saved in 
the same folder as the PDF. The last settings that were used to 
successfully process the Print node are saved. The settings can 
be from any of the following:
• An .xpf job ticket.
• Print node settings if “Always use these settings” is selected.
• A job ticket that was updated in Workflow Job Manager using 

the Settings button. 
To associate the .xpf job ticket with the files to be processed, an 
.xpf job ticket is saved using the following naming conventions: 
• For files: <file name>. <file extension>.xpf, for example:

– PDF file name = brochure.pdf
– .xpf file name = brochure.pdf.xpf

NOTE: If you move or rename the job files, you must also move 
and rename the associated .xpf job ticket.

Using Workflow Submission Client to reprint 

Submit only the saved PDF file to the reprint workflow. Process 
Manager automatically picks up the associated job ticket and 
applies it to all print nodes in the workflow.

Using a hot folder to reprint

You must submit the saved PDF file and the associated .xpf file to 
the reprint workflow. The files are dropped into the Waiting for 
Job Ticket folder inside the hot folder. Process Manager applies 
the saved job ticket to all print nodes in the workflow.
NOTE: When reprinting with Workflow Submission Client or a hot 
folder, if “Always use these settings” is checked in the Print node, 
the Print node settings take precedence over the .xpf job ticket.
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Limitations for Save 

• You cannot create collections or folders during save 
operations. These must be set up in advance.

• For Process Manager to pick up the associated .xpf job tickets, 
the tickets must be in the same directory as the files to be 
processed, and must follow the appropriate naming 
convention. If you move or rename the job files, you must 
move and rename the associated .xpf ticket as well.

Fault handling for Save

Errors are logged in the Windows Event log and display in the Job 
Manager status display area. The following errors cause the save 
operation to fail: 
• If the input PDF file is missing.
• If the destination PDF is locked and cannot be overwritten, or if 

the user lacks sufficient security privileges to access the 
destination directory or document repository.

• If the destination directory or document repository has been 
deleted.

• If invalid credentials have been set up, or no credentials have 
been established.
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Configuring JDF Export settings

Job Definition Format (JDF) is a universal job ticket format. JDF 
capabilities enable Process Manager to use existing JDF job 
tickets and to create new JDF job tickets. 
JDF job tickets are submitted via a hot folder. The hot folder is 
monitored by the Process Manager application, which looks for 
JDF tickets and submits them to the workflow.

To configure JDF Export settings

JDF Export settings allow you to designate a JDF Export file 
destination. The filename cannot exceed 80 characters, and the 
directory path cannot exceed 160 characters. 
The output file of a JDF export task can be reimported and rerun 
by dropping it into a hot folder associated with an appropriate 
workflow. The files associated with the JDF must be in the same 
location as the original job.
1. To access the JDF Export Settings dialog, double-click the 

JDF Export step in a workflow.
2. In the Export Options section, select from the following:

• [Export the Process Manager workflow job as a new 
JDF] to export the supported workflow nodes as JDF.

• [Export the JDF submitted with any modifications 
made by external processes] to export the submitted 
JDF. If external processes are present in the workflow, the 
exported JDF will contain the changes made by the 
external process nodes. For more information, see About 
JDF Export options.

3. Select one of the following:
• [Use job name as file name] to use the job name as the 

exported JDF file name.
• [Use the following as file name] to specify a file name. In 

the File name text box, type the name.
NOTE: If incorrect file characters (for example, \ / : * ? < >) are 
entered, an error message displays.
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4. Select from the following:
NOTE 1: You might be prompted for a login and password if you 
attempt to access a mapped location.
NOTE 2: Prior to perfoming operations that require repository 
access, you must set up and save your repository credentials in 
FreeFlow Process Manager. For more information, see Setting up 
repository credentials.

• [Browse Windows...] to open the Windows file dialog for 
selecting a folder location. 

• [Browse Repository...] to open a repository dialog for 
selecting a repository location. 

The Location text box is populated with the path specified 
during the browse process.

5. Select [Always use these settings] to prevent users from 
modifying the settings. The settings will appear in the 
Submission Client controls, but will be grayed out and 
unchangeable.

6. Select [OK] to accept the changes and close the window.

See also:
About JDF Export options
Fault handling for JDF Export
Limitations when creating JDF Tickets in Adobe Acrobat 
Professional
JDF and Color Manage

About JDF Export options

If you export the workflow JDF by selecting [Export the Process 
Manager workflow job as a new JDF] the JDF Export node 
functions as it always has.
If you submit a JDF file to a workflow that contains a JDF Export 
node:
• If the job does not encounter an External Process node, the 

JDF Export node exports a copy of the submitted JDF file.
• If the job encounters an External Process node, and you select 

the option to send the JDF and an XML file by selecting 
[Export the JDF submitted with any modifications made 
by external processes], the JDF Export node exports a copy 
of the JDF file returned by the External Process node.
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• If the job encounters an External Process node, and you do 
not select the option to send the JDF and an XML by selecting 
[Export the Process Manager workflow job as a new JDF], 
the JDF Export node exports a copy of the submitted JDF file.

• If you select to export the submitted JDF file and a JDF file 
was not submitted to the workflow, the JDF Export node will 
fail.

• In all cases that a JDF file is exported, the exported JDF file is 
updated to reference the PDF file being exported.

Fault handling for JDF Export

Errors are logged in the Windows Event log and display in the Job 
Manager status display area. The following errors cause the 
export operation to fail:
• If the destination specified during JDF Export is missing or 

invalid.
• If the user lacks sufficient security privileges to create the 

specified files in the destination directory specified during JDF 
Export.

• If the workflow contains a non-supported task.
• If the workflow does not contain all the tasks it needs.
• If the JDF file is missing the original file paths.

JDF and Color Manage

When submitting a JDF ticket to a workflow, only the color profile 
being used by the JDF ticket is visible in the Color settings in the 
Optimize node. Normally, when submitting jobs, all default options 
— the set of installed CMYK color profiles, and the srgb color 
space profile.icm — are visible.
NOTE 1: To enable color management, the Optimize node 
settings should be set as follows: in the General tab, de-select the 
check box for “Create a document that complies with PDF/X 
standards.” In the Color tab, in the “Change all colors in 
document” drop box, select “Manage Color profiles.” 
NOTE 2: When the JDF ticket specifies a color profile, the color 
profile must be installed on the Process Manager Server or the job 
will fail.
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Limitations when creating JDF Tickets in Adobe Acrobat Professional

To create a JDF ticket in Adobe Acrobat Professional for 
submission to FreeFlow Process Manager, for the JDF ticket to be 
handled properly, you must specify the number of pages in the 
document or the pages in the range.

To specify the number of pages

1. Select [Start: Programs: Adobe Acrobat Professional].
2. In Adobe Acrobat Professional, select [Tools: Print 

Production: JDF Job Definitions...].
3. Select [New]
4. In the Create New Job Definition dialog, browse to the desired 

selection and select [Save]. The file path displays in the 
Filename text box. 

5. Select [Create and Edit].
6. In the Edit JDF Job Definitions dialog, select [Add Section]. 
7. In the Number of Pages section, enter the appropriate value. 
8. Select [OK]. 
9. Close the dialog.
10. Exit Adobe Acrobat Professional.

To specify the pages in the range

1. Select [Start: Programs: Adobe Acrobat Professional].
2. In Adobe Acrobat Professional, select [Tools: Print 

Production: JDF Job Definitions...].
3. Select [New].
4. In the Create New Job Definition dialog, browse to a selection 

and select [Save]. The file path displays in the Filename text 
box. 

5. Select [Create and Edit].
6. In the Edit JDF Job Definitions dialog, select [Add Section].
7. Select [Add File]. 
8. In the Pages to Pages to use in Document section, enter a 

value for Pages in the Range. 
9. Select [OK]. 
10. Close the dialog.
11. Exit Adobe Acrobat Professional.
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Creating conditional branches

Conditional branching provides an added level of logic to a 
workflow, allowing it to examine the properties of submitted jobs, 
and then act accordingly without human intervention.
You can add one or more conditional branches to a workflow, 
each with one or more user-designated conditions that specify the 
desired attributes or properties of the submitted jobs.
During execution, the condition(s) of each branch are compared 
with the information retrieved from the job. The first branch whose 
conditions or specifications “match” the properties retrieved from 
the job will be taken.  
Each Conditional node can include up to 12 branches; each 
branch can include up to 12 conditions that must be satisfied.
You can specify two main categories of conditions: 
• PDF-related conditions
• JDF ticket-related conditions
For more information about these conditions, see the Conditions 
to Add table.
The branches of a Conditional node can be merged into a 
common workflow. For more information, see Linking conditional 
branches.
Conditional branching provides an alternative to using Preflight as 
a means to filter and route jobs. For more information, see Using 
preflight as a filter.

See also:
Guidelines for successful conditional branching
Adding and configuring branch conditions
Conditional branch conditions
Managing conditional branches
Editing conditional branches
Deleting conditional branches
Linking conditional branches
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Guidelines for successful conditional branching

Number of branches and conditions: A Conditional node is 
limited to 12 outbound branches. Each branch can have up to 12 
conditions.
Nested branching: Nesting occurs when a Conditional node 
directly follows a branch of another Conditional node. You can 
have up to two nested Conditional nodes. 
Execution sequence: Branches are checked from the top branch 
to the bottom. The top branch conditions are checked first. If the 
conditions are satisfied, the top branch is taken. Otherwise, the 
second branch is checked, and so on. Branch order is defined in 
the Conditional Branch Settings dialog.
Number of documents per job: Single document jobs can be 
processed by the Conditional Branching node. Multiple document 
jobs can be processed only if a Join node precedes the conditional 
branch.
Fail branches: A Fail branch can be added to Conditional node. 
The Fail branch is not considered part of the Conditional Branch 
and is not displayed in the Conditional Branch Settings dialog.
JDF Export: Workflows with a Conditional Branch do not support 
JDF Export.
Conditions from more than one category: Different categories 
can be combined in one branch. For example, a branch can 
contain both PDF and JDF conditions.
Modifying conditional branches in Workflow Submission 
Client:  You can add or remove conditions for a Conditional 
branch. You cannot do the following:
• Add or remove branches.
• Rearrange the order of the branches. 
• Change branch names. 
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Failed status: A job will fail if:
• None of the conditional branches match the job and there is no 

pass-through branch.
• The file is corrupted.
• If the necessary information is not available to evaluate a 

condition. For example, if a PDF file is submitted to a branch 
with a PDF bleedbox condition and bleedbox is not defined in 
the PDF file, the job will fail.

See also:
Creating conditional branches
Adding and configuring branch conditions
Conditional branch conditions
Managing conditional branches
Editing conditional branches
Deleting conditional branches
Linking conditional branches
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 Adding and configuring branch conditions

You can place a Conditional process anywhere in a workflow that 
a decision must be made. Node configuration is perforned via the 
Branch Conditions [Branch Name] dialog, where you add 
branches and define or edit their conditions. Twelve branches are 
allowed per Conditional node, 12 conditions are allowed per 
Conditional branch.

To add and configure branch conditions

1. In Workflow Builder, drag and drop a Conditional process into 
the workflow. The Conditional Branch Settings dialog 
automatically opens. 

2. Select [New Branch...].
3. In the Branch Conditions dialog, enter a name in the Branch 

name text box. The name display in the dialog title later, when 
you open the dialog to view or edit conditions.
The options in the “This branch will only accept” area ensure 
that only the desired file types are examined by the branch. 
For example, if you select [PDF format files] and you submit a 
.doc file to the workflow, the system does not attempt to apply 
PDF-only conditions to the file. The branch is skipped; no 
errors are generated.

4. In the “This branch will only accept” area, select from the 
following:
• [PDF format files]: To enable the addition of PDF 

conditions.
• [Documents submitted with JDF job tickets]: To enable 

the branch to accept only files submitted with JDF job 
tickets and to enable the addition of JDF-specific 
conditions.

• Select both options. 
• Select neither option.
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5. In the “Conditions that must be met” drop box, select from the 
following:
• [Any]: To establish that one or more conditions must be 

met for the branch to be considered a match.
• [All]: To establish that all conditions must be met for the 

branch to be considered a match.
6. In the “Conditions to add” area, select a condition.
NOTE: Refer to the Conditions to Add table for a description of the 
conditions and their qualifiers. Qualifiers vary based on the 
selected condition, for example, “PDF format files.” 

7. Select the desired qualifiers for the condition. 
8. Enter text, if required.
9. After all fields are configured, select [Add] to add the condition 

and display it in the Conditions List. 
10. If required, select a condition, and then select [Delete] to 

remove the condition from the Conditions List. 
11. Add more conditions, if desired, up to 12 per branch.
12. Select [OK]. The Conditional Branch Settings dialog displays. 
13. To change the branch order or otherwise manage the existing 

branches, see Managing conditional branches.
14. Select [OK]. A new branch displays in the workflow next to the 

Conditional node.
NOTE: A workflow process must follow a conditional branch or the 
workflow cannot be saved. 

See also:
Creating conditional branches
Conditional branch conditions
Condition Definitions
Managing conditional branches
Editing conditional branches
Deleting conditional branches
Linking conditional branches
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Conditional branch conditions

* For more information, see Condition Definitions

Table 2-15. Conditions to Add

Available For Condition 1st Qualifier 2nd Qualifier

PDF Only Number of Impressions*
Number of Pages
Mediabox Width
Mediabox Height
Trimbox Width
Trimbox Height
Bleedbox Height
Bleedbox Width
Artbox Height
Artbox Width
Cropbox Height
Cropbox Width
Maximum Bleed Size*

Equal to
Not equal to
Less than or equal to
Greater than

Make a numeric 
selection

Author
Title
Subject
Keyword
Creator
Producer

Contains
Does not contain
Starts with
Ends with
Is equal to

Enter text

Color or B&W All B&W
Containing any grayscale 
or color images

None

First Page Orientation Portrait
Landscape

None

All Page Orientations Same
All Page Sizes Equal

Yes
No

JDF Job 
Ticket Only

Customer Billing Code
Customer ID
Customer Job Name
Customer Order ID

Contains
Does not contain
Starts with
Ends with
Is equal to

Enter text

Always Job name 
File Extension

Contains
Does not contain
Starts with
Ends with
Is equal to

Enter text

Number of Copies* 
 

Equal to
Not equal to
Less than or equal to
Greater than

Make a numeric 
selection
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Condition Definitions

For a list of available conditions and their qualifiers, see 
Conditions to Add.

Number of copies

The value that a Conditional Branching node uses for the “number 
of copies” condition is the copy count value associated with the job 
at the time of Conditional branching execution. Regardless of how 
a job was submitted (through submission client, Hot Folder, 
Manifest), if there is a copy count value associated with the job, 
that is the value that the Conditional Branching node will use at 
execution time for the number of copies condition.
A copy count value is associated with a job through the following 
ways:
• If an XPIF ticket was submitted with the Job (for example as 

part of an RDO) and it has a copy count value, that value will 
be considered the Job copy count value.

• If a JDF ticket was submitted with the job and it has a copy 
count value, that value will be considered the Job copy count 
value.

• If the user sets a value for the “Quantity” attribute in FreeFlow 
Process Manager MAX, Manifest Automation from Xerox, that 
value is considered the Job copy count value.

• If the user sets a copy count value during Review in Job 
Manager, that value is considered the Job Copy count value 
from that point on.

• If “Imposition affects copy count switch” is set in the WorkFlow 
Builder, and the copy count value has been modified by 
Imposition, once the job reaches the Conditional branching 
node, the modified value is considered the Job copy count 
value for Conditional Branching. For more information, see To 
enable the Copy Count Divisor and Copy Count Divisor 
examples.

If the job has no associated copy count value, Conditional 
branching fails when it examines the number of copies condition.  
A message saying “no copy count value is available” message 
displays.
NOTE: Printer copy count value is not the same as Job copy 
count value. The “number of copies” condition of Conditional 
branching works independently of the Print nodes in a workflow 
and the copy count values, if any, set during workflow design.
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Number of impressions

This is the number of copies multiplied by number of pages in PDF 
file.

Maximum bleed size

If a Trim Box and a Bleed Box are defined, and the Trim Box is 
contained within the Bleed Box, then the Bleed size is the four 
offsets from the four sides of the Bleed Box to the four sides of the 
Trim Box, and the Maximum Bleed size is the greatest of the four.
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Managing conditional branches

The Conditional Branch Settings [Name] dialog allows you to:
• View and manage existing branches for the selected 

Conditional node. 
• Access the Branch Conditions dialog to create and configure 

new conditional branches.

To manage a conditional branch

1. In Workflow Builder, double-click a Conditional process in the 
workflow to open the Conditional Branch Settings dialog. 

2. Select a workflow branch.
3. Select from the following options to view, manage, and create 

conditional branches:
• Conditional Set Description pane: Lists the conditions 

that must be met for the selected workflow branch.
• Up arrow: Moves the selected workflow branch up one 

level of order.
• Down arrow: Moves the selected workflow branch down 

one level of order.
NOTE: Branches are processed from top to bottom. The first 
branch conditions are checked and, if met, the branch is taken. 
If not met, the next branch is checked, and so on.

• View/Edit...: Opens the Branch Conditions dialog for the 
selected workflow branch. See Adding and configuring 
branch conditions.

• Delete: Removes the selected workflow branch with a 
confirmation dialog.
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• Include pass-through branch with no conditions: 
Active if 11 or fewer branches are defined. Adds a branch 
to the workflow branch list called “pass-through.” This 
branch is not selectable in the list and has no conditions 
associated with it. It accepts all documents that could not 
be passed to prior order branches. Unmark the check-box 
to delete the pass-through branch.

NOTE: The system automatically sequences the pass-through 
branch as the last branch.

• New Branch…: Opens the Branch Conditions dialog for 
creating a new branch.  See Adding and configuring 
branch conditions.

See also:
Creating conditional branches
Adding and configuring branch conditions
Conditional branch conditions
Editing conditional branches
Deleting conditional branches
Linking conditional branches
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Editing conditional branches

You may wish to view and/or edit a conditional branch.

To edit a conditional branch

1. In Workflow Builder, double-click a Conditional node in a 
workflow. 

2. In the Conditional Branch Settings dialog, select the desired 
workflow branch from the list, and then select [View/Edit...].

3. In the Branch Conditions [Name] dialog, make the desired 
edits. See Adding and configuring branch conditions.

4. Select [OK]. 
5. In the Conditional Branch Settings dialog, make any additional 

changes. See Managing conditional branches.
6. Select [OK].

See also:
Creating conditional branches
Adding and configuring branch conditions
Conditional branch conditions
Managing conditional branches
Deleting conditional branches
Linking conditional branches
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Deleting conditional branches

You may wish to remove a conditional branch.

To delete a conditional branch

1. In Workflow Builder, double-click a Conditional node in a 
workflow. 

2. In the Conditional Branch Settings dialog, select the desired 
workflow branch from the list.

3. Select [Delete]. 
4. In the Delete confirmation dialog, select [Yes].
5. Select [OK].
6. To delete a pass-through branch, unmark the check-box for 

“Include pass-through branch with no conditions.

See also:
Creating conditional branches
Adding and configuring branch conditions
Conditional branch conditions
Managing conditional branches
Editing conditional branches
Linking conditional branches



FreeFlow Process Manager Operator and Administrator  Guide 2-135

Workf low Bui lder

Linking conditional branches 

The branches of a Conditional node can be merged into a 
common workflow once they have been processed. Follow these 
rules: 
• If a link is used, all of the branches of a Conditional node must  

merge.
• The branches of one conditional node cannot merge with 

branches of another Conditional node.

To link conditional branches

1. Right-click the Conditional node to which you wish to add a 
link.

2. Select [Create Common Links]. Links display at the end of 
the branches for that node. Another link displays beneath the 
first workflow, creating a common workflow.

3. Drag and drop the necessary workflow processes into the 
common workflow to continue processing the job.

See also:
Creating conditional branches
Adding and configuring branch conditions
Conditional branch conditions
Managing conditional branches
Editing conditional branches
Deleting conditional branches
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Configuring external process settings 

Process Manager allows you to configure up to 5 external 
processes, from any third party software that supports hot folders, 
to use as process options in Workflow Builder. First, set up the 
profiles for each external process in Workflow Job Manager. Then, 
in Workflow Builder, use the [Process Name] Settings dialog to: 
• Designate from which profiles users can select.
• Select the default profile.
External Processes are indicated either by a plus symbol and a 
curved arrow or, if the user chooses an existing process icon, by a 
plus symbol overlay. 

To configure external process settings

1. Double-click an external process in a workflow to access the 
[Process Name] Settings dialog. 

2. In the “Select the profiles that submitters can choose from” text 
box, select the desired profiles. The profiles will populate the 
“Select the default profile” drop box.

3. In the “Select the default profile” drop box, select a default 
profile.

4. Select [Always use these settings] to prevent users from 
modifying the settings. The settings will appear in the 
Workflow Submission Client controls, but will be grayed out 
and unchangeable. 

5. Select [OK] to accept changes and close the window.
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Setting up repository credentials

Repository credentials are used in all transactions that require 
logging into a repository in FreeFlow Process Manager. This 
includes:
• [Add Repository File] in Workflow Submission Client.
• [Browse Repository...] in the Save and JDF export nodes.
• Hot folders When you create a hot folder, you must specify 

the “Submitting user” whose repository credentials are 
associated with the hot folder: either a member of the Process 
Manager Administrator group or a member of the Operators 
group. This informs the system whose repository credentials to 
use when a job must access a repository during hot folder 
submission. 

• Resubmit operation in Workflow Job Manager. 
Prior to performing operations that require repository access, you 
must set up and save your repository credentials in FreeFlow 
Process Manager. Credentials are set up and saved per user. 
Once a user has RMS credentials saved, all future repository 
transactions by that user through the Workflow Builder, Workflow 
Submission Client, or Workflow Job Manager use the same saved 
RMS credentials.
Before setting up repository credentials in FreeFlow Process 
Manager, you must have previously:
• Set up an account on the repository.
• Set up a link between the desired repository and FreeFlow 

Process Manager via the FreeFlow Administration Tool.

See also:
Ensuring success with repository credentials
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To set up repository credentials

1. In Workflow Builder, Workflow Submission Client, or Workflow 
Job Manager, select [Options: Repository Credentials 
Setup...] to open the Repository Credentials Setup dialog.

2. Enter the following repository account credentials:
• User name
• Password

3. Re-enter the password to confirm it.
4. Select [Save]. The credentials are saved and you are not 

prompted for them again. To change repository credentials, 
you must open the repository credentials dialog, as described 
in step 1.

Ensuring success with repository credentials

The following examples illustrate the importance of setting up  
repository credentials before submitting jobs.
• If you do not enter repository credentials, upon clicking [Add 

Repository File] in Workflow Submission Client or [Browse 
Repository] in the Save or JDF Export settings dialogs, the 
Repository Credentials Setup dialog automatically displays.

• If a logged in user, without saved repository credentials, 
submits a job via Workflow Submission Client to a workflow 
with a Save or JDF Export node, the job will fail during the 
Save or JDF Export operation, if those nodes interact with the 
repository.

• During the resubmit operation in Workflow Job Manager, if 
there is interaction with a repository, the RMS credentials of 
the current user (the user running Workflow Job Manager) are 
used. If the current user of Workflow Job Manager does not 
have proper RMS credentials saved, the job will fail during 
resubmit.

• For Hot Folder job submission, if the submitting user selected 
during Hot Folder setup does not have RMS credentials 
saved, and the job needs to interact with Repository, the job 
will fail.
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Checking the status of a process 

The Processes dialog lists information about each process, 
including: 
• Name
• Status
• Concurrent count 
Take Offline/Set Online: Allows you to change the offline or 
online status of a selected process; pauses jobs that reach the 
process. Available if no jobs are using the process. The option 
displays as a context menu option when you right-click a process.
Settings: Opens the Process Settings dialog.

To change the offline or online status of a process

1. In Workflow Builder, select [Options: Processes] to display 
the Processes dialog.

2. Select a process and select [Take Offline/Set Online] to 
change the status.   

3. Close the Processes dialog.

See also:
Setting the number of concurrent processes and the copy count 
divisor
To set the number of concurrent processes
To enable the Copy Count Divisor
Copy Count Divisor examples
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 Setting the number of concurrent processes and the copy count divisor

The Process Settings for the [Process] dialog allows you to: 
• Select the number of concurrent processes. This sets the 

number of instances of a process that can be used to 
concurrently process jobs. 

• Place the process online or offline. 
• Turn the copy count divisor functionality on or off, available for 

Imposition only.

To set the number of concurrent processes

1. In Workflow Builder, select [Options: Processes] to display 
the Processes dialog. 

2. Select a process, then select [Settings] to open the Process 
Settings for [Process] dialog.

3. Select the number of concurrent processes, from 1-4.
4. As appropriate, select or deselect the check box to place the 

process online. 
5. Select [OK] to accept the changes and close the Process 

Settings for [Process] dialog.
6. Close the Processes dialog.

See also:
To enable the Copy Count Divisor
Copy Count Divisor examples
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To enable the Copy Count Divisor

You can enable the system to adjust the copy count to maintain 
the original quantity intent for workflows that contain multiple-up 
impositions. The value is changed to output the original quantity of 
the original document given that the imposition node has changed 
the PDF document to contain multiple instances of the original 
document.
In the Job Manager Copy Count and the Print node Job Setup 
dialogs, the quantity value is modified when you:
• Process the job through a Xerox imposition node (not PREPS) 

that is multi-up repeated. 
• Enable the Copy Count Divisor switch.
• Submit a job with a job ticket quantity intent.
• Use  Print nodes that do not have “Always use these settings” 

selected.
Example: If the original document is 1 page, the original quantity 
is 100 copies, and the imposition is 4-up repeated, then the post 
imposition copy count quantity will be 25, since each copy of the 
imposed document now contains 4 copies of the original 
document.
If there is a JDF Export node in the workflow, the JDF ticket 
created through the JDF export node does not include the 
modified copy count.

See also:
Copy Count Divisor examples
1. In Workflow Builder, select [Options: Processes] to display 

the Processes dialog. 
2. Select the Impose process, then select [Settings] to open the 

Impose Process Settings dialog.
3. Mark the check box for [Imposition affects copy count].
4. As appropriate, select or deselect the check box to place the 

process online. 
5. Select [OK] to accept the changes and close the Process 

Settings for [Process] dialog.
6. Close the Processes dialog.
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Copy Count Divisor examples

The following examples illustrate various uses of the Copy Count 
Divisor:

Example 1: Original quantity is 20 with 2-up;  actual 
copies =10

1. The user sets the Copy Count Divisor switch to On.
2. The user creates a workflow with the following nodes:

• Imposition (2up; Always use these settings is set); 
• Print (Always use these settings is not set)

3. User submits a job with an XPIF ticket: Copies: 20
4. The job successfully goes through the Imposition node.
5. The job  prints 10 actual copies of the imposed document.

Example 2: Original quantity is 20 with 2-up + 2-up; 
actual copies = 5

1. The user sets the Copy Count Divisor switch to On.
2. The user creates a workflow with the following nodes:

• Imposition (2up; Always use these settings is set) 
• Imposition (2up; Always use these settings is set) 
• Print (Always use these settings is not set)

3. User submits a job with an XPIF ticket: Copies: 20
4. The job successfully goes through the two Imposition nodes.
5. The job prints 5 actual copies of the imposed document.

Example 3: Original quantity is 20 with 2-up; observe 
changes to Print quantity settings

1. The user sets the Copy Count Divisor switch to On.
2. The user creates a workflow with the following nodes:

• Review
• Imposition (2up; Always use these settings is set) 
• Review 
• Print (Always use these settings is not set)

3. User submits a job with an XPIF ticket: Copies: 20
4. At the first Review the user opens the Copy Count Dialog. 

They will see: Quantity (original document):20
5. At the first Review the user looks at the Print task setting. They 

will see: Quantity: 20
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6. After the job passes successfully through the Imposition node, 
the user opens the Copy Count dialog at the second Review. 
They see:
• Quantity (original document): 20
• Quantity (imposed document): 10

7. At the second Review the user looks at the Print task setting. 
They see: Quantity: 10

8. The job prints 10 actual copies of the imposed document.

Example 4: Original quantity is 20 with 2-up + 2-up; 
quantity modifed after first Imposition; actual copies = 6

1. The user sets the Copy Count Divisor switch to On.
2. User creates a workflow with the following nodes:

• Imposition (2up; Always use these settings is set) 
• Review
• Imposition (2up; Always use these settings is set)
• Review 
• Print (Always use these settings is not set)

3. User submits a job with an XPIF ticket: Copies=20
4. After successful execution of the first Imposition, at the first 

Review, the user opens the Copy Count Dialog. The user 
sees: 
• Quantity (original document): 20 
• Quantity (imposed document): 10

5. The User modifies the Quantity (imposed document) value in 
the Copy Count Dialog to 12: 
• Quantity (original document): 20
• Quantity (imposed document): 12

6. After successful execution of the second Imposition, at the 
second Review, the user opens the Copy Count Dialog. They 
see: Quantity (original document): 20

7. Quantity (imposed document): 6. Since the user modified this 
value at the first Review, the second Imposition node takes the 
modified value and applies the copy count divisor logic.

8. The job prints 6 actual copies of the imposed document.
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Example 5: Modified quantity ignored/overwritten

1. The user sets the Copy Count Divisor switch to On.
2. User creates a workflow with these nodes:

• Review 
• Imposition (2up; Always use these settings is set) 
• Print (Always use these settings is not set)

3. User submits a job with an XPIF ticket: Copies: 20
4. At the Review node the user brings up the Copy Count dialog. 

They will see: Quantity: 20
5. The user closes the Copy Count Dialog and opens the Print 

task setting. 
6. The user sets the Quantity value in Print task setting to 18, 

closes the dialog and continues executing the job.
7. The job successfully executes the Imposition node.
8. The job prints 10 actual copies of the imposed document. 

The Quantity value entered at the Print task setting was 
ignored and overwritten once the job went through the 
Imposition node. When the divisor logic switch is on and there 
are imposition(s) nodes in the workflow, if the user wants to 
modify the quantity of the imposed document during the 
Review task of Job Manager, they should do it through the 
Copy Count dialog to ensure that the value will not be ignored 
and overwritten.
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Checking the status of a workflow

The Workflows dialog provides the following information about the 
listed workflows: 
Hot Folders button: Opens the Hot Folders dialog.
Name: Lists the names of workflows.
Workflow Id: Lists the system-generated workflow Id.
Status: Lists the following status of the workflows: 
• Enabled - Busy
• Enabled 
• Disabled - Busy 
• Disabled 
Active Jobs: Lists the number of active jobs.
Hot Folders: Lists the number of hot folders associated with the 
selected workflow.
Description: Lists the description text for the workflows.
Processes: Displays the small icon processes for the workflows.
NOTE 1: You can double-click a workflow to open the Hot Folder 
Setup dialog.

NOTE 2: You can right-click in the window to display the context 
menu.
Status text (bottom of screen): Lists the total number of 
workflows.

To check the status of a workflow

1. In Workflow Builder, select [Options: Workflows]. 
2. View the information about the desired workflow. 
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About hot folders

The hot folder function allows you to designate one or more 
folders on your system to be monitored, at set intervals, by the 
Process Manager application. When a file is detected in a hot 
folder, it is automatically submitted to the workflow associated with 
that hot folder. 

See Also: 
Hot folders and Join
Hot folders and RDOs
Hot folders and linked RDOs
Limitations for hot folder submission of RDOs and job files 
associated with .xpf or .xml files
Hot folders and Zip files
Hot folders and JDF
Hot folders and error checking
Hot folders: supported files
Hot folders on mapped or shared drives and resources
Hot Folder submission with and without the Unlimited User 
Conversion License
Limitations when setting up directories as input/output hot folders 
for more than one feature
Managing hot folders
Hot folders and read-only files

Hot folders and Join

To process multiple files as a single joined file, you can:
• Use a Zip file to submit the jobs to a hot folder.
• Submit an .xml workflow with a folder to a dynamic workflow. 
• Submit an .xml workflow with a Zip file to a dynamic workflow.
If you do not use these methods to submit multiple files to a hot 
folder, each file is processed as a separate job, even if the 
associated workflow contains a Join task. 

See also:
Hot folders and Zip files
Submitting .xml workflow files to a hot folder
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Hot folders and RDOs

Use File Manager, Document Library, Makeready, or Web 
Services to copy or move RDO documents into a hot folder, 
otherwise, the RDO may be corrupted. The hot folder checks 
RDOs for readiness to ensure that both the RDO and .CON 
directory are present. If the RDO is not ready, it is checked at the 
next interval.

Hot folders and linked RDOs

Successful submission of linked RDOs (an RDO containing a link 
to another RDO) and set labeling RDOs via Workflow Submission 
Client or hot folders cannot be assured.

Limitations for hot folder submission of RDOs and job files 
associated with .xpf or .xml files

To ensure better processing, when submitting RDOs to a hot 
folder, the user should ensure that all contents inside the .CON 
are copied over, before copying the RDO file. 
When submitting subdirectories that contain job files associated 
with either .xpf files or .xml files, the user should copy the 
directories first, and wait until the files are copied -- if there are 
RDOs inside the subdirectory, make sure that they are copied 
over, as well -- before dropping the .xpf or .xml file into the hot 
folder.
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Hot folders and Zip files

A hot folder can unzip a Zip file containing multiple PDFs or mixed 
file formats.
To process multiple files as a single joined job: Submit the Zip 
file to a hot folder associated with a workflow that has a Join task. 
Files are joined in the order they were added to the Zip file.
Hot folders can process Zip files that contain all supported file 
types. 
Hot folders support the following Zip file formats:
• Microsoft Windows Compressed (zipped) files packaged with 

Windows Server 2003
• WinZip 7.0 and 8.0 zipped files
Hot folders do not support:
• Folders inside a Zip file, except for .CON directories when a 

matching .rdo is present. Folders inside the Zip file are 
unzipped but are not submitted.

• Nested Zip files (a Zip file within a Zip file)
• Files for which, when unzipped, there is not enough room on 

the drive. If problems occur, the file is moved to the error 
folder.
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The following limitations apply to InfoZip files: 

Table 2-16. InfoZip file limitations

Item Limit

Number of files 64 K

Uncompressed 
size of a single 
file

4 GB

Compressed size 
of a single file

4 GB

Total size of 
archive

256 TB

Maximum path/
filename length 
(characters)

DOS: 256 
Unix: 1024
CD-ROM 8 level sub directory; 
depending on the type of file system
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Hot folders and JDF

Job Definition Format (JDF) job tickets can be submitted only via a 
hot folder. JDF is a universal job ticket format. JDF capabilities 
enable Process Manager to use existing JDF job tickets and to 
create new JDF job tickets. The JDF job ticket is created with a 
third party submission tool. 
The following workflow processes support JDF:
• Optimize
• Convert
• Join
• Print
• Impose
The workflow processes currently support two types of JDF Intent: 
• Business card
• Saddle stitch
NOTE: If a JDF ticket does not contain the correct file path to the 
job that is being processed, the job fails.

JDF files take precedence over other files types; they are 
processed first. 

Hot folders and error checking

Non-supported file types are moved to an Unsupported Files 
folder within the hot folder. It is the user’s responsibility to 
manually delete these files from the folder. 

Hot folders: supported files 

The hot folder supports the same files that are supported through 
the Workflow Submission Client: Adobe Illustrator CS, Adobe 
InDesign CS, Adobe Photoshop (currently supported version), 
Bitmap, JPG, JPEG, Microsoft Office 2007, Microsoft Publisher  
(Excel, PowerPoint, and Word), PDF, RDO,TIFF, TIFF-IT, VPC, 
QXD, EPS and PS.

Hot folders and read-only files

Read-only files are not picked up by the hot folder.



FreeFlow Process Manager Operator and Administrator  Guide 2-151

Workf low Bui lder

Hot folders on mapped or shared drives and resources

To work properly, full access for the hot folder must be granted to 
XDL_ADMIN, particularly if the hot folder is on a mapped drive. 
XDL_ADMIN passwords must match client and server.

Hot Folder submission with and without the Unlimited User 
Conversion License

If you do not have the Unlimited User Conversion or the 100 User 
license, and you are submitting an image file via a hot folder: 
• The file attachment is sent as high resolution and can be 

viewed, but not printed or edited. 
• For saved/encrypted files from FreeFlow 5.0, PDF encryption 

is removed when you save via a Save or JDF export node, or 
when you view the PDF via the Review node.

See also:
Unlimited User Conversion option
Setting up a watermark in an email attachment

Limitations when setting up directories as input/output hot 
folders for more than one feature

Within Process Manager, users can set up directories as input/
output hot folders for Process Manager Hot Folders (for job 
submission), QuarkXPress file conversion, and Third party 
external processes. When setting up a directory as an input or 
output hot folder, make sure that it is not being used as a hot 
folder for either of the other two features, by visiting their 
corresponding dialogs.
The system does not currently perform conflict checking across 
these different features.
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Managing hot folders

The Hot Folders dialog allows you to manage existing hot folders, 
or to access dialogs to set up new hot folders and modify existing 
hot folders. 
It lists the hot folder name, the workflow associated with the hot 
folder, the full file location path for the hot folder, the assigned 
submitter’s name, the clustering number of files before submission 
and the scheduled times of day to activate. 
NOTE: Only one workflow can be associated with a hot folder. 
However, several hot folders can be associated with the same 
workflow. 

The Hot Folders dialog options include:
New: Opens the New Hot Folder dialog.
Modify: Opens the Hot Folder dialog for the selected hot folder.
Delete: Deletes the selected hot folder. Also available as a 
context menu by right-clicking an item listed in the Hot Folders 
window.
Pause: When selected, the hot folder mechanism processes all 
files currently in the selected hot folder. It stops scanning for new 
files after all current files are processed. The button toggles 
between the pause and resume states.
Resume: When selected, the hot folder mechanism resumes 
monitoring the selected hot folder at the defined interval. The 
button toggles between the pause and resume states.
Settings...: Opens the Hot Folder System Settings dialog.
Stop/Start: Allows you to stop/start the hot folder services, 
effectively pausing/resuming all hot folders at once.
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Status line: (bottom of screen) Lists the total number of hot 
folders, the Processing or Paused status, and the monitoring 
interval.

See also:
About hot folders
Setting up or modifying a hot folder
Deleting a hot folder
Pausing and resuming hot folder monitoring
Configuring the hot folder system settings
Submitting a job to a hot folder
Submitting an RDO to a hot folder
Submitting a job ticket file (*.xpf) to a hot folder for reprinting
Submitting .xml workflow files to a hot folder
Submitting .vpc files to a hot folder

To manage hot folders

You can use the Hot Folders dialog to manage hot folders 
independently of workflows.
1. Select [Options: Hot Folders], or right-click a workflow listed 

in the Workflows dialog.
2. Perform the necessary actions.
3. Close the Hot Folders dialog.
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 Setting up or modifying a hot folder

The New Hot Folder or Hot Folder (for modifying a hot folder)  
dialogs contain the following options: 
Hot folder location: Lists the full file location path for the hot 
folder associated with the selected workflow.
Browse: Opens a common browse folder dialog and allows you to 
select or create a folder in the system.
Target Workflow: Lists all workflows in the system. The list 
reflects the sort order of the Workflows dialog.
Submitted with documents: This option, in the Target Workflow 
drop down menu, supports the hot folder submission of .xml 
workflows that have been exported from the Workflow Builder 
application. For more information, see Submitting .xml workflow 
files to a hot folder.
Submitting User: Allows you to a specify the user whose 
repository credentials will be associated with the hot folder: either 
a member of the Process Manager Administrator group or a 
member of the Operators group. This informs the system whose 
credentials to use when a job must access a repository during hot 
folder submission.
NOTE: If the submitting user does not have saved repository 
credentials, the job will fail if attempting to access a repository 
during hot folder submission. For more information, see Setting up 
repository credentials.

The following options are available when Enable file clustering, 
Enable hot folder scheduling, and Set scheduled times for hot 
folders individually are selected in the Hot Folder System 
Settings dialog:
Enable file clustering for this hot folder: Enables the system to 
wait until the specified number of files are placed in the hot folder 
before processing them.
Number of files: Allows you to specify the minimum number of 
files before processing is initiated on the set. The default is 2; the 
maximum is 100. 
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Enable scheduling for this hot folder: Enables the scheduling 
functions: 
• Time of Day: Allows you to specify the times during the day 

that you want the hot folder scanned. The default is 12:00 AM.
• Add: Available if Enable scheduling for this hot folder is 

selected. Adds the selected time of day to the list. If you try to 
add a time more than once, the “Time Already Added” 
message displays. 

• Scheduled times: Available if Enable scheduling for this 
hot folder is selected. Lists the times during a day when the 
hot folder system scans the hot folder for files. A maximum of 
10 polling times can be set.
NOTE: Intervals between polling times cannot be smaller than 
the hot folder scan interval.

• Remove: Removes the select time from the list.
OK: Closes the dialog and saves the settings.
Cancel: Closes the dialog and does not save the settings.
Waiting for Job Ticket folder: Each hot folder contains a Waiting 
for Job Ticket folder. When submitting .xpf job tickets with a job 
file, both items must be placed into this folder. For more 
information, see Submitting a job ticket file (*.xpf) to a hot folder 
for reprinting.

To set up or modify a hot folder

1. In Workflow Builder, select [Options: Hot Folders]. The Hot 
Folders dialog displays.

2. Select the desired options in the Hot Folder System Settings 
dialog. See Configuring the hot folder system settings.

3. Select [New...] or [Modify..].
4. Select [Browse...].
NOTE: To work properly, full access for the hot folder must be 
granted to XDL_ADMIN, particularly, if the hot folder is located on 
a mapped drive.

5. In the Browse for Folder window, do one of the following:
• Select a folder, then select [OK]; or
• Select [Make New Folder]. Right-click the new folder and 

select [Rename] in the context menu. Type a folder name, 
and then select [OK].
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6. In the Target Workflow drop down list, select a workflow. 
Ensure that the workflow contains the process steps 
necessary to support the job.

7. In the Submitting User drop down list, specify the user whose 
repository credentials will be associated with the hot folder.

8. If required, select [Enable file clustering for this hot folder] 
to enable the system to wait for the minimum number of files 
before submitting them to the hot folder. This option is 
available when Enable file clustering is selected in the Hot 
Folder System Settings dialog.
• Specify the number of files.

9. If required, select Enable scheduling for this hot folder, 
available when Enable hot folder scheduling, and Set 
scheduled times for hot folders individually are selected in 
the Hot Folder System Settings dialog.
• In the Time of Day area, highlight minutes or hours and 

click to specify the time during the day that you want the 
hot folder scanned.

• Select [Add] to display the designated  time of day on the 
Scheduled times list. A maximum of 10 scheduled times 
can be set.

• If required, in the Scheduled times area, select a time and 
select [Remove] to delete the time from the list.

10. Select [OK] to accept the changes and close the dialog.
11. Close the Hot Folders window.

See also:
Limitations when setting up directories as input/output hot folders 
for more than one feature
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Deleting a hot folder 

This option is available when a hot folder is not paused.

To delete a hot folder

1.  Workflow Builder, select [Options: Hot Folders].
2. Select a hot folder. 
3. Select [Delete], and then select [Yes] to confirm the deletion. 
4. Close the Hot Folders window.

Pausing and resuming hot folder monitoring

The hot folder monitoring function can be paused in order to 
perform any necessary actions.

To pause and resume hot folder monitoring

1. In Workflow Builder, select [Options: Hot Folders].
2. Select a hot folder from the list and select [Pause].
3. When appropriate, select [Resume].
4. Close the Hot Folders dialog.

Stopping and starting all hot folder monitoring

The hot folder monitoring function can be paused for the entire hot 
folder service in order to perform any necessary actions.

To start and stop all hot folder monitoring

1. In Workflow Builder, select [Options: Hot Folders].
2. Select [Stop].
3. When appropriate, select [Start].
4. Close the Hot Folders dialog.
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 Configuring the hot folder system settings

The Hot Folder System Settings dialog allows you to set the scan 
interval, to enable file clustering, and to select between scheduling 
all hot folders for the same times of day or scheduling hot folders 
individually. It contains the following options:
Scan Interval: Sets the time between system scans of the hot 
folders for new files. The default interval is 10 seconds. The 
available range is 10 – 100 seconds. Workflows are submitted as 
files are found, unless clustering or scheduling is enabled.
Enable file clustering:  Enables the system to wait until the 
specified number of files are placed in the hot folder before 
processing them. The number is set on a per hot folder basis. If 
selected, the scan interval is set to 10 seconds and grayed out. 
Enable hot folder scheduling: Enables the scheduling function.
NOTE: The clustering and scheduling options each have the 
ability to invoke the system to submit jobs independent of the 
other’s settings. If both clustering and scheduling are selected, 
then reaching either the clustering number of files or the 
scheduled time results in the submission of hot folder files as 
workflow jobs.  

Set scheduled times for each hot folder individually: Allows 
you to specify times on a per hot folder basis. See Setting up or 
modifying a hot folder.
Use the following scheduled times for all hot folders: Allows 
you to specify times for all hot folders. When selected, the 
following options are available:
• Time of Day: Allows you to specify the times during the day 

that you want all hot folders scanned. The default is 12:00 AM.
• Add: Adds the selected time of day to the list. If you try to add 

a time more than once, the “Time Already Added” message 
displays. 

• Scheduled times: Lists the times during a day when the hot 
folder system scans all hot folders for files. A maximum of 10 
scheduling times can be set.
NOTE: Intervals between polling times cannot be smaller than 
the hot folder scan interval.

• Remove: Available if the “Schedule daily times...” check box is 
selected and a time in the list is selected. Removes the listed 
time.

OK: Closes the dialog and saves the settings.
Cancel: Closes the dialog and does not save the settings.
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To configure the hot folder system settings

1. In Workflow Builder, select [Options: Hot Folders].
2. Select [Settings...].
3. Set the desired interval, from 10 to 100. Available if Enable 

clustering and Enable hot folder scheduling are not 
selected.

4. If required, select Enable file clustering to wait for a minimum 
number of files before processing. 

5. If required, select Enable hot folder scheduling to enable the 
scheduling function.

6. Select Set scheduled times for each hot folder individually 
to specify times that you want hot folders scanned on a per hot 
folder basis.

7. Select Use the following scheduled times for all hot 
folders to specify times for all hot folders, and then schedule 
or remove the desired scheduling times:
• Click to set the time of day and select [Add], or
• Select a time of day from the Scheduled times list and 

select [Remove].
8. Close the Hot Folder System Settings dialog and the Hot 

Folders dialog.
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Submitting a job to a hot folder

Points to remember when submitting a job to a hot folder:
• Jobs submitted with a job ticket must be placed, with the job 

ticket, into the Waiting for Job Ticket folder, inside the hot 
folder. 

• RDO files can be submitted to a hot folder via File Manager 
and Web Services.

• If a JDF ticket does not contain the correct file path for the file 
that is being processed, the job fails.

• When submitting a Zip file to a workflow with Join task, the 
files within the Zip file will be joined in the order that they were 
added to the Zip file.

• Read-only files are not picked up by a hot folder.

To submit a job to a hot folder

1. Locate the desired file using Windows Explorer. 
2. Use Windows Explorer to copy, move, paste, or drag and drop 

the file into the appropriate hot folder. The submission is 
automatically processed. 

NOTE: If you move a file into a hot folder, you will not be able to 
retrieve it. The system automatically deletes the files from the hot 
folder. Copy the file if you need to retrieve it.

See also:
Submitting an RDO to a hot folder
Submitting a job ticket file (*.xpf) to a hot folder for reprinting
Submitting .xml workflow files to a hot folder
Hot folders and Join
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Submitting an RDO to a hot folder

CAUTION: If you are submitting an RDO to a hot folder, do 
not open, copy, move, delete, or rename an RDO document 
using Windows Explorer. You will corrupt the document.

To submit an RDO to a hot folder

1. Select [Start: Programs: Xerox FreeFlow Software: File 
Manager].

NOTE: To submit files to a hot folder, you can also use legacy 
Document Library if you have a FreeFlow Process Manager 
upgrade, or you can use Web Services.

2. In File Manager, navigate to the appropriate RDO.
NOTE: In File Manager, the .CON file is not visible.

3. Right-click the file. In the context menu, select [Copy].
4. In the Copy dialog, select [To]. Type the path to the desired 

hot folder, for example, C:\Documents and 
Settings\Administrator\Desktop\RDO Hot Folder.

NOTE: To display the path to the desired hot folder, select 
[Options: Hot Folder] and locate the hot folder path.

5. Select [OK]. The file is automatically submitted to the workflow 
associated with the hot folder. 

If either the RDO or the .CON folder is missing from the hot folder, 
the file will not be processed. You must then manually delete the 
file from the hot folder.
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Submitting a job ticket file (*.xpf) to a hot folder for reprinting

You can save an .xpf job ticket file with the PDF file for reprinting 
purposes by including a Save process in a workflow and selecting 
[Save job ticket information] in the Save Settings dialog. 
For more information about creating the job ticket file, refer to the 
topic “Saving a job ticket with the PDF for reprinting” in the 
Workflow Builder section.
NOTE: You can also create the job ticket with FreeFlow Print 
Manager Advanced Print Path.

To associate the .xpf job ticket file with the files to be picked up by 
the hot folder for processing, the .xpf job ticket file is automatically 
saved along with the PDF file, in the location designated in the 
Save settings, using the following naming conventions:
• File name: <file name>.<file ext>
• .xpf job ticket name: <file name>.<file ext>.xpf
When submitting files in a folder, the following naming 
conventions are used: 
• Folder name: <folder name>
• .xpf job ticket name: <folder name>.xpf
NOTE: If you are not using a hot folder for submission, you can 
submit only the saved PDF to a reprint workflow. The .xpf 
associated with the file is automatically picked up and applied.

To submit an .xpf job ticket to a hot folder for reprinting

Waiting for Job Ticket folder: The job file and its associated .xpf 
must be placed in the Waiting for Job Ticket folder inside the hot 
folder.
When an .xpf job ticket is submitted to the hot folder’s Waiting for 
Job Ticket folder, with an associated job file, the job ticket is 
applied to all the print nodes in the workflow associated with the 
hot folder.
1. Locate the saved PDF. The PDF is in the location that was 

designated in the Save settings when the job was initially 
processed.
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2. Locate the associated .xpf job ticket. The .xpf should be in the 
same location as the PDF, and the associated .xpf file name 
should match the PDF. For example:

File name = newsletter.pdf 
Job ticket name = newsletter.pdf.xpf

3. Do one of the following:
• For a file: Drag and drop or copy and paste the file to be 

processed and its associated .xpf into the Waiting for Job 
Ticket folder inside the hot folder. 

NOTE: To reprint via Workflow Submission Client, submit only 
the saved PDF file to the reprint workflow. Process Manager 
automatically picks up the associated job ticket and applies it 
to all print nodes in the workflow.

• For a folder: Drag and drop or copy and paste the folder 
to be processed and its associated .xpf into the Waiting for 
Job Ticket folder inside the hot folder. The .xpf file must be 
outside the folder to be processed. Each file in the folder is 
submitted separately as a single job with the job ticket.

4. The job prints using the job ticket.
NOTE: If the Print node has “Always use these settings” selected, 
the Print node setting overwrites the .xpf job ticket; otherwise, the 
.xpf job ticket overwrites the Print node settings.

Error conditions

• JDF is a “job ticket” and cannot be associated with an .xpf.
• Since RDO files already contain an internal job ticket, any 

associated .xpf file and the RDO are moved to the 
Unsupported Files folder.

• If the .xpf ticket is invalid, the .xpf file and the associated 
document are moved to the Unsupported Files folder.

• .xpf files without any associated document are ignored.
• .xpf files placed in the hot folder outside the Waiting for Job 

Ticket folder, are moved to the Unsupported Files folder. 
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Imposition handling with .xpf tickets

• If the .xpf ticket contains Imposition information and the 
workflow contains Imposition nodes, imposition information is 
applied to the first imposition node automatically.

• If the Imposition node has “Always use these settings” 
selected, the Imposition node settings overwrite the .xpf ticket; 
otherwise, the .xpf ticket overwrites the Imposition node 
settings.

• If the .xpf ticket contains any imposition information and the 
workflow does not contain any imposition node, the imposition 
information is ignored.

Submitting .xml workflow files to a hot folder

This feature allows you to submit exported workflow(s) in xml 
format, with either a file or a folder containing several files, to a hot 
folder. 
The .xml file name must match the name of its associated file or 
folder to be picked up for hot folder processing. 
Dynamic workflows: Files are submitted to a dynamically 
created “Submitted with documents” workflow, which is available 
in the target workflow drop box. Each time a new job is submitted 
to a dynamic workflow, a new workflow, with a unique workflow Id, 
is created. Dynamic workflows are not visible and are deleted from 
the Process Manager database when jobs using the workflows are 
deleted. Data from the dynamically created workflow is available 
for accounting information, but the “Submitted with documents” 
workflow does not contain any accounting info. 
Matching file names: The .xml must be named <filename>.<file 
ext>.xml to be associated with <filename>.<file ext>.
Matching folder names: The .xml must be named <folder 
name>.xml to be associated with <folder>. 
When submitting a folder to a hot folder, the .xml must be outside 
the submitted folder. Each file in the folder is submitted as a single 
job to each of the workflows in the .xml file.
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To submit .xml workflow files to a hot folder

1. Create the desired workflow in Workflow Builder.
2. To create an .xml workflow file, export the workflow. Ensure 

that the .xml file name matches the name of the PDF file or the 
folder that you will be submitting to the workflow. If the 
workflow name does not match, rename it.
NOTE: The workflow does not need to exist or be enabled in 
Workflow Builder to process the .xml.

3. In Workflow Builder, select [Options: Hot Folders].
4. Set up a hot folder using the target workflow “Submitted with 

documents.” 
5. Using Windows Explorer, locate the .xml file and the matching 

file or folder you will be submitting. 
6. Copy, move, paste, or drag and drop the .xml and its matching 

file or folder into the “Submitted with documents” hot folder. 
NOTE: If you are submitting a folder to a hot folder, ensure the 
.xml is outside the folder. 

7. The submission is automatically processed.

Error conditions for dynamic workflows

• Corrupted RDO’s will not be processed.
• Unsupported file types will be moved to the Unsupported Files 

folder.
• Invalid or unsupported .xml files will be moved to the 

Unsupported Files folder.
• If a workflow contains a print node and a printer is not 

available, the job will fail.
• The following dynamic workflow file names are restricted; files 

will be moved to the Unsupported Files folder: 
– Unsupported Files folder.xml
– Waiting for Job Ticket. xml
– Manifest Status.xml
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Submitting .vpc files to a hot folder 

VPC files can be submitted only to workflows containing Review, 
Print, Save, Convert and Impose processes. Jobs submitted to 
workflows with processes other than these will fail.

VPC file limitations

• Review: Identification of the number of document sets within a 
VI Container is limited to database mode VIPP and PPML print 
files. Selection of a set, or a range of sets is limited to 
database mode VIPP print files. Viewing and editing VI 
containers via Adobe acrobat requires conversion to PDF.

• Convert: Supports conversion of VI Containers with VIPP print 
files. Once the VI container is converted to PDF, the VI job 
remains as a PDF file throughout the remainder of the 
workflow.

• Impose: Supports VI containers converted to PDF
• Preflight: Supports VI containers converted to PDF. Validates 

that all required elements of the VI Container Job are 
contained in the VI Container and that the container is a valid 
VI container. If validation is sucessful the job will pass; 
otherwise, it will fail.

• Print: Limited to DocuSP DFEs.
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Using third party external processes

Administrators can add up to 5 external processes from third party 
software. Each process can have a combined maximum of 10 
folder-based and CLI profiles. 
Submitting from third party processes via hot folders: Folder-
based profiles allow the submission of jobs from third party 
processes via hot folders. During setup, each profile is assigned to 
a process input hot folder, a process output hot folder, and an 
optional errors hot folder.
For folder-based profiles, third party software must be installed 
and running on the Process Manager server or a third party 
machine in order to use external processes in a workflow. When 
the Process Manager workflow reaches the third party step, the 
job is retrieved by the third party application, processed, and then 
returned to the Process Manager workflow to complete any 
remaining workflow steps.
Running third party scripts: CLI profiles are available for input 
via command line interfaces and scripts. During setup, each 
profile is assigned a file name and location for the script, optional 
parameters, and locations for the input and output files.
Once an external process is set up, it displays in Workflow 
Process Options area, where the operator can drag it into a 
workflow and select the desired profile. 

See also:
Guidelines for using third party external processes
Setting up third party input and output hot folders
Managing external processes
Setting up external processes
Adding or editing an external process
Moving or deleting an external process
Setting up folder-based profiles
Adding or editing a folder-based profile
Setting up CLI profiles
Adding or editing a CLI profile
Configuring parameters
Deleting an external process profile
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Guidelines for using third party external processes

• For folder-based profiles, the third party software must support 
input and output via hot folders. 

• In addition to PDFs, External Process nodes accommodate all 
supported file types, except RDOs.

• The third party application must accept and send out the same 
types of files. For example, PDF in must result in PDF out. The 
function of the third party software cannot be to convert PDF to 
JPEG.

• The third party application must accept and send out the same 
file name. For example, table.PDF in must result in table.PDF 
out. The function of the third party software cannot be to 
convert table.PDF to door.PDF.

• Users must supply a user name and password when a remote 
location is selected during setup.

• The folder-based, input, output, and error locations must 
reside on the same remote machine or the same local 
machine.

• The CLI profile Script full path, Working directory, and Output 
location (if used) must reside on the same remote machine or 
on the same local machine.
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Setting up third party input and output hot folders

For folder-based profiles, to ensure the exchange of files between 
the Process Manager external process and the third party 
software, you must set up input and output hot folders for the third 
party software that match the input and output folders of the profile 
used to execute the external process.
NOTE: It is your responsibility to ensure that your third party 
software has the proper Windows write access to the folders 
(input folder, output folder, etc.) you create and/or set up during 
the External Process node configuration in Workflow Builder.

Example

In Process Manager - The following input and output folders are 
set up in Process Manager for an external process profile called 
Profile 1:
• Process input folder: C:\Profile1In 
• Process output folder: C:\Profile1Out 
In the third party software - The following input and output hot 
folder locations must be set up to match the above input and 
output folders for Profile 1:
• Third party input hot folder location is mapped to the Process 

input folder: C:\Profile1In
• Third party output hot folder location is mapped to the Process 

output folder: C:\Profile1Out
NOTE: The third party software must be running for you to use the 
external process in a workflow.

See also:
Using third party external processes
Limitations when setting up directories as input/output hot folders 
for more than one feature
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Managing external processes 

The External Processes dialog allows you to move or delete 
processes and provides access to the external process 
configuration dialogs. It includes the following options:
Move Left: Moves a selected process one space to the left.
Move Right: Moves a selected process one space to the right.
NOTE: Moving a process also changes the order in Workflow 
Builder.

New Process…: Opens the External Process Setup dialog which 
allows you to add a new external process; available if four or fewer 
processes are configured. If there are already five external 
processes when [New Process...] is selected, the Maximum 
Allowed error dialog displays.
Edit…: Opens the External Process Setup dialog for the selected 
process. Allows you to edit an external process or to add 
additional profiles to an external process.
Delete: Deletes a selected process and all its settings.

See also: 
Setting up external processes
Using third party external processes
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Setting up external processes 

The External Process Setup dialog allows you to set up or edit 
process icons, names, and profiles, or to delete a profile from the 
Process Profiles list. It includes the following options:
Process icon: Allows you to select an icon. 
Process name: Allows you to enter a name for the external 
process. 
Process profiles: Lists, by name, the existing profiles up to a 
maximum of 10. Listed profiles are selectable. 
Add folder profile...: Available if 9 or fewer profiles are 
configured. Opens the Folder Profile Setup dialog, which allows 
you to enter a new configuration. If there are ten profiles 
configured when [Add] is selected, the Maximum Allowed error 
dialog displays.
Add CLI profile...: Opens the CLI Profile Setup dialog which 
allows you to enter a new configuration.
Edit...: Opens the setup dialog for the selected profile.
Delete: Deletes the selected profile with a confirmation dialog.

See also:
Setting up folder-based profiles
Setting up CLI profiles
Using third party external processes
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Adding or editing an external process 

External processes must be added and configured before they 
can be used in a workflow. Initial configuration involves: 
• Selecting a process icon
• Assigning a process name
Final configuration involves:
• Setting up input, output, and error hot folders for folder-based 

profiles
• Setting up a script location, parameters, a working directory, 

and output location for CLI profiles 
• Defining the timeout interval for each profile
For folder-based profiles, the third party software must be running 
for you to use the external process in a workflow.

To add or edit an external process

1. In Workflow Builder, select [Options: External Processes]. 
2. In the External Processes dialog, select [New Process...]. 

This option is available only if four or fewer processes are 
configured. 

3. In the External Process Setup dialog, select an icon from the 
Process icon drop box.

NOTE: External Processes are designated by a plus symbol 
overlay.

4. In the Process name text box, enter a name for the process.
NOTE 1: The name must be no longer than 14 characters, and it 
must be a unique name. 
NOTE 2: If incorrect file characters (for example, \ / : * ? < >) are 
entered, an error message displays.
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5. Do one of the following:
a. To add a folder-based profile, select [Add folder 

profile...]. The Folder Profile Setup dialog opens.
b. To add a CLI profile, select [Add CLI profile...]. The CLI 

Profile Setup dialog opens.
c. To modify an existing profile, select a profile in the Process 

Profiles list, and select [Edit]. 
6. Continue to the appropriate procedure to add or modify a 

folder profile or CLI profile:
• Folder-based profiles: Setting up folder-based profiles
• CLI profiles: Setting up CLI profiles

See also:
Setting up third party input and output hot folders
Using third party external processes
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Moving or deleting an external process 

Moving a process changes its position one space to the left or 
right with respect to the other external processes. It also changes 
the process position in Workflow Builder.
When you delete a process, you delete all the profiles for the 
process.

To move or delete an external process

1. In Workflow Builder, select [Options: External Processes].
2. Select a process and then select from the following:

• [Move Left] or [Move Right] to move the process.
• [Delete] to remove the selected process and all associated 

profiles.
NOTE: Deleting an external process affects existing workflows. 

3. Select [Close].

See also:
Using third party external processes
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Setting up folder-based profiles 

The Folder Profile Setup dialog allows you to set up hot folders for 
input, output, and error files, and to define a timeout interval. 
NOTE: Input, output, and error files must be assigned to unique 
locations.

The dialog includes the following options: 
Profile name: Allows you to enter a name for the profile.
Input location: Allows you to select a hot folder on a local or 
remote drive for Process Manager to place the files and for the 
third party software to retrieve the files.
Provide available job data to external process by XML file: 
Allows you to request the system to provide additional information 
to the external process via an XML file written to the external 
process input folder. Information includes job name, job ID, date 
submitted, JDF and preflight results file path information, manifest 
order jacket file information. 
NOTE: The third party application should also be configured to 
retrieve input at this location. 

Output location: Allows you to select a hot folder on a local or 
remote drive for the third party software to store successfully 
processed files.  
NOTE: The third party application should also be configured to 
store successfully processed files at this location.

Error location: Allows you to select a hot folder for the third party 
software to place error files. If error files are generated, the job will 
fail.
NOTE: Creating an error file location is optional. 

Timeout: Allows you to enter a duration to wait for the external 
process to return processed files. If this time elapses with no 
returned files or errors, the job fails. Seconds and minutes values 
cannot both be zero.
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Adding or editing a folder-based profile 

A combined total of 10 folder-based profiles and CLI profiles can 
be configured for each external process. For folder-based profiles, 
the input, output, and error locations must reside on the same 
remote machine, or on the same local machine.

To add or edit a folder-based profile

Refer to Adding or editing an external process to add an external 
process, and then set up a folder-based profile as follows:
1. In the Folder Profile Setup dialog, enter or change the name 

for the profile.
NOTE: Changing a name or a folder affects existing workflows. 

2. To select process input, process output, and error folders, do 
the following:

NOTE: You will be asked for a user name and password when a 
remote location is selected during setup.

a. Select [Browse].
b. In the Browse For Folder dialog, do one of the following:

– Select the desired folder, and then select [OK]. 
If you select a remote location, the Remote Connection 
dialog displays. Enter the appropriate User name and 
Password, and select [OK].

– Select [Make New Folder], name the folder, and select 
[OK].

3. In the timeout drop box, select a duration. 
4. Select [OK]. If you edited an existing profile, a confirmation 

dialog displays. The new profile displays in the Process 
Profiles text box.
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5. To configure additional process profiles, repeat steps 1-4. 
Otherwise, select [OK] to close the External Process Setup 
dialog.

NOTE 1: You must set up input and output hot folders for the third 
party software that match the input and output folders of the 
profile.
NOTE 2: For folder-based profiles, the third party software must 
be running to use the external process in a workflow.

See also:
Deleting an external process profile
Using third party external processes
Limitations when setting up directories as input/output hot folders 
for more than one feature
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Setting up CLI profiles 

The CLI Profile Setup dialog allows you to select a script location 
and enter optional parameters, set up working directory and 
output locations, and define a timeout interval. The dialog includes 
the following options:
Profile name: Allows you to enter a name for the profile.
Script full path: Allows you to enter or select the location and file 
name of the script file to be used for the external process. 
Browse…: Opens a common file dialog that allows you to select a 
file.
Parameters: Allows you to enter optional script parameters. 
Default parameters are $in$ $out$.
Provide available job data to external process by XML file: 
Allows you to request the system to provide additional information 
to the external process via an XML file written to the external 
process input folder.
Working directory: Allows you to designate a location on a local 
or remote drive in which the external process node can place input 
files and from which the script can retrieve the files. 
Output location: Optional; allows you to enter the location on a 
local or remote drive in which the script stores successfully 
processed files.
Timeout: Allows you to enter a duration to wait for the external 
process to return processed files. If this time elapses with no 
returned files or errors, the job fails. Seconds and minutes values 
cannot both be zero.

See also:
Configuring parameters
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Adding or editing a CLI profile 

A combined total of 10 folder profiles and CLI profiles can be 
configured for each external process. The CLI script full path, 
working directory, and output location (if used) must reside on the 
same remote machine or on the same local machine.

To add or edit a CLI profile

Refer to Adding or editing an external process to add an external 
process, and then set up a CLI profile as follows:
1. In the CLI Profile Setup dialog, enter or change the name for 

the profile.
NOTE: Changing a name or a folder affects existing 
workflows. 

2. To select a Script full path, select [Browse].
3. In the Open dialog, locate the script, and select [Open]. 
4. (Optional) In the parameters text box, enter additional script 

parameters. For more information on configuring parameters 
refer to Configuring parameters.
NOTE: You may add parameters before, after, or between the 
default parameters, but you should not delete the defaults. If a 
default is deleted, an error message displays when you click 
[OK].

5. To select a working directory location or an output location, do 
the following:

NOTE: You will be asked for a user name and password when a 
remote location is selected during setup.

a. Select [Browse].
b. In the Browse For Folder dialog, do one of the following:

– Select the desired folder, and then select [OK].
– Select [Make New Folder], name the folder, and select 

[OK].
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6. In the timeout drop box, select a duration. 
NOTE: If you select a timeout value of zero minutes and zero 
seconds, an error message displays. Select [OK], and then 
enter a valid value.

7. Select [OK]. If you edited an existing profile, a confirmation 
dialog displays. The new profile displays in the Process 
Profiles text box.

8. To configure additional process profiles, repeat steps 1-7. 
Otherwise, select [OK] to close the External Process Setup 
dialog.

See also:
Configuring parameters
Deleting an external process profile
Using third party external processes
Limitations when setting up directories as input/output hot folders 
for more than one feature
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Configuring parameters

The following examples illustrate various options for configuring 
parameters for CLI profiles.

Example 1: Using the default parameters 

Scenario: The user would like to execute a script named 
“SomeScript” on the C drive during the execution of the External 
Process node in FreeFlow Process Manager. The script takes an 
input file as its first parameter, does something to the file, and 
stores the result in an output file specified by the second 
parameter.
The External Process Node for Script is configured in the CLI 
Profile Setup dialog as follows:
Profile name: Something
Script Full Path: c:\SomeScript
Parameters: $in$ $out$
Working directory: c:\temp (user’s choice) 
Output Location: c:\brianOut (user’s choice)
Time interval: 30 seconds
During execution, the user submits the file “someFile”. The 
External Process launches “SomeScript” by launching the 
following command:
C:\SomeScript c:\temp\someFile c:\brianOut\someFile
The file “someFile” is copied to the working directory by the 
External Process node prior to launching the script. Also, the 
External Process node automatically uses the same name for the 
input file as for the output file.
The External process node waits for the script to finish executing 
successfully for the maximum of the time interval (if the time 
interval passes, an error has occurred) and then looks for 
c:\brianOut\someFile.
If the file is there it is picked up; if not, an error has occurred.
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Example 2: Adding a parameter between the input and 
output parameters

Scenario: Now, assume that the user wants “SomeScript” to use 
an additional parameter, “someParameter,” between the input and 
output parameters. The only difference to the configuration is this: 
Parameters: $in$ someParameter $out$ 
During execution, External Process node launches the following 
command:
C:\SomeScript c:\temp\someFile someParameter 
c:\brianOut\someFile

Example 3: Adding a parameter after the output 
parameter

Assume the same scenario as Example 1, except the user wants 
“someParameter” to follow the output parameter. The user would 
configure this way:
Parameters: $in$ $out$ someParameter
During the execution, External Process node launches the 
following command:
C:\SomeScript c:\temp\someFile c:\brianOut\someFile 
someParameter

Example 4: Adding two parameters

Scenario: Assume the same scenario as Example 1 except 
“SomeScript” uses two additional parameters “someParameter1” 
and “someParameter2,” and the user wants “someParameter1” to 
come in between input and output parameters, and 
“someParameter2” to come after output Parameter. The 
configuration would be as follows:
Parameters: $in$ someParameter1 $out$ someParameter2
During execution, the External Process node launches the 
following command:
C:\SomeScript c:\temp\someFile someParameter1 
c:\brianOut\someFile someParameter2
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Example 5: When the output location is not specified

Scenario: Assume the same scenario as Example 1, except the 
user does not specify an output location. 
During the execution, External process node launches the 
following command:
C:\SomeScript c:\temp\someFile c:\temp\someFile
With no output location specified, the External Process node 
automatically uses the same output parameter as the input 
parameter when the script is launched.

Example 6: Using “  ” for a path that contains a space

Scenario: If you are using a path with a space for your DOS 
script, you can use “  “, per this example. Assume the same 
scenario as Example 1, except the working directory is c:\program 
files. Note the space between program and files. The user 
configures the External Process node as follows:
Profile name: Something
Script Full Path: c:\SomeScript
Parameters: “$in$” $out$
Working directory: c:\program files
Output Location: c:\brianOut 
Time interval: 30 seconds
Notice the quotations (“  “) around $in$
During execution, the External Process node launches the 
following command:
C:\SomeScript “c:\program Files\someFile” 
c:\brianOut\someFile
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Example 7: Specifying parameter order

Scenario: In this scenario, the user submits the file “someFile.” 
The user can specify the parameters in any order in the 
Parameters field.
Profile name: Something
Script Full Path: c:\SomeScript
Parameters: -I $in$ -O $out$
Working directory: c:\temp (user's choice)
Output Location: c:\brianOut (user's choice)
Time interval: 30 seconds (user's choice)
During execution, the External Process launches SomeScript with 
the following command:
C:\SomeScript -I c:\temp\someFile -O c:\brianOut\someFile

Deleting an external process profile 

You can select and remove individual profiles from an external 
process.

To delete an external process profile

1. In Workflow Builder, select [Options: External Processes].
2. In the External Processes dialog, select the process that 

contains the profile you wish to delete, and select [Edit].
CAUTION: If you select [Delete] in the External Processes 
dialog, you will delete the external process and all profiles 
associated with the process.
3. In the External Process Setup dialog, select the desired profile 

from the Process Profiles list.
4. Select [Delete]. The selected profile is deleted. A confirmation 

message displays.
5. Select [OK].

See also:
Using third party external processes
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Setting up the SMTP Server 

The Simple Mail Transport Protocol (SMTP) Server is used for 
email notification. To support the Notify process step, you must 
designate a mail server for outgoing mail or notifications. 
NOTE: Incoming and outgoing mail cannot be directed without the 
SMTP address of your mail server.

The SMTP Setup dialog contains the following options:
SMTP Server text box: Allows you to enter the SMTP Server 
name, for example: smtp.galaxynet.net.
NOTE: Only valid characters and strings for SMTP Servers are 
accepted. An error message displays if the syntax is incorrect. 

Maximum attachment size: Allows you to set a size limit for e-
mail attachments in the Notification process. The available range 
is 20 - 1024 MB.
OK: Closes the dialog and saves the settings.
Cancel: Closes the dialog and does not save the settings.

To set up the SMTP server

1. In Workflow Builder, select [Options: SMTP Setup...]. 
2. In the SMTP server text box, enter the name of the mail server 

used for outgoing mail or notifications. 
3. Select a maximum attachment size from 20 - 1024 MB.
4. Select [OK].
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Setting up the proxy server 

Job submission using JMF/JDF might require communication via 
a proxy server. The Proxy Setup dialog is used to configure an 
address and port number on your proxy server.

To set up the proxy server

1. In Workflow Builder, select [Options: Proxy Setup...].
2. In the Address text box, enter an address for the proxy server.
3. In the Port text box, enter a port number for the proxy server.
4. Select [OK].
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Creating preflight profiles

This is an administrator function. 
The Preflight step validates and checks formatting, and verifies 
the image, fonts, and references to the OPI image server images. 
Preflight profiles are provided via a Callas plug-in using Adobe 
Acrobat Professional. 

To create a preflight profile

1. In Workflow Builder, select [Options: Preflight Setup...]. 
Adobe Acrobat Professional launches.

2. In Adobe Acrobat Professional, select [Advanced: 
Preflight...].

3. In the Preflight dialog, select [Edit].
4. In the Preflight: Edit Profiles dialog, select the [Create a new 

Preflight profile] icon.
5. Select [New profile].
6. Enter a profile name and other desired information, and select 

the desired options.
7. Refer to the “Creating new preflight profiles” procedure in 

Adobe Acrobat Professional to add or create rules and 
conditions, as required.

8. Exit Adobe Acrobat.
NOTE: For in-depth information about creating preflight profiles, 
refer to the preflight Help topics in Adobe Acrobat.

To modify a preflight profile

NOTE: If a profile has been selected in a Preflight node, and then 
the profile is modified in Adobe Acrobat Professional, the 
modification is not reflected in the already-selected Preflight node. 
In order to use the modified profile, you must create a new 
Preflight node and select the profile again. 

1. In Workflow Builder, select [Options: Preflight Setup...]. 
Adobe Acrobat Professional launches.

2. Select [Advanced: Preflight...].
3. Select one of the predefined profiles.
4. Select [Edit].
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5. Refer to the “Modifying preflight profiles” procedure in Adobe 
Acrobat to add or create rules and conditions, as required.

6. If desired, to create a duplicate, select [Duplicate].
7. Exit Adobe Acrobat Professional.

NOTE: For additional information about creating preflight 
profiles, refer to the preflight Help topics in Adobe Acrobat 
Professional.
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3. Workflow Submission Client

Xerox FreeFlow Workflow Submission Client allows you to 
perform major job submission tasks, from choosing files to enter in 
a designated workflow to selecting the best workflow for the job.

About Workflow Submission Client

Use Workflow Submission Client to:
• Select files for submission from WIndows or from a document 

repository.
• Create a file list (.xfl) to save one or more files for future 

submissions
• Select an automated workflow to which to submit files. 
• Launch Workflow Builder.
• Set up Repository credentials.
If a workflow is set up to accept changes, use Workflow 
Submission Client to:
• Modify the workflow process settings.
• View the job ticket, select an optional job ticket for submission 

with the files, and resolve job ticket conflicts.
You can also submit files remotely from a workstation or server 
with Remote Workflow Submission Client installed.



FreeFlow Process Manager Operator and Administrator Guide3-2

Workf low Submission Cl ient

Logging in to Workflow Submission Client

Process Manager user accounts are created and managed using 
the Windows Local Users and Groups functionality in the 
Computer Management application. During install, Xerox 
FreeFlow Process Manager Administrators and  Xerox 
FreeFlowProcess Manager Operators groups are created. Your 
adminstrator then populates these groups with users. Permissions 
to launch applications are based on group membership.
NOTE: If you are not a member of an authorizing group, contact 
your administrator. If you forget your username and password, 
notify your administrator.

To log in to the Workflow Submission Client application

A login screen may or may not display, depending on group 
membership and server location.
If you enter the incorrect username or password, you receive an 
incorrect username or password error message. You can then 
enter your correct username and password.
1. Select [Start: Programs: Xerox FreeFlow Software: 

FreeFlow Process Manager: Workflow Submission Client]. 
The Login dialog opens for the selected application.

2. In the User name text box, enter your user name.
3. In the Password text box, enter your password.
4. The Domain text box is populated with the domain of the 

currently logged in user, or the last domain entered in the login 
form. Confirm that the proper domain name appears.

5. Enter the appropriate Process Manager server name in the 
Server text box.

6. Select [OK]. The main window opens.
7. If during login to a remote client you enter the incorrect 

username or password, an incorrect username or password 
error message displays. Enter your correct username and 
password.
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Workflow Submission Client main window

The Workflow Submission Client main window contains four areas 
that represent the main steps in the job submission process: Get 
Files, Select Workflow, Configure Settings, and Submit Job. 

Select Workflow Area

Area
Configure Settings

Submit Job Area

Get Files Area
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The Get Files area

The Get Files area contains a scrollable window that allows you to 
select and manage files from local disks or document repositories.

The files display in the order in which they are submitted. 
Files are managed with the following buttons:

The Total status text, under the Get Files text box, lists the number of 
files in the text box. 

Table 3-1.  Get Files buttons

Button Name Description

Add Windows File... Displays a Windows browse screen.

Add Repository File... Displays a repository browse screen.

Remove Removes selected files from the text box.

Save File List Opens a Save common file dialog and allows 
you to save the list of files as a .xfl (Xerox 
File List) file. The file lists can then be 
submitted using the “Add Windows File” and 
“Add Repository File” dialogs.

Move Up Moves a selected file up one position in the 
list.

Move Down Moves a selected file down one position in 
the list.

Expand/Collapse Shows/hides the Select Workflow, Configure 
Settings, and Submit Job areas of the 
window. The Submit Job button is not hidden 
when Collapse is selected.
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The Select Workflow area

The Select Workflow area displays a scrollable list of the available 
workflows. 

NOTE: A workflow must be enabled in Workflow Builder for it to 
display in the Workflow Submission Client window.

The list can be sorted by each column by selecting the column 
heading. The following information is displayed for each workflow:

Table 3-2. Select Workflow columns

Column Description

Name Displays the workflow name.

Id Displays the workflow Id.

Date Modified Displays the date the workflow was last changed.

Processes Displays the workflow process icons. 

Only the icons associated with Pass states are 
shown; Fail states are not shown.

A workflow is grayed out if it is unavailable due to 
a Join, Convert, or Image Enhance conflict.

When you sort by this column, the order is 
determined by the number of processes.

Description Displays the workflow description.

% Match Shows the % match: the number of matching 
processes, divided by the number of selected 
processes, multiplied by 100.
For example, if a user selects 5 check boxes and 
a workflow includes 4 of the processes marked by 
the check boxes, the % Match would be 80%. 

% Match Filter Allows you to select check boxes for the 
processes you want to include or exclude in the 
workflow.



FreeFlow Process Manager Operator and Administrator Guide3-6

Workf low Submission Cl ient

The Configure Settings area

The Configure Settings area displays the selected workflow. The 
pane displays the workflow processes, including the fail pathways, 
in a view similar to Workflow Builder. 

Settings are configured using the following options:

Table 3-3. Configure Settings options

Button Name Description

Edit Settings Allows you to access and change process 
settings for the selected process if the 
administrator has configured the settings to allow 
changes. 

Restore Settings Allows you to restore settings to those that 
accompanied the workflow when it was originally 
opened.
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The Submit Job area

The Submit Job area allows you to configure the job and sender 
names and displays other job details.

 

Table 3-4. Submit Job area options

Component Description

Job name Allows you to type a meaningful job name. 
Default: If there is only one file, the file name 
displays here. If there are two or more files, 
the prefix “multi” displays, followed by the first 
filename, until a character limit of 40 is 
reached.

Use file name as 
job name

Available when multiple files are selected and 
a workflow without a Join node is selected.
When selected, the “Job name:” field is 
grayed out and the job names match the 
submitted file names.

Number of files Reflects the number of files in the Get Files 
list.

Selected workflow Contains the name of the workflow selected in 
the Select Workflow area.

Submitter Allows you to type a sender name. The default 
is the current username.

Submit Job(s) Submits the job and displays a confirmation 
message. Label displays as “Jobs” when 
multiple jobs are submitted.
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Workflow Submission Client menus

The Workflow Submission Client menu bar provides commands 
for selecting files and submitting jobs.

File menu

The File menu contains the following options:

Table 3-5. Workflow Submission Client File menu

File menu option Description

Add Windows File... Opens a Windows browse screen.

Add Repository File... Opens a repository browse screen.

Save File List... Opens the Save File List dialog.

Submit Job Submits the job. Displays the Submission 
Progress dialog, which shows the 
submission progress in percentage. 

Exit Closes the Workflow Submission Client 
application. 
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Edit menu

The Edit menu contains the following options:

View menu

The View menu contains the following options:

Table 3-6. Workflow Submission Client Edit menu

Menu 
options Description

Remove Removes a selected file from the text box.

Move Up Moves a selected file up one position in the list.

Move Down Moves a selected file down one position in the list.

Edit 
Settings...

Opens the Edit Settings dialog for the workflow 
process.

Restore 
Settings

Restores settings to those that accompanied the 
workflow when it was originally opened.

Workflow 
Builder

Displays the Workflow Builder login dialog if you are 
not logged in; if you are logged in, activates 
Workflow Builder.

Find... Opens the Find dialog, which allows you to locate a 
process node in a workflow.

Table 3-7. Workflow Submission Client View menu

Menu option Description

File Details Shows the details (file name, file size, date 
modified) in the Get Files area.

File List Shows the list (file name only) in the Get Files area. 

Hide % Match Hides % Match and % Match Filter.

Show/Hide 
Process Tool 
Tips

Show: Allows you to view process settings via tool 
tips in the graphical workflow display by positioning 
the mouse pointer over a workflow process.

Hide: Disables the tool tips.

Workflow Icons Small Icons: Displays small icons.
Medium Icons: Displays mid-sized icons.
Large Icons: Default; displays large icons.



FreeFlow Process Manager Operator and Administrator Guide3-10

Workf low Submission Cl ient

Options menu

The Options menu contains the following option:

Help menu

The Help menu contains the following options:

Table 3-8.  Workflow Submission Client Option menu

Menu Option Description

Remove Files After 
Submission

Removes files from the Get Files list after the 
files are submitted for processing.

Repository 
Credentials Setup...

Opens a dialog that allows the current user to 
enter a Username and Password for the 
active repository.

Table 3-9. Workflow Submission Client Help menu

Menu option Description

Help Topics... Displays the Help application to allow you to 
list the Help topics for Workflow Submission 
Client.

About Workflow 
Submission Client...

Displays program and copyright information 
for Workflow Submission Client.
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Job submission

Job submission involves a few basic steps.

Job submission process

• Locate and sequence the files: You can select files from 
local disks, DocuShare, or from the document repositories. If 
you are submitting multiple files for joining, list them in the 
desired sequence. 

• Select a workflow: Only workflows that have been enabled in 
Workflow Builder display. Ensure the selected workflow 
includes the processes necessary to meet the job criteria.

• Modify the process settings: You can modify process 
settings to meet the needs of a job in the Configure Settings 
area; for example:
– You can change page numbers or watermarks settings via 

the appropriate process settings dialogs.
– You can change the job ticket settings (for example, the 

number of copies, the stock) using the Job Setup dialog in 
Print Settings.

• Name and submit the job: Use the default name or select a 
new name, and then submit the job.
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Workflow selection methods

NOTE: A workflow must be enabled in Workflow Builder for it to 
display in the Workflow Submission Client window.

Two basic workflow selection methods are described below.

Direct method

Select a workflow if you are familiar with the workflows and the job 
requirements. Keep in mind the following:
• If a workflow does not contain the Convert process, and if you 

have files that require conversion to PDF, the workflow will be 
grayed out.

• When submitting multiple files to a workflow:
– To create a single joined job, Join must be in the workflow. 
– To create multiple separate jobs, Join should not be in the 

workflow.

% Match method

Select the required components and generate a list of workflows 
that meet the job criteria.
• Check the workflow components that you need to complete a 

given job.
• To sort by processes not included in the workflows, do not 

select the workflow components. 
% Match equals the number of matching processes divided by the 
total number of selected processes, multiplied by 100.
For example, if you select 5 check boxes, and a workflow includes 
4 of the checked processes and no additional processes, the 
percent match is 80%.
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Submitting a job

With a single submission, you can process either a single file, 
multiple files as a single joined job, or multiple files as separate 
jobs. The table shows how submission input and the presence of a 
Join node in the workflow defines the job output:

To submit a job to a workflow

1. In Workflow Submission Client, select from the following:
• To locate a Windows file(s), select [Add Windows File...], 

and browse for the file.
NOTE: To retrieve files from DocuShare, select My Network 
Places and navigate to the appropriate Docushare web folder.

• To locate repository files, select [Add Repository File...], 
and browse for the file. 

NOTE: Prior to perfoming operations that require repository 
access, you must set up and save your repository credentials 
in FreeFlow Process Manager. For more information, see 
Setting up repository credentials.

2. Select [Open] to add the file(s) to the Get Files list. 
3. For jobs that use a workflow with a Join node, the order of the 

list indicates the joined sequence of the files. If necessary, re-
order the files or file list by selecting an item in the list, and 
then select [Move up] or [Move Down]. 

NOTE: To automatically clear files from the Get Files list after 
submission, select [Options: Remove Files after Submission]. 

4. (Optional) To save one or more files to a file list (.xfl) for future 
submissions, select [Save File List...]. For more information 
about saving a file list, see the Saving a File List procedure.

Table 3-10. File submission with and without join

Submission Join node in 
workflow Job(s) created

Single file No Single job

Multiple files Yes Single joined job

Multiple files No Multiple separate jobs
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5. Select a workflow directly if you are familiar with the workflows 
and the job requirements, or select the check boxes for the 
workflow components required to complete the job.
NOTE: To process multiple files as separate jobs, select a 
workflow without a Join step.

6. To view or modify the process settings for a selected workflow:
• Double-click a workflow process to display the settings 

dialog, or click [Edit Settings]. Modify the settings, and 
select [OK] to save the changes. 

7. Select from the following:
• Type a name in the Job name text box. The default is the 

name of the document, unless multiple files are selected. 
• Select [Use file name as job name] to give each job a 

name that matches the submitted file. Each job receives 
the job name specified in Workflow Submission Client with 
an incremental number appended (such as, MyJob 1, 
MyJob2, MyJob3).

8. If necessary, type a name in the Submitter text box.
9. Select [Submit Job(s)] to process the files.
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Saving a File List

The [Save File List] option facilitates the multiple submission of 
files by saving the current list of one or more selected files as a 
Xerox File List (.xfl). Since the files in the file list are really “paths” 
to the source files, any updates to the source files are captured 
when the file list is submitted. File lists are useful for:
• Multiple submissions of the same files to various workflows 

without reselecting the files.
• Rerunning a job in which only one or two of the files in the list 

is updated.
NOTE: A file list cannot be submitted to a hot folder.

Consider the following points when creating and using a file list:
• The same file can be included in multiple file lists.
• The same file can be included more than once in the same file 

list.
• The file list exists only in the local Workflow Submission Client.
• If during submission any of the files in the file list no longer 

exist, you are notified, and the missing file(s) are skipped.

See also:
Limitations for Save File List

To save a file list

To save one or more files for future submissions, do the following.
1. In the Workflow Submission Client Get Files area, locate, and 

then select the desired files in the list.
2. Select [Save File List...]. The Save File List dialog displays.
3. In the File Name text box, enter a name for the file list.
4. Select [Browse...]. In the Browse for Folder dialog, select a 

location for saving the File List, and then select [OK]. The 
Location text box is populated with the file location. 

5. Select [OK] to exit the Save File List dialog.
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To submit a file list

1. In the Workflow Submission Client Get Files area, browse to 
the location of the saved file list.

2. Select the appropriate file list, identified by an .xfl file 
extension.

3. Continue with step 2 of the Submitting a job procedure. 

Limitations for Save File List

Repository files that have been saved in a Xerox File List (.xfl) can 
be successfully loaded only if the Workflow Submission Client 
application has not been closed since the file list was first created. 
Once the Workflow Submission Client application is closed, the 
temporary repository files are removed. If you re-launch the 
application and load the file list, an error message will display for 
each of the removed repository files. 

Submitting Zip files

Zip files can be submitted only via a hot folder.

Submitting VI Containers (.vpc) 

VI Container files (.vpc) can be submitted via Workflow 
Submission Client only to workflows containing Review, Print, 
Save, Convert and Impose. Jobs submitted to workflows with 
processes other than these will fail.
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Submitting a file with saved job ticket information for reprinting

The [Save the job ticket] option in the Save Settings dialog 
allows you to save the job ticket (XPIF) information with the PDF 
file for reprinting purposes. To reprint via Workflow Submission 
Client, submit only the saved PDF file to the reprint workflow. 
Process Manager automatically picks up the associated job ticket 
and applies it to all print nodes in the workflow. 
For more information about the [Save the job ticket] option, refer 
to the topic “Saving a job ticket with the PDF for reprinting” in the 
Workflow Builder section.

Submitting QuarkXPress files (.qxd, .qxp) 

QuarkXPress files (.qxd, .qxp) can be submitted via Workflow 
Submission Client only to workflows containing a Convert 
process. QuarkXPress files must be manually converted to PDFs 
before they can be processed in a workflow. To do this, you must: 
• Set up a QuarkXPress working directory in the Convert 

Settings. Files are held in the directory until they are manually 
converted. 

• Set up an e-mail notification address in the Convert Settings. 
This allows you to send an e-mail message to indicate that a 
QuarkXPress document is waiting to be converted to PDF. A 
message are sent for each QuarkXPress document 
processed.

For more information see, “Configuring Convert settings” in 
Workflow Builder.
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About submitting RDOs

The FreeFlow document type, RDO, stands for Raster Document 
Object. It is an electronic document that is made up of images. An 
RDO can contain several different types of images: TIFF, JPEG, 
and Adobe PDF. Images can be black and white, grayscale, or 
color.

Identifying the parts of an RDO

An RDO is a compound object (an object having many parts), but 
FreeFlow sees an RDO as a single document. The two main parts 
of an RDO are the RDO file and the .CON directory. The RDO part 
of the file contains all the information about how to organize the 
images in the document to produce the desired output, or 
appearance. The .CON directory part of the file contains all the 
images of the document. Each TIFF, JPEG, Adobe PDF, and file 
is stored as an individual file in the .CON directory. 
When you open Windows Explorer and look for your documents, 
you see both parts of the RDO. For a document named Family, 
you see a file named Family.rdo and a directory named 
Family.con. In File Manager, you can view only the RDO. 
FreeFlow treats the parts of the RDO as a single document. 
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Submitting RDOs

RDOs are submitted to a workflow via Workflow Submission 
Client, the same way that you submit any job to a workflow:
1. Locate the file on a local disk or document repository.
2. Select a workflow.
3. Submit the job.

To submit an RDO and produce a PDF 

To submit an RDO and produce a PDF, the RDO must be 
submitted to a workflow in which Convert is the first step. 

To submit an RDO and produce an RDO (RDO reprint) 

RDOs previously set up with the necessary job parameters in 
Makeready can be submitted to Process Manager for reprinting. 
Minor changes can be made to the job ticket—for example, the 
copy count.
You can submit an RDO reprint to a workflow that contains any 
combination of Save, Print, and Review. Review is available only 
to pause, approve, fail, change copy counts, and print a proof. You 
will not be able to view the RDO using [View Document]; the 
RDO ticket can be viewed via [Settings]. This is possible only if 
you have a Print node.
NOTE 1: The RDO embedded job ticket is used to print the job 
unless “Always use these settings” is selected in the Print node 
settings.
NOTE 2: If “Always use these settings” is selected, the Print node 
settings are used and the RDO embedded job ticket is ignored.

RDO limitations

Successful submission of linked RDOs (an RDO containing a link 
to another RDO) and set labeling RDOs via Workflow Submission 
Client or hot folders cannot be assured.
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Remote Workflow Submission Client

Process Manager can support multiple remote instances of 
Workflow Submission Client. This allows you to submit files by 
logging in to any workstation or server in your print shop that has 
the Remote Workflow Submission Client software installed. The 
following file types are supported:
• If only Adobe Reader is installed on the client system, only 

PDF file types can be submitted remotely via the Add 
Windows File, Add Repository File, or Add Cabinet File (for 
legacy Document Library) options. This also applies if Adobe 
Reader is not installed.

• If Adobe Acrobat is installed on the client system, then all 
supported file types can be submitted.

Process Manager supports a maximum of 8 instances of Remote 
Workflow Submission Client, not including the client on the 
FreeFlow Process Manager server.
NOTE:  Ensure that the Process Manager server is selected in the 
text box of the remote client login screen.

 Accessing Workflow Builder from Workflow Submission Client

During the job submission process, you may need to create new 
workflows in Workflow Builder if none exist that meet the needs of 
the job.
To access Workflow Builder from Workflow Submission Client:
1. In Workflow Submission Client, select [Edit: Workflow 

Builder].
2. The Workflow Builder login dialog may or may not display, 

depending on group membership. See Logging in to Workflow 
Submission Client. If required, log in to Workflow Builder.

3. Select [File: New].
4. Create a new workflow.
5. Save the workflow.
6. Enable the workflow.
7. Exit Workflow Builder. 
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4. Workflow Job Manager

Xerox FreeFlow Workflow Job Manager allows you to view and 
manage active and completed jobs in the system.

About Workflow Job Manager

Use Workflow Job Manager to perform tasks at the job level:
• View job details and status.
• Review and edit jobs in Adobe Acrobat.
• Edit process settings.
• Print hardcopy proofs.
• Identify faulted jobs.
• Resubmit jobs. 
• Approve, fail, pause, or delete jobs.
• Generate, view, and export reports.
• Set up repository credentials.
• Launch Workflow Submission Client, Workflow Builder, Printer 

Registration, and FreeFlow Administration Tool.
• Review and configure incoming third-party jobs from 

Management Information Systems (MIS).
• Perform selected tasks remotely from a workstation or server 

with Remote Workflow Job Manager Client installed.
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 Logging into Workflow Job Manager

Process Manager user accounts are created and managed using 
the Windows Local Users and Groups functionality in the 
Computer Management application. During install, Xerox 
FreeFlow Process Manager Administrators and  Xerox 
FreeFlowProcess Manager Operators groups are created. Your 
adminstrator then populates these groups with users. Permissions 
to launch applications are based on group membership.
NOTE: If you are not a member of an authorizing group, contact 
your administrator. If you forget your username and password, 
notify your administrator. 

To log in to the Workflow Job Manager application

A login screen may or may not display, depending on group 
membership and server location.
If you enter the incorrect username or password, you receive an 
incorrect username or password error message. You can then 
enter your correct username and password.
1. Select [Start: Programs: Xerox FreeFlow Software: 

FreeFlow Process Manager: Workflow Job Manager] from 
the Windows desktop.The Login dialog opens.

2. In the User name text box, enter your user name.
3. In the Password text box, enter your password.
4. The Domain text box is populated with the domain of the 

currently logged in user, or the last domain entered in the login 
form. Confirm that the proper domain name appears.

5. Enter the appropriate Process Manager server name in the 
Server text box.

6. Select [OK]. The main window opens.
7. If during login to a remote client you enter the incorrect 

username or password, an incorrect username or password 
error message displays. Enter your correct username and 
password.
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The Workflow Job Manager main window 

The Workflow Job Manager window provides an overview of all 
jobs and their current status in the system. You can view all jobs in 
the system, including active and completed jobs.
Two major areas comprise the Workflow Job Manager main 
window: the Status area and the Jobs area.

Status
Area

Area
Jobs
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The Status area 

The upper portion of the Workflow Job Manager window displays 
the detailed status of a job selected in the Jobs area.

The status area reflects the status of the selected job and the 
selected workflow node. The buttons that display vary, based on 
the selected workflow and node. The status area displays the 
name of the job and includes the following elements:
• Process status text: Displays the name and status of a 

selected workflow process—for example, “Passed in Convert.” 
Includes an instructive statement—for example, “You may edit 
settings and resubmit to this node.”

• Selected process arrow: An arrow connects the currently 
selected process to the status area.

• Process buttons: The available buttons display for the 
selected process—for example View Document and 
Approve.

• Progress bar: Indicates the status of an in-progress 
automated process.

NOTE: When submitting multiple files for conversion, the progress 
bar shows the conversion progress on a per file basis. For each 
file, the progress bar moves to 50% to indicate that the file is 
processing, and then to 100% when processing is complete.
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• Workflow: Graphically represents the workflow of the selected 
job.
– Active process: A green highlight indicates the currently 

active process; green arrows link the processes.
– Completed process: A blue check mark indicates a 

completed process.
– Selected process: A blue background indicates a 

selected process; an arrow connects the selected node to  
the message area. Selecting a process displays the 
Settings button, if available, and allows you to access the 
settings dialog.

– Process Settings: You can position the mouse cursor 
over a process to view the setting in a tool tip.

– Input settings: In Workflow Job Manager, you can open 
the Input settings dialog and view a list of the original input 
files for the selected job. Input files can also be viewed via 
the tool tip.

NOTE: The workflow process steps cannot be dragged and 
dropped in this graphical view.
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The Jobs area 

The lower portion of the Workflow Job Manager window lists all 
jobs, active and completed, currently in the system.

• Each row lists a job and the job details. 
• The toolbar allows you to launch Workflow Submission Client, 

or delete a job, or launch Workflow Builder. 
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The Jobs area columns 

Each row in the Workflow Job Manager Jobs area contains the 
following information about a job:

Additional features allow you to:
• Sort the jobs list by the items in any column by selecting the 

column heading. For example, to sort the table alphabetically 
by workflow, select the Workflow column heading.

• View a context menu for a listed job by right-clicking the job.
• Make multiple selections from the list using <Control + Shift>.

Table 4-1.  Jobs area columns

Column Description

Name Lists the names of the current jobs.

Id Displays the Job Id number.

Status Lists the current status of each job.

Print Status Shows the status of print jobs submitted through 
Process Manager. Available for IPP printers only.

Workflow Lists the names of the workflow used.

Workflow Id Lists the system-generated workflow Id.

Date Submitted Lists the time and date the job was submitted.

Submitter Lists the job submitter’s user name from login. For 
hot folders, defaults to the administrator. 

Dynamic Indicates (Yes, No) whether the workflow is 
dynamic.

Processes Displays a small graphical representation of the   
workflows.
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Print Status descriptions 

The following sample print statuses might be displayed in 
Workflow Job Manager area Print Status column. For a complete 
list, consult your printer documentation.

Table 4-2. Print Status descriptions

Status Description

Active The job is in process or in a printing state.

Pending The job is ready and is waiting to be processed at the system.

Paused The job is paused because of a printer or job execution problem.

Printing The job is printing.

Processing The job is being processed.

Rejected The job was rejected by the system while it was being received.

Save completed The job was saved successfully.

Waiting for printer The job has completed processing and is waiting for the printer.

Waiting for save The job has completed processing and is being saved
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Workflow Job Manager menus

The Workflow Job Manager menu bar provides commands for 
managing jobs. 
Commands can also be accessed by right-clicking a job to display 
the context menu. Menu items that are not available are grayed 
out.

See also:
The File menu
The Edit menu
The View menu
The Options menu
The Launch Menu
The Help menu

The File menu

The File menu contains the following options:

Table 4-3. Workflow Job Manager File menu

File Menu Option Description

Exit Closes the Workflow Job Manager application. 
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The Edit menu

The Edit menu contains the following options:

Table 4-4. Workflow Job Manager Edit menu.

Edit Menu 
Option Description

Settings... Displays the settings dialog for the selected 
process.

View 
Document

Allows you to preview the current state of the 
document in the Review step or in prior steps and to 
interactively edit the document in Adobe Acrobat. 

In remote Workflow Job Manager, if Adobe Reader 
is installed, you can view, but not edit, PDF files. If 
Adobe Acrobat is installed, you can view and edit 
PDF files. 

Preflight 
Results

Opens Adobe Acrobat with any PDF files generated 
from preflight processes completed for that job.

Print Results Opens the Print Results dialog for each instance of 
a production print process in the workflow that has 
completed submission of the document to the 
printer. Print status is available only from IPP 
printers. 

Pause Pauses the job and allows a user to review. 
Available if a job is processing and not failed.

Resume Allows the workflow to continue to the next steps. 
Available if a job is paused.

Approve/ Allows a job to continue in the workflow. Changes to 
Resume. Available if a job is at a review step. 

Fail The job goes to the failed status. Available if a job is 
at a review step or is paused. Changes to Delete.

Resubmit Resumes the workflow at the currently selected 
process; uses the changed process settings. 
Appears in place of Approve and Fail buttons when 
a process step is selected while the workflow is at a 
Review step. 

Delete Deletes the job.

Find... Opens the Find dialog, which allows you to locate a 
process node in a workflow.
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The View menu

The View menu contains the following options:

The Options menu

The Options menu contains the following options:

Table 4-5. Workflow Job Manager View menu

View Menu 
Option Description

Show/Hide 
Process Tool 
Tips

Show: Allows you to view process settings via 
tool tips in the graphical workflow display by 
positioning the mouse pointer over a workflow 
process.

Hide: Disables the tool tips.

Workflow Icons Small Icons: Displays small icons.
Medium Icons: Displays mid-sized icons.
Large Icons: Default; displays large icons.

Table 4-6. Workflow Job Manager Options menu

Options Menu 
Option Description

Reports... Opens the reports dialog, in which you can select, 
define, view, and export reports.

Repository 
Credentials 
Setup...

Opens a dialog that allows the current user to 
enter a Username and Password for the active 
repository.
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The Launch Menu

The Launch menu contains the following options:

The Help menu

The Help menu contains the following options:

Table 4-7.  Workflow Job Manager Launch menu

Launch Menu 
Option Description

Workflow Builder Launches Workflow Builder.

Workflow 
Submission Client 

Launches Workflow Submission Client.

Printer Registration Launches Printer Registration.

FreeFlow 
Administration Tool

Launches FreeFlow Administration Tool.

Table 4-8. Workflow Job Manager Help menu

Help Menu 
Option Description

Help Topics... Displays the Help application to allow you to list 
the Help topics for Workflow Job Manager.

About Workflow 
Job Manager...

Displays program and copyright information for 
Workflow Job Manager. 
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Workflow Job Manager toolbar

The Workflow Job Manager toolbar provides commands for 
managing jobs. 

The Jobs toolbar

The Jobs toolbar includes the following options:

Table 4-9. Jobs toolbar

Workflow 
Submission 
Client

Launches Workflow Submission Client; available if 
there is at least one enabled workflow on the system.

Delete Deletes the selected job with all intermediate files. 
Saved workflows are not deleted.

Workflow Builder Launches Workflow Builder
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Managing Jobs

This section contains the activities available within Workflow Job 
Manager, including checking job, process, and workflow status; 
editing documents; editing workflow settings for specific jobs; 
approving or deleting jobs; viewing print results; or opening 
Workflow Submission Client to start a new job. 

Checking the status of a job

When you choose to view the details of individual jobs, details are 
displayed in the status area at the top of the screen and include: 
• Graphical display: Depicts the workflow process steps. A “+” 

in the workflow indicates a process branch that was created 
due to a failed process. Click “+” to open the branch; click “-” to 
close the branch.  

• Progress bar: Shows the progress of the current process.

To check the status of a specific job

1. In Workflow Job Manager, select a job from the Jobs list. The 
progress bar and workflow display in the status area.

2. Review the information in the status area.
3. Repeat step 1 to view the details of another job.
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Creating reports

The reports feature allows you to set up, generate, view and 
export various customized reports. The reports can include audit 
trail data, such as status and information about each job 
processed; as well as accounting data, such as processing time 
and number of impressions. You can also manage accounting 
data for past deleted jobs. 
Reports can be viewed in Workflow Job Manager, or can be 
exported to the following formats:
• CSV comma delimited (*.csv) 
• XML (*.xml)
The report function is also available via Remote Workflow Job 
Manager Client. 

You can set up and generate the following reports:

Table 4-10.  Report categories and types

Report Category Report Type

Job reports Full job report
Job totals daily
Job totals monthly
Job totals yearly

Workflow reports Full workflow report
Single workflow daily
Single workflow monthly
Single workflow yearly
All workflows daily
All workflows monthly
All workflows yearly

Process reports Single job
All jobs
Process results daily
Process results monthly
Process results yearly

Print results Print results report

System counters Counters daily
Counters monthly
Counters yearly
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The Reports dialog allows you to select a report type and define 
the report parameters. It provides access to dialogs that allow you 
to view or export a report, and purge data for past jobs. Dialog 
options, which vary depending on the selected report, include: 
Workflow name: Allows you to enter the workflow name.
Workflow Id: Allows you to enter the workflow Id.
Job name: Displays for reports that require an exact job name; 
allows you to enter the job name. 
Job Id: Allows you to enter the job Id.
Category: Allows you to select a report category. Report options 
for the category are displayed in the Report type field.
Type: Options depend on the report category selection.
Start date: Allows you to a select a start date for inclusion of data 
in a report.
End date: Allows you to a select an end date for inclusion of data 
in a report. 
All dates: Allows you select the use of all available data in terms 
of dates for report generation
Attributes to include: Includes the appropriate data/column 
options for the selected report type. 
NOTE 1: Processing time is displayed in seconds.
NOTE 2: “Impressions” refers to the number of sides of paper 
printed. Data is available only at the time of print. If an IPP 
connection is not available at the time the report is requested, the 
number of impressions is not reported.
Move Up: Allows you to shift the selected data fields up in the list; 
moves the data column to the left in the report. 
Move down: Allows you to shift the selected data fields in the list; 
moves the data column to the left in the report. 
Select all: When selected, places a check beside all of the 
attributes listed. Automatically clears if you deselect any attribute.
Sort attribute: Available if at least one report attribute is selected. 
Allows you to sort a report by the selected attribute in ascending 
or descending order.
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Purge: Opens the Purge dialog, which allows you to remove 
accounting data for deleted jobs. 
View: Generates a report and displays a report for viewing. 
Export...: Opens the Export dialog. 
Close: Closes the Reports dialog.

To create a report

1. In Workflow Job Manager, select [Options: Reports...] to 
display the Reports dialog.

2. Select the report category and type.
3. If required, enter a Workflow name and/or Workflow Id, Job 

name and/or Job Id in the appropriate text fields. The 
displayed fields vary depending on the selected report type. 

NOTE: You can also enter a wildcard for the workflow or job 
name, for example, *reprint.

4. Select a Start date from the drop box.
• Type the day or year; or 
• Highlight the month, day, or year, and use the up/down 

arrows to select the desired option.
5. Select an End date from the drop box.
NOTE: Only data for jobs occurring in the date range will be 
included.

6. In the Attributes to include window, scroll as needed, and 
select the individual attributes or select Select all to include all 
attributes. Attributes vary, based on the job type.

7. To define the position of the data in the report columns:
a. Select the attribute, and select Move Up to move the data 

column to the left in the report.
b. Select the attribute, and select Move Down to move the 

data column to the right in the report.
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8. To generate the report sorted by a specific column, in the Sort 
attribute window:
a. Select an attribute.
b. Select the desired data display sequence: Ascending to 

display from lowest to highest; Descending to display from 
highest to lowest.

9. Continue selecting report options, or select [Close] to close 
the dialog.

See also:
Viewing a report
Exporting a report
Purging report data
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Viewing a report

Once you set up the report parameters in the Reports dialog, you 
can select [View] to generate the configured report and view the 
report data. Report features include:
• The report name in the window title. 
• A column for each report attribute selected in the Reports 

dialog. Columns can be repositioned by dragging and 
dropping. 

To view a report

1. In Workflow Job Manager, select [Options: Reports...] to 
display the Reports dialog. Set up the desired report.

2. Select [View] to generate and display the report. 
3. (Optional) If you need to modify the report setup, click the 

Reports dialog to bring it to the foreground, make the 
necessary changes, and then select [View] to generate and 
view the modified report.

4. To view multiple reports side-by-side, leave the current report 
open, click the Reports dialog to bring it to the foreground, 
make new report selections, and then select [View]. Repeat as 
needed.

NOTE: To print, save, or archive the report, it must be exported.

5. Close the report(s).
6. Select [Close] to exit the Reports dialog

See also:
Creating reports
Exporting a report
Purging report data
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Exporting a report

Once you set up the parameters in the Reports dialog, you can 
export the report data. 
NOTE: You can load report data into an application such as 
Microsoft Excel, and then produce customized reports by 
combining reports.

Select [Export] to display the Export dialog, which includes the 
following options:
File name: Allows you to enter the file name for the export file.
Location: Displays the directory selected by using the Browse 
common dialog that will receive the exported report.
Browse: Opens a Browse for Folder dialog. Allows you to select a 
file location.
Format: Allows you to select the file type to export the report.
Encoding: Available for CSV format only. Allows you to select the 
encoding type. 
OK: Closes the window and exports the report.
Cancel: Discards changes and closes window.

To export a report

1. In Workflow Job Manager, select [Options: Reports...] to 
display the Reports dialog. Set up the desired report. You may 
want to view the report before exporting it.

2. Select [Export] to display the Export dialog. 
3. In the file name text field, enter a name for the export file.
4. To select a file location, select [Browse].
5. In the Browse For Folder dialog, do one of the following:

• Select the desired folder, and select [OK]; or
• Select [Make New Folder], name the folder, and select 

[OK].
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6. In the Format drop box, select the desired format. Options 
include:
• CSV comma delimited (*.csv), for database support such 

as Microsoft Access and Microsoft Excel. 
• XML (*.xml), a current method for data exchange used, for 

example, by database management systems and for VIPP 
printing.

7. In the Encoding drop box, select the encoding type for 
exporting the report. Options include: 
• Unicode (UTF-8), which can be used internationally to 

support Arabic, Hebrew, and other languages. 
• ANSI, which is compatible with older systems.

8. Select [OK] to close the window and export the report.
NOTE: The CSV file might display using the icon of an associated 
spreadsheet program.

See also:
Creating reports
Viewing a report
Purging report data

Purging report data

To help manage the database size, accounting data from deleted 
jobs can be removed from the database. 
NOTE: Deleting jobs from the Workflow Job Manager window 
should not be confused with the Purge function.

Select [Purge] in the Reports dialog to display the Purge dialog, 
which includes the following options: 
Never: Never removes accounting data.
Now: Removes data for deleted jobs upon clicking [OK].
Older than: Purges the records older than the specified value. If 
selected, the default is 365 days.
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OK: Performs one of the following, and then closes the dialog:
• If Now is selected: Purges the accounting data for deleted 

jobs. 
• If Older than n days is selected and unchanged: Continues on 

the fixed rate, checking and purging the accounting data for 
deleted jobs on a daily basis. 

• If the number of days is changed: Restarts the duration count 
before purging.

Cancel: Closes the dialog and disregards any changes made in 
the dialog.

To purge report data

1. In Workflow Job Manager, select [Options: Reports...] to 
display the Reports dialog.

2. Select a report.
3. Select [Purge].
4. Select one of the following:

• Never: To never remove accounting data.
• Now: To remove data when you select [OK].
• Older than [n] day(s): To daily purge records older than the 

value specified in the days spinner box.
5. Select [OK] to process your selection and close the dialog. 

See also:
Creating reports
Viewing a report
Exporting a report
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Viewing and editing a document in Adobe Acrobat

The View Document function is available whenever a PDF job is at 
a Review step or is paused. 
It allows you to open the PDF file in Adobe Acrobat, preview its 
current state and, if necessary, edit the document.
NOTE: You cannot change the file submission or the selected 
workflow, but you can access the other settings if you are allowed 
to change settings.

The following options are available:
Approve/Resume: When selected, the job continues in the 
workflow.
Fail: When selected, the job fails.

To view and edit a job in Adobe Acrobat

1. In Workflow Job Manager, select a job that displays Attention 
Required for Review, or that lists a status of Paused or Review 
in the Jobs list.

2. Select from the following:
• At the Review or paused step, select [View Document]. 

Adobe Acrobat displays the PDF document.
• Select a step that precedes the Review step. Select [View 

Document] to open Adobe Acrobat and display a PDF 
document for the step. 

NOTE 1: If a document from an earlier step is edited, the changes 
do not affect the later document unless the job is resubmitted 
before the place where the document was edited.
NOTE 2: Optional selection methods: You can also right-click a 
step and select [View Document] from the context menu, or 
select a step and select [Edit: View Document].
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3. If necessary, modify the document using the Adobe Acrobat 
features.

4. If necessary, save the document.
5. Exit Adobe Acrobat.

Viewing preflight results

A Preflight process step must be completed for a job in order to 
select this option. 

To view preflight results

1. In Workflow Job Manager, select a job from the Jobs list.
2. Select a Preflight node, and then select from the following:

• Right click the node and select [Preflight Results] from 
the context menu.

• Select [Edit: Preflight Results]. 
• Select the [Preflight Results] button.

3. Adobe Acrobat displays the results for the selected Preflight 
node.

4. Exit Adobe Acrobat.
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Viewing print results

Use the Print Results dialog to obtain information about 
documents submitted to IPP printers. The dialog updates 
periodically to display up-to-date information about each instance 
of a production print process in a workflow, including printer name, 
queue name, job name, job status, job ID, time, print quantity, 
finishing type, collation, and output. 

To view print results

1. In Workflow Job Manager, select a job from the Jobs list.
2. Select a Print step, then select from the following:

• Right-click the node, and select [Print Results] from the 
context menu.

• Select [Edit: Print Results].
• Select a Print step, and then select the [Print Results] 

button.
3. Review the print results for the selected Print node.
4. Exit the Print Results dialog.
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Modifying workflow settings

Settings...: Available if a job is at a Review step or paused and a 
configurable process step is selected in the workflow. It provides 
access to the workflow process settings.
Resubmit: Available if a job is paused at a Review step and a 
previous process step is selected. When selected, it reprocesses 
the workflow at the step that is currently selected. 
NOTE 1: During the resubmit operation, if there is interaction with 
a repository, the RMS credentials of the current user (the user 
running Workflow Job Manager) are used. If the current user of 
Workflow Job Manager does not have proper RMS credentials 
saved, the job will fail during resubmit.
NOTE 2: If a job is in a Review state prior to the installation of the 
Unlimited User Conversion, when you resubmit the job after the 
Unlimited User Conversion is installed, the files remain at low 
resolution.

To modify workflow settings

1. In Workflow Job Manager, select a job that is at a Review step 
or is paused.

2. Select a workflow process step. 
3. Select [Settings]. If the process is not configurable, [Settings] 

is grayed out.
4. Make the desired changes.
5. Select [OK].
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Pausing a job

You can pause a job if it is processing and not in a failed status.
The following options are available for a paused job:
View document: Opens the PDF file in Adobe Acrobat; allows 
you to review and edit the document. 
Settings...: Available if a job is at a Review step or paused and a 
configurable process step is selected in the workflow. It provides 
access to the workflow process settings.
Resume: When selected, the job continues in the workflow.
Fail: When selected, the job fails.

To pause a job

1. In Workflow Job Manager, select a job from the Jobs list. The 
job must be processing.

2. Select [Pause].
NOTE: The job pauses after the current process is done 
processing.
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Approving a job at a Review step

A job can be approved if it is at a Review step.
The following options are available for a job awaiting approval:
View document: Opens the PDF file in Adobe Acrobat; allows 
you to review and edit the document. 
Settings...: Available during the Review process step. Provides 
access to the workflow process settings.
Copies: Available when a selected job is at the Review step. If the 
job’s workflow contains a Print step after the Review step, it opens 
the Copies dialog. 
Print Proof: Available when a selected job is at a Review step, 
only if the workflow contains a Print step following the Review 
step. Allows you to print a high resolution proof of the PDF file 
processed to that point, on the next available Print step in the 
workflow. 
Approve: Available during the Review process step. When 
selected, the job continues in the workflow.
Fail: When selected, the job fails.

See also:
Modifying the copy count
Printing a hardcopy proof

To approve a job at a Review step

1. In Workflow Job Manager, select a job that displays Attention 
Required for Review, or that lists a status of Paused or Review 
in the Jobs list.

2. Select [Approve].
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Failing a job

You can fail a job if it is paused or at a Review step. The following 
option is available for a failed job:
Delete: Deletes the job and all intermediate files. The workflow is 
not deleted. 

To fail a job

1. In Workflow Job Manager, select a job that displays Attention 
Required for Review, or that lists a status of Paused or Review 
in the Jobs list. 

2. Select [Fail]. 
3. The status of the job becomes Failed.

Deleting a job

This process deletes the job and all intermediate files. The 
workflow is not deleted.

To delete a job

1. In Workflow Job Manager, select a job from the Jobs list. 
2. In the Jobs toolbar, select [Delete]. 
3. Select [Yes] to confirm.
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Modifying the copy count

The [Copies...] option is available when a selected job is at the 
Review step. If the job’s workflow contains a Print step after the 
Review step, it opens the Copies dialog, in which the following 
options are available:
• Quantity (original document): Allows you to change the 

number of copies to print, from 1-9999999, for all Print steps 
that follow the Review step in the workflow branch. 
Represents the quantity of the document as submitted via an 
XPIF, JDF or manifest value (order jacket file field for 
Quantity). If the copy count dialog is opened from a Review 
node prior to the copy count being modified by a multi-up 
repeated Imposition node, only this option displays.

• Quantity (imposed document): Allows you to modify the 
imposed copy count. If the Copy Count dialog is opened from 
a Review node after the copy count is modified by a multi-up 
repeated Imposition node, this option is available and the 
Quantity (original document) cannot be modified. Quantity 
(imposed document) is available when you:
– Process the job through a Xerox imposition node (not 

PREPS) that is multi-up repeated. 
– Enable the Copy Count Divisor feature via [Workflow 

Builder: Processes: right-click Impose: Settings...]. 
This feature enables the system to adjust the copy count to 
maintain the original quantity intent for workflows that 
contain multiple-up impositions.

– Submit a job with a job ticket quantity intent.
– Use Print nodes that do not have “Always use these 

settings” selected.
• OK: Sets the copy counts of Print steps following the current 

Review step to the specified number.
During the Review task, if both Quantity (original document) 
and Quantity (imposed document) are available for a Print 
node, the value displayed in the Print node Quantity setting is the 
Quantiy (imposed document) value.
For more information about the copy count divisor, see the topic 
“To enable the copy count divisor.”
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To modify the copy count

NOTE: The job must have a Print step following a Review step.

1. In Workflow Job Manager, select a job from the Jobs list. The 
job must be at a Review step. 

2. Select [Copies...].
3. In the [Quantity (original document) section, set the number 

of copies to print.
4. In the [Quantity (imposed document) section, set the 

quantity of the imposed document to print. See description, 
above, for a list of availability criteria. 

5. Select [OK].
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Printing a hardcopy proof

A hard proof allows you to review a hardcopy of the job before 
printing a full production run. 
The [Print Proof] option is available when a selected job is at a 
Review step. It uses the job ticket settings, with a copy count of 
one, to print a high resolution proof of the PDF file processed up to 
that point on the next available Print step in the workflow. 
NOTE: [Print Proof] is only available if the workflow contains a 
Print step following the Review step. 

Printer status and results for print proof jobs are not available in 
the Process Manager reports. However, you can obtain the job 
information in the production printer Job Manager.

To print a hardcopy proof

1. In Workflow Job Manager, select a job from the Jobs list. The 
job must be stopped at the Review step. 

2. Select [Print Proof] to print a single copy. Obtain and review 
the proof.
NOTE: A “Proof sent to printer” message displays when the 
“Print Proof” button is selected and the document is 
successfully sent to the printer. 
 
A “Proof failed to print” message displays when you select 
[Print Proof] and the document is sent to the printer but fails 
to print.

3. If appropriate, select [Approve] to print the entire job.
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Adding a recipient to a Notify step with no recipient address specified

If the [Enter recipient address during job processing] option is 
selected during configuration of the Notification Settings, the job l 
runs until it reaches the Notify step. It then pauses and displays 
the following message:
“Attention Required for Notify. Please add recipients to the notify 
settings and resume the job.”
The following options are available for the job when you select a 
Notify step with no recipient addresses specified:
View Document: Opens the PDF file in Adobe Acrobat; allows 
you to review and edit the document.
Settings: Opens the Notification Settings dialog and allows you to 
enter recipient addresses.
Resume: Continues processing the job. Is grayed out if no 
recipients are specified, and the submitter did not check the “Allow 
job to continue even if no notification is sent” check box.
Fail: Fails the job.

To add a recipient to a Notify step with no recipient address 
specified

1. In Workflow Job Manager, select a job from the Jobs list with 
Incomplete Settings in the Status column. 

NOTE: The job must have a Notify step following a Review step. 

2. Select [Settings].
3. Select from the following in the Notification settings dialog: 

• Enter the recipient email address.
• Select [Allow job to continue even if no notification is 

sent] to prevent the job from failing if email notification is 
not sent due to the lack of a recipient address or other 
failure. 

4. Select [OK].
5. Select [Resume].
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Viewing Web Services Job Instructions

Web Services job instructions can be viewed via a URL link by 
selecting [View Job Instructions]. This option is available when a 
selected Web Services job is in a Review, paused, or Incomplete 
Notify Settings state.

To view Web Services job instructions

1. In Workflow Job Manager, select a Web Services job from the 
Jobs list.

2. Select [View Job Instructions]. The system default web 
browser opens to the WebServices-supplied URL for the 
selected job.
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 Remote Workflow Job Manager Client

Process Manager can support multiple remote instances of 
Workflow Job Manager. This allows you to manage jobs by 
logging in to any workstation or server in your print shop that has 
the Remote Workflow Job Manager Client software installed. 
Process Manager supports a maximum of 8 instances of Remote 
Workflow Job Manager Client, not including the client on the 
FreeFlow Process Manager server.
NOTE:  Ensure that the Process Manager server is selected in the 
text box of the remote client login screen.

Using the View Document function

To use the View Document function when a job is stopped at the 
Review task, Adobe Acrobat or Abobe Reader must be installed. 
Otherwise, the function is disabled.
If Adobe Reader is installed:
• You can use the View Document function to view PDF files. 
• You cannot edit PDF files.
If Adobe Acrobat is installed, you can use the View Document 
function to:
• View PDF files
• Edit PDF files 

Functions not available in Remote Workflow Job Manager 
Client

The following administrative functions are not available or are 
disabled in Remote Workflow Job Manager Client:
• Preflight setup
• SMTP setup
• Proxy setup
• Hot folder setup
• External process setup
• Process status modifications
• Printer polling interval
• The launch of Workflow Builder from Job Manager



FreeFlow Process Manager Operator and Administrator Guide4-36

Workf low Job Manager

Job In Use dialog

When using Remote Workflow Job Manager Client, only one 
remote client at a time can modify a job. If another user attempts 
to edit or review documents associated with a job that is being 
edited or reviewed, the system locks the job and the Job in Use 
Dialog displays. This prevents other clients from accessing the 
job. Dialog options include:
Unlock: Available only on the server installation of Workflow Job 
Manager. Brings up the Unlock Confirmation dialog.
Cancel: Returns the user to Workflow Job Manager; does not 
open the job or the PDF associated with the job.
OK: Appears only on the remote version of Job Manager. The 
remote user cannot access or unlock the job. The user must wait 
for the other user to finish or for the administrator to override the 
lock from the local server.

Unlock Confirmation dialog

The Unlock Confirmation dialog displays when a user selects 
[Unlock] in the Job in Use dialog. Dialog options include:
Yes: Closes the dialog. The file is unlocked, potentially nullifying 
any changes made by the user who originally had the file or job 
open. The selected file or job opens.
No: Closes the dialog and the Job In Use dialog.
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Accessing Workflow Builder from Workflow Job Manager

You might need to access Workflow Builder to create or modify a 
workflow, or to configure process step settings.

To access Workflow Builder from Workflow Job Manager

1. In Workflow Job Manager, select [Launch: Workflow 
Builder]. The Workflow Builder login displays.

2. Log in to Workflow Builder.
3. Select [File: New].
4. Create a workflow.
5. Save the workflow.
6. Enable the workflow.

7. Exit Workflow Builder.

Accessing Workflow Submission Client from Workflow Job Manager

If you need to create and/or submit a new job while in Job 
Manager, you can access Workflow Submission Client via the 
Jobs toolbar. 

To create and/or submit a new job

1. In Workflow Job Manager, select [Workflow Submission 
Client] in the Jobs toolbar. The Workflow Submission Client 
login is displayed. 

2. Log in to Workflow Submission Client.
3. Select a file for submission.
4. Select a Workflow.
5. Specify the job requirements.
6. Select [Submit]. 
7. Exit Workflow Submission Client.
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Managing jobs from third party management information systems (MIS)

Third party management information systems (MIS) can submit 
jobs directly to Process Manager. For incoming jobs that do not 
include all the necessary processing information, the operator 
might have to complete the job setup by assigning and configuring 
a workflow and/or selecting the workflow submission files. 
Incoming third party jobs that require additional configuration 
display the following elements:
• A paused job icon in the Name column
• “Attention Required” in the Status column
• Instructional text, for example: “Please configure this job and 

select Approve to begin processing.” 
The topics in the following sections cover the dialogs and 
procedures involved in configuring incoming third party MIS jobs:

See also:
Assigning and configuring a workflow for an incoming third party 
job
Selecting files for an incoming third party job
Viewing the JDF file for an incoming third party job
Viewing the job instructions for an incoming third party job
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Assigning and configuring a workflow for an incoming third 
party job

On occasion, incoming jobs do not have the information 
necessary for processing, and you will need to assign a workflow.
Choose a workflow...: This option allows you to select a workflow 
from the drop box.

To assign and configure a workflow for an incoming 
third party job

1. In Workflow Job Manager, from the Jobs list, select a job with 
“Attention Required” in the Status column.

2. Choose a workflow from the Choose a workflow... drop box. 
NOTE: When you select a workflow, the JDF job intents are 
matched as closely as possible to the workflow settings. If the 
settings are locked or not available, the workflow defaults are 
applied.

3. To configure process settings for the workflow, select a 
workflow step and select [Settings...]. 

4. Make the desired changes and select [OK]. 
5. Continue configuring the job if files have not been selected, or 

select [Approve] to release the job for processing.
NOTE: [Approve] is available if a workflow has been assigned 
and files have been selected. If [Approve] is grayed out, you must 
complete the job configuration.

See also:
Managing jobs from third party management information systems 
(MIS)
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Selecting files for an incoming third party job

On occasion, incoming jobs do not have the information 
necessary for processing, and you will need to select files for a 
workflow.
Select Files...: This option opens a common file dialog for 
selecting input files. If files have been selected, they are listed 
beneath the button instead of the default statement: “No files are 
currently associated with this job”.

To select files for an incoming third party job

1. In Workflow Job Manager, from the Jobs list, select a job with 
“Attention Required” in the Status column.

2. Select [Select Files...].
NOTE: If files have been selected previously, they are listed 
beneath the button.

3. In the Open dialog, select the files to add to the job, and then 
select [Open].

NOTE: The same file types that are supported in Workflow 
Submission Client are available.

4. Continue configuring the job if a workflow has not been 
assigned, or select [Approve] to release the job for 
processing.

NOTE: [Approve] is available if a workflow has been assigned 
and files have been selected. If [Approve] is grayed out, you must 
complete the job configuration.

See also:
Managing jobs from third party management information systems 
(MIS)
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Viewing the JDF file for an incoming third party job

On occasion, incoming third party jobs do not have the information 
necessary for processing, and you will need to review the JDF file 
submitted with the job.
View JDF: This option is available if a JDF file was submitted with 
the job. It opens the JDF file in a separate window. 

To view the JDF file for an incoming third party job

1. In Workflow Job Manager, from the Jobs list, select a job with 
“Attention Required” in the Status column.

2. Select [View JDF] to display the JDF file in a separate dialog. 
If desired, keep the window open while you configure the job in 
other dialogs, and then close the window.

See also:
Managing jobs from third party management information systems 
(MIS)
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Viewing the job instructions for an incoming third party job

On occasion, incoming third party jobs do not have the information 
necessary for processing, and you will need to review the job 
instructions submitted with the job.
View Job Instructions: This option is available if a job 
instructions file was submitted with the job. It opens the file with 
Adobe Reader in a separate window.

To view the job instructions for an incoming third party 
job

1. In Workflow Job Manager, from the Jobs list, select a job with 
“Attention Required” in the Status column.

2. Select [View Job Instructions] to display the job instructions 
in a separate dialog. If desired, keep the window open while 
you configure the job in other dialogs, and then close the 
window.

See also:
Managing jobs from third party management information systems 
(MIS)
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